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NOTE

NOTE

In ThisManual

This document is the self-paced training manual to help you to understand how to use the
Keysight EasyEXPERT software.

Module 1. Getting Started

This module explains the basic operations of the EasyEXPERT. You will learn how to
perform application test, quick test, and tracer test.

Module 2. Data Display and Management

This module explains the data display and analysis capabilities of the EasyEXPERT
software. You will learn how to use analysistools, how to change display setup, and
how to print/export test result data.

Module 3. Classic Test Environment

This module explains the classic test mode of the EasyEXPERT. You will learn how to
create the classic test setup in the course exercises.

Module 4. Measurement Functions

This modul e explains the measurement functions available with the EasyEXPERT. You
will learn how to use various measurement functions in the course exercises.

Module 5. Modifying Application Test Definitions

This modul e explains amodification example of an application test definition. You will
learn how to modify the definition in a course exercise.

Module 6. Creating Your Test Definitions

This module explains about the application test definition. You will learn how to create
your application test definition in a course exercise.

Module 7. Advanced Definitions and Operations

This module explains how to control external GPIB devices, how to call an execution
file, how to perform a repeat measurement, and how to use the prober control script.

Module 8. Miscellaneous Operations

This module explains what is the status indicator, what is the automatic data export
function and the automatic data record function, how to perform selftest and
calibration, how to perform SMU zero offset cancel, and such.

To get the latest firmware/software/manual/specifications/support information, go to
www.keysight.com/find/easyexpert.

Theinformation is subject to change without notice due to the future enhancement. The
actual screen image of EasyEXPERT may be different from the image shown in this
manual.



Class Exercises

Class exercises use the test setup listed below. The test setup data are only examples and
included in the Demo.xpg file stored in Keysight B1500 Series Product Reference CD.

Module Exercise Device Test setup/definition/data Page
Module 1 Id-Vd measurement MOSFET | Id-vd 1-19
1d-Vg, gm-V g measurement MOSFET | Vth gmMax 1-27
|d-Vd measurement MOSFET | Traceldvd 1-31
B2200/E5250 switch control - - 1-54
Module 2 1d-Vg, gm-V g measurement MOSFET | GMMAX 2-30
Using Preview window - - 2-33
Module 3 Id-Vd measurement MOSFET | Trngld-vd 3-27
Multi Channel 1/V Sweep Bipolar Tr | Trng Multi 3-39
M easurement LED
I/V List Sweep Measurement MOSFET | TrngList 351
1/V-t sampling measurement 0.1 uF Trng Sampling 3-65
C-V sweep measurement MOSFET | Trng CV 3-79
B2200/E5250 switch control - Trng Switch 3-84
Direct Control (C-f measurement) 0.1 uF Trng C-f 391
Module 4 SMU pulse mode MOSFET | IDVD-Pulse 4-7
RC measurement 0.1 uFand | RC-sampling-log 4-15
511 kohm
Negative hold time 511 kohm | R-sampl-neg-hold 4-21
Auto analysis MOSFET GMMAX 4-27
Bias hold function LED LED 4-38
Module 5 Modifying application test MOSFET | Trngldvd Vth 5-14
definition Trng idvd idvg2 5-29
Trng idvd idvg3 5-32
Using auto analysystwice MOSFET | VthgmMax and Id 5-34
Using vector data MOSFET | Trng Cgg-Vg 5-42




M odule

Exercise Device Test setup/definition/data Page

Module 6

Creating application test definition MOSFET | Trngidvdidvg 6-17

Module 7

no exercise

Module 8

no exercise

NOTE

NOTE

NOTE

NOTE

Demo.xpg file

Demo.xpg file is required to create the Demo preset group which contains the test setup
data used by the class exercises. And it is stored in the \data folder on Keysight B1500
Series Product Reference CD.

The Demo preset group should be created before starting the class exercise. To create the
preset group, launch EasyEXPERT and import the file by using the Preset Group Import
dialog box opened by clicking My Favorite > Import... The test setup data are only
examples for the class exercises.

Before importing the Demo.xpg file, import the .xtd files stored in the same fol der.

Xtd files

The \data folder stores some .xtd files. They are the application test definitions used by
some class exercises. To use the definition file, import the file by using the Test Definition
Import dialog box opened by clicking Library > Import... The test definition data are only
examples for the class exercises.

Xtr files

The \data folder also stores some .xtr files. They are the sample test results created by
executing the test setup which has the same name as the result data. To display these
sample test results, import the files by using the Test Result Import dialog box opened by
clicking Results > Import...

About sample data

The test setup data described in this manual are only examples. If these example data
damage your devices, Keysight is NOT LIABLE for the damage.




Required Devicesfor Class Exercises

To perform the class exercises, you need the device set (Keysight part number
04156-87001) which contains the following devices.

Description Quantity
N-channel MOSFET 2ea
NPN Bipolar Transistor lea
Red Miniature LED lea
0.1 uF Capacitor 50 V lea
1.0 Q Resistor 1/8 W lea
1.1 kQ Resistor Y8 W lea
511 kQ Resistor /8 W lea

-

N-ch MOSFET NPN bipolar Transistor

Brown Brown

LED
Black Brown
Black Black
Silver Brown

1 ohm Resistor 1.1 kohm Resistor

Green

Brown
Brown
Orange

— S—

511 kohm Resistor 0.1 uF Capacitor



Required Accessoriesfor Class Exercises

To perform the class exercises, you need the following accessories. Prepare the accessories
shown below.

Designation Description Modéel No. Qty.
1 Test Fixture a16442A or lea
) 16442B
28 pin socket module (B1500A-A5F) lea
Connection wire 6 ea
2 Triaxial Cable 16494A 4 ea
3 Interlock Cable 16493J lea

a. The 16058A Test Fixture for the 4145A/B may be substituted for the
16442A/B Test Fixture. If you use the 16058A, you a so need the 16435A
Interlock Adapter.

28 pin DIP Socket Module (1ea.)

o
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o
o
S [FonTguaDD0D] o
ooooungooono)

Connection Wire (6ea.)
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16442A/B Test Fixture (1ea.) @ Oir>——=—=10
Triaxial Cable (4ea.)
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INTLK Cable (1ea.)



Module 1. Getting Started

* TolLaunch EasyEXPERT

* To Specify/Create Workspace

* ToPerform Application Test

 To Save/Recall Your Test Setup

* ToExport/Import Your Preset Group
* ToExport/Import Test Record

e ToPeform Quick Test

* ToPerform Tracer Test

* ToControl Switching Matrix

* ToManage Data Display Window

Module 2. Data Display and M anagement

» Data Display window

* Graph AnalysisTools

» Data Status

* ToChange Graph/List/Display Setup
* ToSeePrint Preview

* ToPrint Display Data

* Exporting to Excel

 ToCopy Graph Plot/List Data

* To Save Analysis Result

e ToUsePreview Window
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Module 3. Classic Test Environment

* Classic Test Execution Mode

* |/V Sweep Measurement

e Multi Channe I/V Sweep M easur ement
* 1/V List Sweep M easurement

* 1/V-t Sampling M easur ement

* C-V Sweep Measurement

* Switching Matrix Control

e Direct Control

Module 4. M easurement Functions

SMU Pulsed Sweep M easur ement

* 1/V-t Sampling M easur ement

* Negative Hold Time for High Speed Sampling
* AutoAnalysis

e SMU Filter

e Standby Function

« BiasHold Function
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Module 5. Modifying Application Test Definitions

 ToOpen Application Test Definition

* ToModify Test Definition

» ToUseDebug Tools

* ToUseBuilt-in Functions

 ToAdd DataDisplay

» ToUseAuto Analysis

e ToUseTest Setup Internal Variables

* ToUseAuto Analysistwice (as Class Exercise)

* ToUseVector Data (as Class Exercise)

Module 6. Creating Your Test Definitions

* What isTest Definition

* What isTest Contents

* ToOpen Test Definition Editor
* ToDefine Test Specification

* ToDefineTest Contents

* Available Elements

* AvailableVariables

* ToDefine Test Output
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Module 7. Advanced Definitionsand Operations

* ToControl External GPIB Devices
* To Call Execution Files

* ToPerform Repeat Measurements
* Prober Control Script

e Thermo-trigger

Module 8. Miscellaneous Oper ations

* Function Status Indicator

* Run Option

* Automatic Data Export and Data Record
» Calibration

* Configuration

e XSLT Samples

* ToEnable System Controller

 To Start EasyEXPERT on External PC

* ToUse415x Setup File Converter
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In This Module

+ EasyEXPERT Software

* To Launch EasyEXPERT

* To Specify/Create Workspace

* To Perform Application Test

* To Save/Recall Your Test Setup

* To Export/Import Your Preset Group
* To Export/Import Test Record

* To Perform Quick Test

* To Perform Tracer Test

* To Control Switching Matrix

* To Manage Data Display Window
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EasyEXPERT Software
" Clean Room Office
EasyEXPERT
Keysight B1500 Data server
=11 To control B1500 =
-~ = O viaGPIB ] !2/
E ‘ J
o l_——-z
3
To export test record b eE——————
EasyEXPERT

To import/expaort test setup

via LAN Data server

Print server

Line Printer

Note: The B1500 cannot be controlled via LAN.

Module 1
Getting Started

The EasyEXPERT software isinstalled in the Keysight B1500 for the measurement execution

and the measurement data analysis. And you can use the EasyEXPERT for an external PC and

that provides the following additional advantages to the B1500, allowing you to minimize the

amount of offline tasks performed on the B1500 and increase the working ratio for
measurements.

*Allows the B1500, 4155, 4156, E5260, or E5270 to be controlled from an external computer

while online.
*Allows test setup to be created on an external computer while offline.

*Allows data analysis to be performed on an external computer while offline.
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Module 1
Getting Started

To Turn on/off B1500

The Standby button works to turn on the B1500 when it is turned off. When the B1500 is turned
on, the Standby button works to terminate the EasyEXPERT software, Windows, and turn off the
B1500.

After the B1500 is turned on, log on Windows.
The default user is Keysight B1500 User with no password.
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To Launch EasyEXPERT

Start EasyEXPERT icon

Start EasyEXPERT button/window

NH=BH sasen

After logging on, click Start EasyEXPERT button to launch the EasyEXPERT software.

If you do not see the Start EasyEXPERT button, double click the Start EasyEXPERT icon to
open the Start EasyEXPERT window.

This window has the File menu and the Option menu. The File menu is used to close this
window. The Option menu provides the following functions.

*Auto Start of EasyEXPERT: Enables or disables the automatic start function. If thislabel is
checked, the function is enabled. From the next boot or logon, the Start EasyEXPERT window
will be skipped and EasyEXPERT will be launched. To disable this function, use the Start
EasyEXPERT window opened by the File > Exit menu on the EasyEXPERT main screen. This
function is not effective for EasyEXPERT for externa PC.

*Backup EasyEXPERT Database: Used to make backup of the EasyEXPERT database.
*Restore EasyEXPERT Database: Used to restore the EasyEXPERT database.

Note:
EasyEXPERT for external PC provides the following additional functions in the Option menu.

Execution Mode: Used to change the software execution mode.
Move EasyEXPERT Database: Used to move the EasyEXPERT database.

1-5
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Module 1
Getting Started

To Specify Workspace

el el el il el
0 T

Casel

Case 2

After launching the EasyEXPERT, you will see one of the above screens.
Case 1. If thisisthefirst time to launch the EasyEXPERT

The EasyEXPERT main screen is displayed. Initial test mode depends on the instrument.
Case 2: If the EasyEXPERT has one workspace only

Select Yes, and click OK if you use the existing workspace.

The EasyEXPERT main screen is displayed.

Select No, and click Next if you want to create a new workspace.

See next dlide.

Case 3: If the EasyEXPERT has some workspaces (more than one)
Select workspace you want to use, and click Continue.

The EasyEXPERT main screen is displayed.

If you create workspace, check the Create a new Workspace from scratch radio button, and click
Continue.

To create a public workspace, check the Allow other usersto access this workspace box. The
public workspace can be used by all users.

To create a private workspace, delete the check from the Allow other usersto access this
wor kspace box.

Workspace is the space created in the hard disk drive, and is used to store the test setup,
measurement result data, and so on. The workspace can be created and allocated for each user.

Work on the same setups and data next time and Choose the same workspace next time:

If this check box is checked, the workspace selection screen will be skipped at the next startup
and EasyEXPERT will be launched with the workspace used at the last operation. To perform
this setup again, click the File > Exit Workspace menu on the EasyEXPERT main screen.
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To Create Workspace

Keysight EasyEXPERT software manages setups and data in
enclosures known as "Workspaces.” Since you want to
starta new session, you should create a new Workspace
with a distinctive name. Please specify a name for the new
Workspace:

1 - g =

Ot e o cces vis workapce.

You can also rename a previously defined Workspace;

Public workspace

1: New workspace name to create

2: New workspace name to rename

Check this box for

Enter the workspace name and click OK to create/rename the workspace.

If you want to create a public workspace, check the Allow other users to access this workspace

box.
The public workspace can be used by all users.

Module 1
Getting Started

If you want to create a private workspace, delete the check from the Allow other usersto access

this wor kspace box.
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Module 1

Getting Started

Online Help
File Edit View Run Tools Options[Help |
it Workspace = vecen [ = o W,
il My Favorite
E[1/V Trace About Workspace... = _!.. -
VAR1 3

Keysight on the Web I

GenersteReportforTed| 4] & = @&
e st Port

Event Log...

et
What's New in EasyEXP| —
About EasyEXPERT...

Keysight EasyEXPERT Online Help

[ Quick Test [ Tracer Test| Classic Test | Application T

Edition 15: March 2015, for EasyEXPERT revision 60

To get the latest information:

Z8 - | BRI Fa'l . 2 SR To get the latest firmware/software/manualsupport informatien, go te wnw keysighi com
E!;i =g} IE} l!{! bl. ’ | g and type in EasyEXPERT in the Search field at the top of the page.
Unit V Name Tl
I:l M; KEYSIGHT
I:] To add a channel parameter, press the [A
+[ [Fag  [Setup Name [Date ||
2
3
H
&
lnitial Workspace (Adminstrator) 1] Then I

Online Help is available for the EasyEXPERT. Select Help > Contents Help menu to display the
online help window. The online help provides the following information.

«[ntroduction describes overview, front view, rear view, and measurement units of the B1500.

*Using EasyEXPERT provides the reference information of the Keysight EasyEXPERT
software.

Classic Test Definition provides the reference information of the classic test setup GUI.

«Application Test Definition provides the reference information of the application test definition
setup GUI.

<Function Details explains the measurement functions of the EasyEXPERT.

Built-in Programming Tool provides the reference information of the built-in function, read out
functions, and script programming statements.

«Utility and Software Furnished introduces the utility programs and software furnished with the
EasyEXPERT.

«If You Have a Problem describes the problem solving information and the error messages.
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Application Test
File Edit View Run Tools Help
 Initial Workspace [y g | Device ID : = | Count: [0 I
£ Ic-Vce(PowerBIT) Setup Name : [[c-Vee(PowerBIT) = | | My Favorite |
& * |Device Parameters ] =
]
g PowerMOSFE Polarity : [HPN | Temp: [25.0deg )
sic
g Structure [ »|
= | Thermal |
4 ) tilty =
4
5 Test Extended Setup... -
| Library V| §
ETOE - Memo =
5 0 About lc-Vee{Power8JT) N
Primary Sweep
§ scv e Ic-Vee(PowerBIT): Ic-Vce characteristics, SMU Pube (A.05.00) =
"o | Offset Meas [Description] = |fector: [SMU4HR ~
ﬁ Measures Ic-Vce characterstics. SMU pulse & used for the Collector-Emitter voage
% output. istart: [0V ]
2 -Vee(PowerBIT)) Il (pevice under Test]
24 AtanEA Power BT, 3 terminals [Stop: |200v & |
" Device Paramet : oorw @)
haty e e ore tie et ki) o £ {SH e e negatie [Step : [200mv 8 «
_— speciied value),
Vea(sat) 1 || Temp: Temperature - [puimit: 1o0A &
‘ce(sat)-Ic
{l Zfumit: 200w &
i Tostop : [100mA 8] o] | vepulsewidtn : [o00s 6] 3
Ie-Vicho bstep: [oma | =
ol PulsePeriodMode : [aUTO |
e
ManualPulsePeriod :
— IbPulsewidth : [S00us @ e anualpulse S0 m [
iaI:-\wceu Emitter : [GNOU:GHL ~ |
»[ [Flag  [Setup Name [Date |Count Device ID |Remarks
i
Inital Workspace ) 5] OFF |[2] Multi Display OFF ] Standby OFF _[bi] sMU Zero OFF [ Auto Export OFF _[IB] Auto Record ON

Application Test tab sets the application test mode.
Test definition can be selected by using Category and Library, and then click Select button.

To know about the application test, click the (i) icon. Thisicon displays the message box that
explains the application test definition. Thisfunction will help you to know what is and how to
use the application test.
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Getting Started

Typical Value Selection

You do not need to hit the keyboard.

File Eda View Run Tooks Hep

i Wokopace o ocen [ cun

i [category... | IcVee(PoweriT) @] setup Name ; [ic-veelFonedT) = | | My Favorite
§

X

“ |Device Parameters ]
Polarity : [lPH il Temp: 50 W]

» Right clicking
this field
displays the
menu.

Memo: |

[ Quick Test | Traces Test | classic Testf] Appiica

Secondary Sweep

Base: [SMUSMP

start: [ 8] |G
= e e ] The values are
Ie-Vbo Ihstep: [lome W] |::| defined as
[~ . i anualPulsePeriod : [50.0 ms :
ﬁ‘i"‘“—é IbPulsewidth : [560 vs imm“ = Ll Foome 8| J typlca] Values
- in the Test
v [ [Flag [Setup Mame [Date [Count [Device ID [Remarks [ ..
h Definition.

s Vierkepace (Admstator) {1 Trermameter oFF (] Ml Display 0[] stncby oFF ] s zero orF 5] Auto Bpeniorr ] Auts Recora o

When you set atest condition of application test, you do not need to use keyboard. You can
select the value from the typical values as shown below.

«Click the entry field of a setup parameter by using the touch screen or the mouse. This displays
the typical values for the specified parameter on the softkeys.

*Select one of the softkeys.

Also you can use the following manner.

«Point the entry field of a setup parameter by using the mouse.

*Right click the mouse to display the popup menu.

*Click the Select menu to display the typical values for the specified parameter.
*Select one from the typical values.

Note:
The typical values are defined in the test definition. And you can change the values by using the
Define typical values window opened by clicking the Typical Values button on the Test

Specification screen of the Test Definition window. For the Test Definition window, see Module
5.



Screen Keyboard

—
—

Bksp
Clear

IIIIIIH\*!

| -

=

When you need to enter numeric characters in an entry field, you will see the icon at the right
side of the entry field. Thisicon opensthe Numeric KeyPad. Y ou can use this screen keypad

instead of the USB keyboard.

When you need to enter alphabetic characters in an entry field, you will see the icon at the right
side of the entry field. Thisicon opensthe On Screen Keyboard. Y ou can use this screen

keyboard instead of the USB keyboard.

Module 1
Getting Started
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To Perform Application Test
File Edit View Run Tools Help
Untitied [E N, veiem: [ o icwt:f ],
i | category... ~| 1d-vd @| setup Name : [15-vd ] | [ My Favorite =
s [Cer = -
qa —
5 |0 Discrete Polarity : [fich O] Lg: [to0nm  §] wo: [100um 8|
B | Genercrest »|
1 = |1 MCsMU_IV Temp : [25.0 deg [] IdMax: [10maA [
& 1 memary
% i
Test Extended Setup... ~
Zlubrary _ ~ ¥ | §
g - | ——| Primary Sweep
| 10-vd puise - = S [
3 @ IDVG [(1) “PLCLE"; 2008/11/15 17:31:40] - eysit ExsyEXFERT siErE
E O al-s5c QEHEM® &-9A- ® OEE GEE
% Nt puse f I
g - Praterence -
< G A MARKER{ 693100 i 13545208 e )
| I . ' ‘
 [1d-vd: 16-vdF1E (A03.20) ] $ om
, Gate: [SHUZ:HR/. ~ | § o
n vostart: [s00mv & bl
3 1o0n
16-vd(3) vgstop: [2.00v @ ‘;’u“
. Vostep: [soomv @ &
. ]
1d-Vg pulse ot
Ex: 1 500m o S00m 1 15 2 25 3
= wm 0midy
| CEE— ]
» [ [Flag  [Setup Name [Date N E— —— v ;
GUMMEL 2006/11/16 11113} % sews oo o
i ALWG monitor 2008/02/01 20:36:02 1
= IDVG 2006/11/15 17:31:40 1 PLC16
it [1] Thermometer OFF [ Multi Display OFF [] Standoy OFF (0] sMu Zero OFF _[ES] Auto Export OFF || AutoRecord ON_ |
1
Test Record List area

Step 1: Click Application Test tab.

Step 2: Select one or more technology categories, and select a desired test from the list of tests
associated with the selected technology categories.

Step 3: Change the setup parameters (Device parameters and Test parameters) if you want.

Step 4: Connect DUT, and click the Single button. The EasyEXPERT starts the selected test.
After the measurement, the test result datais displayed on the Data Display window. And the
Test Result Editor shown in the next page is displayed on the lower left area of the EasyEXPERT
screen if the Auto Record function or the Auto Export function is set to ON. Check the status
indicator at the bottom of the screen.

Step 5: Analyze the measurement result data.
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Test Result Editor
ave | v Flags: | Important | Valid | Questionable |
| pelete || Remarks: | = oK |
*  Save/Delete

L ]

! Important

# Valid

L]

? Questionable

[ ]

Remarks

« OK

The Test Result Editor provides the following GUI to set aflag and remarks to the test result
record. Set the flag and remarks to the test record.

*Save button and Delete button

Divides test records into groups, Save and Delete.

Test records in Save-group are always listed in the lower area of the EasyEXPERT main screen.
Test records in Delete-group can be listed when Results > Filter > Show Deleted Datais
checked.

<Flags buttons

The following buttons are available while the left check box has been checked. Y ou can set one
of the following flags.

eImportant ! Button

Sets the important flag (!) to the test result record.

*Valid # button

Setsthe valid flag (#) to the test result record.

*Questionable ? Button

Sets the questionable flag (?) to the test result record.

*Remarks field

Thisfield is effective while the left check box has been checked. Y ou can enter charactersinto
thisfield. The characters will be recorded as the Remarks value of the test result record.

*OK button

Applies the setup on the Test Result Editor, and closes this dialog box.
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Test Record List Area

Results > Filter > Show Deleted Data

Flag | Setup Name
Flag | Setup Name ﬂ # __|Vth gmMax
..|# |Vth gmMax A # Vth gmMa
ID-VD1 S |? |Vth gmMax
ID-VD1 S [? Vth gmMa
\r ! Vth gmMax A ID-VD1
|l ID-VD1 ] A ID-VD1
T S ID-VD1
L. ID-VD1
Expand Application Test Results 1 |Vth gmMax
! Vth gmMax
F'hg Setup Name i ID-vD1
| # \ Vth gmMax

~[# | VthgmMaxy] Show All Append Data

ID-VD1

; Vth amMax

! Vth gmMa

= ID-VD1 |

The test result records are listed in the test record list area. The area aso lists the following data.
«Append measurement data marked with ...

*Deleted data marked with * if Results > Filter > Show Deleted Data is checked

*Test name defined in the application test definition if Results > Filter > Expand Application
Test Resultsis checked

If Results > Filter > Show All Append Data is checked, all append data will be listed and the
symbol will be changed to A for the data obtained by the Append measurement or Sfor the data
obtained by the Single measurement.



Single/Append/Repeat measurement

Append

Single Repeat

P - s

o8, L Choose an application test object from the left area.

= Counter reset

| quick Test | Traces Test | lassic Test | Applicason T

ic-Vaa for

I 3

[Aag  [Setup Name [Date Count Device ID [Remarks

sl Workspoce (admsyator) 1] Thermometer OFF [ Mt Display OFF |G| Standoy OFF _[34] SMU Zero OF 5] Auto Bxport o | Aumo Record G

The EasyEXPERT provides three execution modes, Single, Append, and Repeat.
Single button triggers a single measurement.

Append button triggers an append measurement. The measurement results will be appended to
the Data Display window that shows the previous measurement results. The Data Display
window can have maximum 50 (20 if the amount of system memory is less than or equal to 1
GB) layers for displaying measurement results.

Repeat button opens the Repeat M easurement Setup dialog box used to set the repeat
measurement condition. To perform the repeat measurement, see Module 7.

To abort measurement, click Stop button that appears instead of the Single button.
To reset the counter, click the reset button.

Module 1
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To Save/Recall Your Test Setup

My Favorite button

File Edt View Run Teols Help

i Workpace e S e 0 0 e

B [category... -] /1e-vee @) setup Name : [icic
- B * [Device Parameters j
§ Polarity : [iich O] Temp: [50deg M|
2 e
v
¥ -
¥ ;
2 - ‘ Preset Group name.
H e: [NER 5 rn i
= et RO ] Use this field to select
2
1 } vestat: [ov 8] preset group.
2 veston : 5V 1]
e Secondary Sweep Velinearstep : 200wy 6] i
VE‘ Gate: [SusP ¥ tetimit : [T 50
R vgstart : ’17 utamit
ﬂ vostop: [10.0V | 3
Ievge Vgstep : W To W 8] =
g Manualpulseperiod : m
mfm ! Emitter: [GHDUGHE = puisewidth : [500us ]
e
|Fag [Setup Name |Date [Count  [Device ID [Remarks

T =

s Wokspce (Admristratie) [ Themameter o [E] ki Dispiay O [ Standy o ] i 7o o [B5 Auto BpertOFF ] Auts Record O

The test setups you create or modify MUST be saved in a preset group (My Favorite).
To save the setup, click the Save button.

To recall the setup, click the Recall button.

Y ou can organize the setups by using the My Favorite button.

To select the available preset group, use the field below the My Favorite button. In the above
example, the Demo group is selected and listed in the My Favorite list.

To rename, duplicate, or delete the setups, and to add, rename, duplicate, delete, import, or
export the preset group, use the function of the My Favorite button menu or the Organize Preset
Group dialog box shown in the next page.

Module 1
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To organize preset group for test setup

Keysight EasyEXPERT
File Edit View Run Tooks Hebp

=
]
wo: [10.0um &
Preset Group List o
Demo Add
Extende ool
New..
[T R
! Duplicate
B in: [Gileete
tmpart b [T hg:;'l_

Preset Group : Preset Group :
2 e
Setup Name 2
1 Trng 1d-vd
Source : [SMUZ:HP =
Trng Sampling
- =l
[Count _ [Device ID |Remarks |

2
1
3

A S|
A || W |

|N==3
[N

[l stancy o [o] sMUzerooFF [T Auto Export OFF | Auto Record ON

]

Thisdialog box is opened by clicking the My Favorite > Organize... menu, and is used to
organize the preset group.

*Preset Group List

Lists the preset groups saved in the workspace. The Add, Rename, Duplicate, Delete, Import,
and Export buttons are available to organize the preset groups.

+Copy

Sets the operation of the >> button and the << button. They work as Copy when this check box is
checked, and as Move when this check box is blank.

o>>

Copies or moves the preset setup selected in the left Preset Group box to the right Preset Group
box.

<<

Copies or moves the preset setup selected in the right Preset Group box to the left Preset Group
box.

*Close

Closes the Organize Preset Group dialog box.

*Preset Group

Lists the preset setups saved in the preset group. The Select All, Unselect All, Rename,
Duplicate, and Delete buttons are available to select or organize the setups saved in the preset
group.



To Export/Import Your Preset Group

Keysight Easy EXPERT
File Edit View Run Tools Hep

i [category..+] vth gmmax @] setup Name : [Vih omitax =

g |OeT B e ]

8 |ocvos

3 ) Discrete Polarity : [tich 0| Lg: [00om & L P | Run Options...

@ Exercise
O GenericTest Temp: [S0ces W] wMax: looma W count:[o 8] 1|
&5 mesmu_tv Device 1D :

ﬁ O Memory =]
2 [Test Extende  Concel Vi Fovontex
g T [ Exercse -
= WA Ol Rename_ =
tg Charge Pumpin Dpbas n
=1 Y T Drain: [5HI Debts »| 1-vd
% Q IntegTime: [MEDIUM | va: [0 Export
3
S | pemo-5-NorF G 2
Endurance Lock_ i)
= i ony .
cate: [ =] [0 [[N]  subs: [smi_ Readonh ]
Tmg Cgg-v +
B vostart: | Preset Group Export K| ﬂ]I— 1107
% B Vostop : srop [Gomssono -] + @cHEr «
Teng idvd idv VgStep : ‘: @0
My Reosnt
éﬁ Documents C‘j

Trng idvd idva.z] B &

A e Timg Samplne _
- EETTE RS —
r Zero-check

Zero-check i
! Tg Sampling -
1 ... Trng Sampling &l =l
sl workspace W Cropcon Fr Bl amresdon
Vs Fi e =] = )
Save a3 type: EasyEXPERT Prestt Group Fies Cancel
ya |

(=T}

My Favorite
button

Y ou can export/import your preset group.

To export the present preset group, click the My Favorite > Export..., and specify the folder and

the name of the preset group to export.

To import the preset group, click the My Favorite > Import..., and specify the preset group to

import.
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Fie Est View Run Tooh Help

To Export/Import Test Record

e e [ = - | . | -
—

@] sotwp vama: [Forvan

Polarity : [tich & Temp: [50ce0 W]

Initial Workspace
B <] vee-vge
5 [Coa =
H e [Device Parameters
il
3 Test Parameters.
r; kVoe ames
£ a8
E cvaet
cVge for
Y| ewencers
&
=
vih Vge{off) g
Vostart :
= vostop :
Ie{oflyvos Vastep :
o
B=
Vee-vge
B =

I =

W!
[asv 5]
m
m

Eritter: [GOUG]

|
. e |
e —
A B

1
2 SetupTitle ld-Vd
3| Application’ Id-Vd

T 4 TestParam Name
5 TestParam Value
6 DutParame Name

7 DutParame Value

8 MetaData TestReco! true

V[ [Fag  [Setup Name

T
IV Trace
Se—

oG U5 P
9/18/2009 4:59:38 PM 1
T Frarmoneter 67F [ Wit ispioy 07 [

1. Select data record to export, and right click.
2. Select Export > As xxxx.

To export multiple data, select Export > Folder-...

b
SMUZ:HPE SMUS:HR SMU1 HPH SMU4:HRE

—— 9 MetaData TestRecoi 11/08/2006 131759
10 MetaData TestRecol
11 MetaData TestRecol
12 MetaData TestRecol true
13 MetaData TestRecol
14 MetaData TestRecol
- “ 15 MetaData TestReco: 99c92al c-65kd-4081 -a747-9dck53c0a690
16 AnalysisSe’ Analysis St true
17 AnalysisSe' AnalysisSi
18 AnalysisSe: AnalysisS:
18 AnalysisSe: AnalysisSi

20| R O Kb i © VSl

To export the test result record, specify the data records and select the Export > As xxxx menu.

Module 1
Getting Started

Y ou can save the data records as an EasyEXPERT file, aCSV file, a XML spreadsheet file, or a

XML file created by using the specified XML style sheet.
Y ou can import the data record exported as the EasyEXPERT file or the XML spreadsheet file.

To import the file, select the Import... Then the Test Result Import dialog box is opened. On the

dialog box, select the file to import.

Y ou can read by using atext editor or a spreadsheet software as shown above. This example

reads atest record exported to a CSV file.

Note:

To export multiple test records, select Export > Folder..., and specify the destination folder and
file names automatically set. Then the multiple test records can be exported to the specified

folder.



Class Exercise

Perform Application Test.

. Connect device (MOSFET). See the following pages.

. Open 1d-Vd test definition in the CMOS library.
. Change the setup (SMU, output value, etc.)

. Click BB button to start a single measurement.

1
2
3
4. Create your preset group, and save your setup.
5
6

. Perform this exercise for the Vth gmMax test
definition.

Note:
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SMU Triax Connection
Force Lines to Fixture 1,2,3,4 Ports

Force side Sense side
N Vi
| JORCE |
CMU ©000 /
SMU4 T3: - @.,@ - 16442 A/B Fixture

SMU3 .= -

SMU2 T © i =@, ® -
~o—t—0.5 -

SMU1 - &.®- [ ©®.@-

GNDU

B1500A Rear View

For the non-Kelvin connections, connect only the Force lines, leaving the Sense lines open.

Connect corresponding numbers. On the 16442A/B fixture use the numbers labeled 1 - 6, not 1 -
3.

Y our B1500A may not match the SMU configuration shown in thisfigure. Note that SMU1 is
the module top of the GNDU (ground unit). The SMU number become large from bottom to top
as shown.

Thisisthe SMU cable setup that will be used in the remainder of the class exercises.
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Jumper Leads - MOS transistor

GNDU
FO n®,
s©
O
6
@)
12
@)
8
1 2 C‘% i - o IS(ZOS
© © s |00000000000000) % 16088-60002
VMU 9 I g Dual in line package
7
@ C?D lIIIEI[IEIIIII]IIII]I]I]I]IIII]IIII4 (28 pin)

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with
force and sense, or six SMUs with force only. For this class example we will use the six (6)
SMU scheme. On older fixtures, this scheme is shown in light blue lettering. In newer fixtures,
this scheme is shown in white reverse background lettering.
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Sub

Device Orientation and Insertion

15

gouoooooooopd

Insert the transistor last,
AFTER connecting the
cables and leads. Remove
the shorting wire after
insertion in the socket.

1: Substrate
2: Source

3: Gate

4: Drain

14

The MOS FET leads must be re-arranged into a straight line as shown.

IMPORTANT:

Module 1
Getting Started

The MOS FET is highly sensitive to electrostatic damage. Touching the bare leads can definitely
destroy the device. The device comes with a special shorting wire attached. Bend the leads the
way you want, insert the device in the socket, and then remove the shorting wire. The wire hasa

tab. Just grab the tab and pull straight out. The wire will spiral out as you pull.

Once the shorting wire isremoved, you must use awrist strap when handling the device.
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Flle Edit Wiew Run Tools Help
s Y I P
& | category... ~| 1d-vd @)| setup Name : [i6-vd T —
1. check 5[5 e 1 <+— 4. create
bl 4 505
B Ef:;;.:ﬂsl Polarity : [Hch ] Lg: [100 nm ] wo: [ooum  H] —5 save
E MESMU_IV Temp: [25.0deg ® IdMax: 10 mA 0}
"
% Library T | Test Parameters Extended Setup... " j
] i Primary Syeen
3 [ orain o e |
= 1d-Vd pulse VdStar-
= vdStop : |[2uu v L]
2. select : 3.‘chanJge
3 [ B vdstep: [Somv W] = | =
\Id—vdpulse[]'i 3. change[
e : (s 3. change | ||
ey a2’ ” ] subs: [[swue <]
VoStop: 200V W] '% Vsubs: [0V §] i
E VoStep : |So0mv | o«
[ e 3. change
m « i ||
»| [Fag  [Setup Name [Date [Count " [Device 1D [Remarks
GUMMEL 2006/11/16 11:11:10 1 PLC16
ﬁ ALWG monitor 2008/02/01 20:36:02 1
& IDVG 2006/11/15 17:31:40 1 PLC16
lntited 1] Thermometer OFF =] Multi Display OFF [ ] Standoy OFF [0 s Zero OFF [ Auto Expart OFF ] Auto Record ON
Test result data (record) is automatically saved after measurement.

1. Check the CMOS check box.
2. Select 1d-Vd (or Vth gmMax) and click the Select button.

3. Change the SMU setting as follows.
Substrate: SMU1
Source: SMU2
Gate: SMU3
Drain: SMU4

4. Create your preset group (ex. Exercise).
5. Save the changed setup to your preset group.

After this class exercise, the 1d-Vd setup and the Vth gmMax setup will be saved in your preset
group.
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Result Example

| Flle Edit Vview Zoom Axis Marker Cursor Line Text Pointer Window Help
| g I BB - e B 23 W =y
@-Elz 8W-5¢ BEEFMS E-F-EHE X ERE ERE
Setup Name : [1d-vd [(1) ; 2015/04/13 20:06:42] X
X-Y Graph Plot Preference v |
(a)
10m
c
3
2
1.00 m
Jdiv
0
0 Vdrain (V) 200 m /dv
| List Display Preference ~
Index Vgate Vsource Vdrain Vsubs ldrin 1drainPerWe =
I |
2 500.00 mV ov 50.0 mv ov 49.99nA 39000000 nA/um
3 500.00 mV ov 100.0 mv oV

99.99 A 39000000 nA/um

Thisisthe Id-Vd measurement result example of the following source setup.

Gate voltage: 0.5V to2V, 0.5V step
Drain voltage: 0V to 2V, 0.05V step
Source voltage: 0V

Substrate voltage: 0V
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To Perform Quick Test

Fle gt View Run Tooks Hel

Untitled i | Device ID : = : Count:[0 1

@ [My Favorite Setup_- ‘ 1

% I prf_sgtcmup:l[mm _L‘_l

§ (o SetupName Repeat Quick Test List

= 1d-vd =

B M vth gmMax ~ 1 Select All

S

g

= CE

b £ 9

o

;-

&

g / s \ = I
G = = = I
© 163 Caysgn ExmyEXPERT (-] B3 (@ Vo _gmar - terght EosybXPERY — =5 |

File Edit View Marker Cursor Line Window Help File Edit View Marker Cursor Line Window Help

HERE Daaf@-EiaEHsE-U-436ly BEREEhacXd- DEHEHsGE-PA-EHEls
X | | sotupame: Frngmmas x|

o Froperties. | | [Parameters |

vih Wl

L

SotupMame: [BVd
[ Gragh Plat Properties |

)
om

Step 1: Click Quick Test tab.
Step 2: Select the Preset Group.
Step 3: Set the execution ON/OFF and the data record ON/OFF for each test.

Step 4: Connect DUT, and click the Single button. The EasyEXPERT starts the selected tests
from top to bottomin the list.

After the measurement, the test result datais displayed on the Data Display window. And the
Test Result Editor is displayed on the lower |eft area of the EasyEXPERT screen if the Auto
Record function or the Auto Export function is set to ON. Check the statusindicator at the
bottom of the screen.

Step 5: Analyze the measurement result data.
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.
To organize preset group for test setup
Fle Fdt Vew Run Toos Hep My Favorite Setup banner
Untitied Z5 veen: T = omp H
E Cancel ]
é Duplicate... pemo =l
'§ Import... — Repeat Quick Test List
= Export... 1 e
1 EEL L
L] e | [z
g Preset Group List
= [pemo
! w
g
g
=
Recall
Edit Repeat
preset Group: —J
]‘ Rename
Setup Name
Duplicate
Delete
[Flag  [Setup Name [
GUMMEL
g ALWG monitor Select Al
Untitied Aot OFF ] Auto Record ON

This dialog box is opened by selecting the Organize... of the My Favorite Setup banner menu,
and is used to organize the test preset group.

*Preset Group List

Lists the preset groups saved in the workspace. The Add, Rename, Duplicate, Delete, Import,
and Export buttons are available to organize the preset groups.

+Copy

Sets the operation of the >> button and the << button. They work as Copy when this check box is
checked, and as Move when this check box is blank.

o>>

Copies or moves the preset setup selected in the left Preset Group box to the right Preset Group
box.

<<

Copies or moves the preset setup selected in the right Preset Group box to the left Preset Group
box.

*Close

Closes the Organize Preset Group dialog box.

*Preset Group

Lists the preset setups saved in the preset group. The Select All, Unselect All, Rename,
Duplicate, and Delete buttons are available to select or organize the setups saved in the preset

group.
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Class Exercise

Perform Quick Test.

1.
2.
3.

Use the device connection of the previous exercise.
Open your preset group.

Edit your preset group as you want (changing the test
execution order etc.).

Save your preset group.

Perform Quick Test.

Note:
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Result Example

Vi _srmax et ExsyXPERT ==
Elle Edit View Run Jools Help [Fle EGt View Marker Cursor Une Window Félp
i BTN EPEEEEE RS- OEHE e E- - a6y
[My Favorite Setup ~ | SowpNama: [ g X
i  Graph Pt Proverties.. | | [Parsmeters ]

VRN LSRR 0 ¥ LSS 94 A LIPSO D § ) v oY

gmMax (36751 ms.

| Preset Group : [Demo

setup Name

Versght
Fle Edt View Marker Cursor Line Window Help

BERE Daafl-BiEEMNemEm-M- G5l
x

Propesties.. |
4/3/2006 7:07:37 PN 5
5 4/3/2006 7:01:40 PM| 2
Trng idvd idvg3 3/31/2006 9:21:00 B
Trng idvd idvg2 3/31/2006 9:19:56 A
Trng idvd idvg 3/31/2006 5:30:03 Bf 1
Ting idvd idvg 3/31/2006 3:58:54 P
vV LUVUSLLJLD L1 .20
o
= Wrain W0m S
Ytnital Warkspace: L] hermometer OFF |F2] Multi Display OFF [0 2 ol s
st isplay Properties._ |
Index Vgaze| Vsgwrce | ‘Vdan| euos[ Ban] lanPeiig A
1 500 W oV oV o 3.78pA 378 fAjum
2 S0 ov s av 1FErA  13.85A0m
<. »

Note:
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To Perform Tracer Test

File Edit View Run Tools QD“

| Quick Test] Tracer Test Jctassic Test [ Applicatior

save

Recall

Help
Untitled m“ Device D : ] | count :[0 ",
% 1/V Trace @| setup Name : [V Trace - ‘ [MyFavorite |
5 VARL jpare.___ ]
VAR2 @
CONST » Id-vd

4
abh-ScC iBRE/EERE Y = R
V Name 1 Name Mode Function [ Meas. Tim

ﬂ To add a channel parameter, press the [Add] button in this area. il 500us W

v| |Fag [Setup Name |Date |Count Device ID |Remarks |

o Trng Id-vd 2006/12/11 16:50:56 1

% Vth gmMax and 1d 2008/10/02 16:20:46 1

L GUMMEL 2006/11/16 11:11:10 1 PLC16

i ALWG monitor 2008/02/01 20:36:02 1 S
Untted (7] Thermometer OFF ] Multi Display OFF [3] Standoy OFF 0] SMU Zero OFF _[55] Auto Export OFF ] Auto Record ON

Step 1: Click Tracer Test tab.

Step 2: Select and define the source and measurement channels.

Step 3: Set the source output parameters.

Step 4: Connect DUT, and click the Single button to start a single measurement.

After the measurement, the test result datais displayed on the graph area. And the Test Result

Module 1
Getting Started

Editor isdisplayed on the lower left area of the EasyEXPERT screen if the Auto Record function
or the Auto Export function is set to ON. Check the status indicator at the bottom of the screen.
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Setup Example

I/V Trace ®| setup Name : [I/V Trace

50 mv/div. w
d 3 - Compliance :

Mode :
LIN-SGL w
Stop : =

ov @
No. of Steps :

SMU2:HR/AS «
Source : *
ov @

100mA &)

- 0 e ———
& | H{ES ¢m 3
V Name Function (&~ Meas. Time :
« SMU4HR v vd = d m V- vart v ~l ai4 - -I | 2us B
c SMU3:HR/AS + Vg m® Ig m Vv - VARZ e
Down S500us B
(s SMUZ:HR/AS v Vs m Is m® V v CONST v ~ 2

Y ou can compl ete the measurement setup by the following steps.
1. Click Add button and add SMU1, SMU2, SMU3, and SMU4.
2. Set the channel definition. See below.

3. Set the X axis parameter, polarity and maximum value.

4. Set the Y axis parameter, polarity and maximum value.

5. Definethe VAR1, VAR2, and CONST setup. See below.

Channel definition:
SMU1: Vsub, Isub, V mode, CONST
SMUZ2: Vs, Is, V mode, CONST
SMU3: Vg, Ig, V mode, VAR2
SMU4: Vd, Id, V mode, VAR1L

Source setup:
VARL: Stop 0V, Compliance 100 mA
VAR2: Start 2V, Stop 5V, NOS 4, Compliance 10 mA
CONST: Compliance 100 mA

Thisisthe MOSFET |d-Vd measurement setup example.

Module 1
Getting Started

This measurement setup is effective for the device connection of the Application Test class exercise.
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Class Exercise

Perform Tracer Test.

1.

2
3
4

Complete the measurement setup shown in the previous page.

Highlight the VAR1 Stop entry field and leave it.
Click button to start a repeat measurement.

VAR1

Rotate the rotary knob to change sweep range.

2 m|

Mode:

LIN-SGL »

101 B

Compliance:

100ms B

VAR2

Start:

2y B

sv B

Note:
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Result Example

I/V Trace

S0 ma

@| setupName: [IV Trace

VAR1 ¥

Mode :
LIN-SGL ~
i +
g 0
No. of Steps :

101 B
Compliance :
100mA B

VAR2 ¥
Start :

Stop :

Step :

No. of Steps :

CONST ¥

Unit :
SMUL:HP
Source : =
ov B
Compliance :
100mA H

Down

Unit

SMU4HR
SMU3:HR/AS -
SMUZ:HR/AS +

Function
VARL w

VARZ ~
CONST =

&

Add

Delete

Meas. Time :
2us B

Step Time :
500us B

Note:
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Graph Setup and Option Tools

Select reference traces

Capture a reference trace .
Select tracking traces

Replay traces

Set stop condition area Marker
Redo scaling Tangent line
Undo scaling Regression line
Auto scale Oscnlloscope view (B1505A)
Llne/Dot
Color and thickness

71 .....n |!mﬂ 5¢ | BEREY L] M-sa'

Unit V Name I Name Functlun

Add
To add a channel parameter, press the [Add] button in this area. I

Y axis setup X axis Setup |

Sample setups

X orY axis setup: Used to set the X or Y direction forward or reverse, the variables for X-Y
plot, the graph scale linear or log, and the plot polarity positive, negative, or both.

Line/Dot: Used to switch line or dots of trace.
Auto scale: This button performs auto scaling.

Undo scaling: This button is available for the graph zoomed in, and is used to return the graph
scale to the original setting. The graph can be zoomed in by the point and drag operation.

Redo scaling: This button is available if Undo scaling has been performed and is used to cancel
Undo scaling.

Set stop condition area: See “To Use Stop Condition” page.
Replay traces. Opens/closes the dialog box used for managing the record and replay of traces.

Capture areference trace: Used to capture the trace as the reference trace. Up to 10 traces can be
captured.

Select reference traces. Opens/closes the dialog box used for managing the reference traces.
Select tracking traces. Opens/closes the dialog box used for managing the tracking traces.
Marker: Enables/disables the marker.

Tangent line: Enables the marker and enables/disables the tangent line.

Regression line: Enables the marker and enables/disables the regression line.

Oscilloscope view: Opens/closes the Oscilloscope View window used for monitoring the
waveforms of output signals.

Color and thickness: Opens/closes the dialog box for changing graph color and trace thickness.
Sample setups. See “ Sample Setups’ page.
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For B1500A

Diode:
BJT:

For B1505A

Diode:
IGBT:
BJT:

MOSFET:

MOSFET:

Sample Setups

ID-VDS, ID-VGS, ID(off)-VDS, BVDSS
IF-VF, IR-VR
IC-VCE, IC-VBE, IC-VCEO, BYCEO

ID-VDS, ID-VGS, ID(off)-VDS, BVDSS

IF-VF, IR-VR

IC-VCE, IC-VGE, IC(off)-VCE, BVCES
IC-VCE, IC-VCEO, BVCEO, IC-VCBO, BVCBO

GaN FET (N1267A): 1ID-VDS, ID(off)-VDS,

ID-VDS Current Collapse,
FET Current Collapse Oscilloscope View

GaN Diode (N1267A): IF-VF, IR-VR, IF-VF Current Collapse,

Diode Current Collapse Oscilloscope View

The Sample setup button displays the sample setup menu. Clicking a setup name in the menu
applies its setup to the tracer test environment.
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Arithmetic Operation for Tracer Test

‘ Operator +, -, *, or / is set by clicking here. |

@| 1LV Trace Setup Name: [Rd-VGS
Rd [om]=vwos|/ o

Marker( 10V 0.0

10 mohm

Maximum 3 operations

Operation 1: Rd [ohm] can be defined by using
this area.

0ohm

Click the Option > Arithmetic Operation > Operation N (N: 1, 2, or 3) menu, the arithmetic
operation area appears at the top of the graph. Thisareais used to define arithmetic expressions
using the measurement result data. This function is useful to graphically display parameters
given by the expressions.

An expression can be defined by two operands and an operator + (addition), - (subtraction), *
(multiplication), or / (division). The following elements can be the operand.

*Measurement data

eSource data

*Redl literal constant (e.g. 2, 0.123, or 100E-3)

*Operation 1 result, for the expression of Operation 2 and/or Operation 3
*Operation 2 result, for the expression of Operation 3

Note: "NaN" isreturned for the invalid calculation results.

Note: To disable the operation, click the Option > Arithmetic Operation > Operation N menu and
uncheck the Operation N menu.
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Line/Dot

Setup Name: [I/V Trace

@|I/V Trace Setup Name: [[/V Trace

500 mv/div.

Clicking Line/Dot button
toggles the line type between
dotted and solid lines.

500 mv/div.

vd

Note:
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Zoom in and Undo/Redo Scaling

Il’oint and drag operation zooms in the graph.

500 mV/div.

Undo Scaling cancels the last zooming in.
Redo Scaling cancels the last Undo Scaling.

Note:

1-38



Module 1
Getting Started

Graph Minimum and Maximum

Clicking the maximum or
minimum value pops up the dialog.

Enter a value and
close the dialog.

e.g. Maximum is
changed on Y-scale.

10 mA/div.

Undo Scaling cancels the last change of
minimum/maximum value,
Redo Scaling cancels the last Undo Scaling

Note:
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Marker
Marker position Marker

[ I/V Trace 9[ Setup Name : [ID-VDS|

Marker( 16.99678 V 0.749969 A )

To move the marker:
* Rotate the knob.
+ Click somewhere on the
graph.
Click the Marker button + Use the mouse scroll button.
to display the marker.

=

2
<
£

=]
=1
=

Note:
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Tangent Line

Tangent line

I/V Trace @| \setup Name : [D-vDg
I -0.0270287 X Intercept

Marker( 2.60052V 0.1831A)
1.88349E-003 Y Intercept |
________ . X-intercept

* Y-intercept
* Gradient

100 mA/div

Click the Tangent line button
to display the marker and the
tangent line.

2 V/div

| ine parameters:

Module 1
Getting Started

Note:
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RegreSSion Line 2. Point and drag to specify the data

used for the regression calculation.

®| 1/V Trace __ Setup Name: |I0-VDS Line pal'ameters:

Marker( 14400

+ X-intercept
3. Click the trace to draw * Y-intercept
the regression line. * Gradient

100 mA/div

Marker e

7 e |

1. Click the Regression line
button to display the marker.

Note:
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Oscilloscope View

I/V Trace

ID-VDS Pulse G 3.5kW

Setup Name:

Rectangular marker @i

501A B
VAR2 ¥
Start:

48V W
Stop:

v e
Step:

// 366.666 mV

NOS:
78

e —

5 Vi : Oscilloscope view |

[T
Oscilloscope View
File Data Setup Window
MARKER: 70 us

A Marker

50 us

Tr—ABNY

Oscilloscope view is opened/closed by clicking the Oscilloscope View button or selecting the
Option > Oscilloscope View menu on the Tracer Test screen.

This function monitors a point of the pulsed sweep measurement or the pulsed spot measurement
and displays its waveform. The monitoring point is specified by arectangular marker on the
trace. Thisfunctionis used for monitoring the time rel ationship between multiple channel
outputs/measurements, the change of the output level for the gate drive channel, and so on.

Thisfunction isvalid for using one or more VPULSE or IPULSE channels. And thisfunctionis
not available for the following measurement resources.

*HRSMU, HPSMU, MPSMU
*MFCMU

*WGFMU

*SPGU

*GNDU

Data names set in the V Name and | Name fields of the channel area are used to specify the
target monitored signals.

During executing the tracer test, the waveforms within the specified duration are displayed in
thiswindow graphically.
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To Use Stop Condition

@ 1. Click the Set stop condition area button. ‘

Sweep measurement is stopped
if the measurement data enters
into the abnormal region.

100uA| >

8

Note:
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To Use Replay Function

Automatic trace record ON/OFF
Open trace record
\ | Save trace record

/
] L f— |

|(?lick the Replay traces button to open this dialog box.

VHOH .\'J ‘
- i1 |[=— Selects recorded trace.

2 S e

play Interval:
100ms B N: Trace number
Haxknum Reoord: ] M: Total number of recorded traces
Recording Interval:
0s B

Up

To add a channel parameter, press the [Add] button in this area.

Down

P DEEE i EeECEER
Unit: V Name: 1 Name: Mode: Function:

Use the slide bar or the arrow buttons (<<, <, >, >>) to select the recorded trace to display.

Long-clicking the << or >> button changes the trace sequentially.

Replay Interval isused to set the time interval of the long-click operation of the << and >>

buttons.

Maximum Records is used to set the maximum record count. After the record number reaches

Module 1
Getting Started

this value, the record numbers are shifted to the newer side and the oldest record is deleted. This

number is always assigned to the last record.

Recording Interval is used to set the timeinterval of the automatic trace record operation.
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To Use Reference Trace

@| 1/V Trace Setup Name: [ID-VDS

Comparing with reference trace
expressly shows difference in such
as thermal drift effect.

Setup Name: [ID-VDS

100 mA/div

Click the Capture a reference trace
button to capture the trace as the
reference trace.

Note:
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Select reference traces and
Select tracking traces

Show/hide selected trace
Inversion

Erase selected trace

| Open a trace Erase selected trace

| Save selected trace \

1l
{ %)
EN [T E:
Trace | Time Trace
(372672009 T5027PM | vi-i1 3/26/2009 5:27:0 Vi-11
3/26/2009 5: vi-1

‘ Select tracking traces ‘

[T [ I R S s 1 [ |
Unit: V¥ Name: 1 Name: Mode: Function: @’
i To add a channel parameter, press the [Add] button in this area. i

Down Delete

Reference trace means the trace set as the reference by using the Capture a reference trace
button. Up to 10 traces can be captured.

The Select tracking traces button is available for the measurement result which contains at least
two traces by the append measurement. Tracking trace means each trace of this measurement

result.
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GUI of Source Setup Area

lick title bar to display hidden parameters.

_I;C
VAR1 v VARL 2

o &l [Point and drag
operation slides the
source setup area.

OFF |
Mode: Mode: Hold Time:
LIN-SGL + LIN-SGL ~ 0s M
Stop: Start: VAR2
sv ov B — 2]
NOS: Stop: -
101 B sV B 5 v B
Compliance: Step: Stop:
100mA B 50 mv - 5V @
NOS: D
VAR2 ¥ I 01 B s v
Start: . Interlacing: :
2v & 1E &
Stop: \ Compliance: Compliance:
sv B 100ma @ 100uA @
Step: Pwr Comp.: Pwr Comp.
iv OFF B
NOS: V Compliance:
4 8 oFf B
Dual Polarity:
CONST ¥ OFF ~
Unit: Hold Time:
2 o 0s |
Sourd
VAR2 and VAR2 |
Comp) " Start: Compliance:
CONST hide 2V B 100maA @
. Ston:
meas| Dehind. ( Meas. Time: Meas. Time:
e | 2us B 2us
Step Time: Step Time: Step Time:
s00us B S00us @ S00us

Hidden parameters
are displayed.

The source setup areaistoo small to display all setup parameter. So the source setup area

Module 1
Getting Started

provides two display mode, short and full. To switch the mode, click thetitle bar, VAR, VAR?2,

or CONST. You can see the hidden setup parameters. Also use the point and drag operation to

display the hidden parameters.
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VARI1 Setup Parameters

VAR1 =
tode: et o| «———Mode:  LIN-SGL (linear single sweep)
Start: LOG-SGL (log single sweep)

o B
Stop: ! LIN-DBL (linear double sweep)

5v B

Step: LOG-DBL (log double sweep)
500 mv
NOS: . .——NOS (numbers of steps)

Interlacing: Baseline of Pulse Period

. g| — Interlacing

Compliance:

! |

100mA /Power Compliance 3 i

Pwr Comp.: | H
e Voltage Compliance H H

V Compliance:
G ] Pulse Base:

Pulse Base: -—
ov § Pulse Base

ov B
Pulse Width: o
Pulse Width: ‘ P :
ims B 1ms @]« Pulse Width | "~ | <: Measurement

Pulse Delay: L
0 B Pulse Delay
Dual Polarity: P
OFF ~ Meas. Delay =,
Hold Time:
0s @ /
Meas. Delay: | 41
AUTO B
Meas. Time:
2us B

Pulse Period: e e Pulse Period

AUTO E

Pulse Delay:

0s B

In the short mode, the VARL setup area shows Mode, Stop, MOS, and Compliance only.

In the full mode, Start, Step, Interlacing, Pwr Comp., V Compliance, Dual Polarity, and Hold
Time are added.

For the VPULSE/IPUL SE source, Pulse Base, Pulse Width, Pulse Delay, and Meas. Delay are
also added.

When a pulse source is set, Pulse Period is available instead of Step Time.

V Compliance is effective only for UHCU, UHV U, or HYMCU. Thisisthe limit value for the
voltage sweep output. The output voltage of the measurement resource is automatically
measured, and the measured voltage is compared with thislimit value. And then, if it exceeds
the limit, the measurement status is set to the compliance status, and the sweep measurement
stops. Voltage range and setting resolution depend on the measurement resource.

If Dua Polarity is set to ON, the VAR channel performs positive sweep from start to stop and
negative sweep from -start to -stop in this order. For the pulsed negative sweep, the pulse base
valueis-1*(Pulse Base).
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NOS and Interlacing

For “NOS =3” and “Interlacing = 5"

Output Total 11 points
Stgy = il R v s
P 2 points 2 points
2 points
3 points 2 points

Center ---- I I S

—_— S Y Y

Sweep 1 2 3 4 5

For “NOS = 11" and “Interlacing =1"
Output
4 Stop "mTmmmmmmmmommmmmssmsmsosmmsosomomseos rT

11 points

- oI

Sweep 1

Time

This slide explains the effect of the Interlacing parameter. The NOS parameter sets the number
of stepsin a sweep operation. And the Interlacing parameter sets the number of sweep
operations performed in a single measurement.

Thisisthe example of NOS=3 and Interlacing=5. At first, the sweep measurement is performed
for the Start, Center, and Stop values. After that, the sweep measurement is repeated four times
to narrow the sweep step. This results the same sweep steps as the sweep output of NOS=11 and
Interlacing=1 although the timing is not same for some steps. By using the Interlacing, you can
see the rough characteristics in the early stages. Thisis effective for the measurement such as
the total pulsed sweep time is so long.

For NOS=N and Interlacing=M, the sweep isrepeated M times so that the final sweep step is
equal to Step/M. Total number of stepswill be N+(N-1)*(M-1).

The Interlacing is the function only for the Tracer Test environment. Thisfunction is not
available for the other test environment. Also this function is not covered by the FLEX
command set.
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Pwr Comp. — Power Compliance

@| I/V Trace Setup Name: [ID-/0S

LIN-SGL
ov |

20v E

200 mv.

Power limit is set
to SW.

100 mA/div

2 Vidiv
VDs
Unit: VName: IName:  Mode: Function:

Up c SMUZHP vGs m 6 m Ve VAR -
9 SMU4:HC VDS m D m V¥ VARL -

2us W
Step Time:

Power compliance is effective to limit power consumption in the device.
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To Control Switching Matrix

@ Switching Matrix Operation Panel

Jokd

Switch Setup

setup Name || [1t07

g
-4
&

[SWM IN2

Hi
Zle
< IS
5|7
W
=
s
=

ki

WM IN3/SMU2:HP

SwM ING

i,

SWM ING

WM IN8

Export to Current My Favorite Group Open All

5 6 7 8 9 10 11 12

Apply Switch Setup

Read Switch Setup

This function
is not available
for B1505A,

Module 1
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B1506A, and
B1507A.

-

[SWM INO

Recall

SWM IN11

SWM IN12

= = s =
= = = =
= = = =
= = Z =z
z z 3 &
@ = @ @
2 2 +
g = &
= ES I
S Ed
T

SWH IN14
ORI R A A S R N
« | »l

Step 1: Click Switching Matrix button to open the Switching Matrix Operation Panel.
Step 2: Enter the switch setup name.

Step 3: Define the switch setup by using the matrix on the operation panel window. Label can be set to input
ports and output channels.

Step 4: Click the Apply Switch Setup button to send the switch setup to the B2200/E5250 switching matrix.

Note: Before clicking this button, connect the B2200/E5250 to the B1500A via GPIB, and set the
configuration. To set the configuration, see Module 8.

The switch setups you create or modify MUST be saved in a preset group.
To save the setup, click the Save button.

To recall the setup, click the Recall button.

Y ou can organize the setups by using the Preset List button.

To select the available preset group, use the field below the Preset List button. In the above example, the
DemoSW group is selected and listed in the Preset List list.

To rename, duplicate, or delete the setups, and to add, rename, duplicate, or delete the preset group, use the
function of the Preset List button menu or the Organize Preset Group dialog box shown in the next page.

Read Switch Setup: Read switch setup from B2200/E5250 via GP-1B and show it on the operation panel
window.

Note: EasyEXPERT supports the E5250A installed with the E5252A matrix card.
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To organize preset group for switch setup

P

Export to Current My Favorite Group

3 4 5 6 7 8 9 10 11 12

Demosw

New...

Rename...
Delete
Duplicate...

SWM IN11 1

T
JC__]
\

SWH IN13

SWH IN14

This dialog box is opened by selecting the Preset Group > Organize... function of the Preset List
button menu, and is used to organize the switch preset group.

*Preset Group List

Lists the preset groups saved in the workspace. The Add, Rename, Duplicate, and Delete
buttons are available to organize the preset groups.

+Copy

Sets the operation of the >> button and the << button. They work as Copy when this check box is
checked, and as Move when this check box is blank.

o>>

Copies or moves the preset setup selected in the left Preset Group box to the right Preset Group
box.

<<

Copies or moves the preset setup selected in the right Preset Group box to the left Preset Group
box.

*Close

Closes the Organize Preset Group dialog box.

*Preset Group

Lists the preset setups saved in the preset group. The Select All, Unselect All, Rename,
Duplicate, and Delete buttons are available to select or organize the setups saved in the preset

group.
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To add switch setup to test preset group
;;t Yiew  Run Tools  Help : ‘V - : I — :
My Favorite Setup_~ ]
! Preset Group : [Demo =l
Setp Name S N e

 1¢-vd owithsewp |

*H 1to7 Je ,ITm; = ] EXport to Current My Favorite Group Al

Output: 1 2 3 4 5 6 7 8 9 10 11 12

Apply Switch Setup

Read Switch Setup

Preset List -

SWM INL [ = Damasw =
SWM IN2 OpenAl

1to7

b J[_]
[Flag__[Setup Name ]
Tmg 1d-Vd ]

Vth gmMax and Id 1

fmone  J[]

SWH INS
SWM ING
SWH IN7
SWM INS
SWH IN9

Switch setups can be saved in the preset group for test setups.
Click the Export to Current My Favorite Group button. The switch setup will be converted to a
classic test setup and saved in the My Favorite group opened in the main screen.

To select the available preset group, use the Preset Group field. In the above example, the Demo
group is selected and listed in the quick test setup list.

To duplicate, import, or export the preset group, use the function of the My Favorite Setup
banner menu or the Organize Preset Group dialog box shown in the next page.
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Class Exercise

Add switch setup to test preset group.

1.

Create a switch setup.

. Create your switch preset group, and save your setup.

2
3.
4

Add the switch setup to your test preset group.

. Save your test preset group.

Note:
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To Manage EasyEXPERT Main Windo
Tools > Preference...
Fle Edt View Run [Toob
Untitied Devke D : o | count :[0 1[§.
E My Favorite Setu ata Displd |
s Preset Gr¢ siso = -1 —
2 » Preference - M‘—
g Setup Name
2 B 1vd L Preference Group: [BE =] General
& . Vth gmMax User Level
% ¥ 1to7 Window Layout \
I
] I™ Legacy (A.05.60 Compatible)
ki
g Sub Window
g ¥ category ¥ Library ¥ Test Results
ki
% I~ Run Control [~ Administrative Tools & Soft Keys
<
[t ¥ My Favorite
¥ Toolbar
¥ workspace Name Width : [245 L]
¥ Run Control ¥ Counter
¥ DeviceID I” Administrative Tools
[~ Input Assistance I~ Running Animation
Reset to Factory Default =
Setup Name Date 7
Trng Id-Vd
Vth gmMax and 1d 2008/1(]|_Reset Al to Factory Default | oK cancel | apoly | 1

The Preference window is used to set the default setting of the EasyEXPERT main window, the
Data Display window, and the Test Definition Editor. Thiswindow is opened by selecting the
Tools > Preference... menu of the main screen. To set the default setting of the EasyEXPERT

main window, select General by using the Preference Group menu. The following setup items
are available.

*Legacy (A.05.60 Compatible) check box sets the GUI layout as same as the EasyEXPERT
revision A.05.60 or earlier.

*Check boxes in the Sub Window select the visibility for the panel/tool bar.

Reset to Factory Default button resets the setting selected by Preference Group to the setting at
the factory shipment.

Reset All to Factory Default button rests all setting to the setting at the factory shipment.
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To Manage Test Definition Editor

Tools > Preference...

Preference Group :

Test Definition Editor

Window Layout |

[ Legacy (A.05.60 Compatible)

Reset to Factory Default
Reset All to Factory Default | 0K I Cancel [ Apply J

To select the appearances of the Test Definition Editor, select Test Definition Editor by using the
Preference Group menu. The following check box is available.

Legacy (A.05.60 Compatible) check box sets the GUI layout as same as the EasyEXPERT
revision A.05.60 or earlier.
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To Manage Data Display Window

Tools > Preference...

Preference 1 &
Preference Group : W Data DiSplay

Color and Style ‘ Graph Trace Color | Format | Text Size | Options |

Color Style

Background :
Text:

Grid :

Line/Cursor :

VAR2 Label :

Il

|Ad]acent _'J

Use Preset Graph Colors :  |Customized -

Reset to Default | Reset to Factory Default J

Reset All to Factory Default ‘ OK I Cancel Apply l

To set the default setting of the Data Display window, select Data Display by using the Preference
Group. The following setup items are available.

The Color and Style tab is used to set the color map and style for the Data Display window.

« Y ou can change the color of the background, text, graph grid, line/cursor, and VAR2 label. The color
palette is opened by clicking the pattern of the item.

« Y ou can change the line style of the graph grid and line/cursor.

« Y ou can change the position and display style of the VAR2 label.

The Graph Trace Color tab is used to set visibility, color, style, and thickness of the datatracesY1to Y8
plotted on the graph.

The Format tab is used to set grid rule and value display format.

» Maximum decades to show ticks sets the maximum number of decades to show the minor ticks for the
log axis. If the number of graph decades is less than or equal to the entered value, the minor ticks are
displayed. If it is greater than the entered value, the minor ticks are not displayed.

» Analytic Value's Display Format selects the value notation and the number of digits to display the
analytic values.
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To Manage Data Display Window

Tools > Preference...

Preference 1 &
Preference Group : W Data DiSplay

Color and Style ‘ Graph Trace Color | Format | Text Size | Options |

Color Style

Background :
Text:

Grid :

Line/Cursor :

Il

VAR2 Label : |Ad]acent _'J

Use Preset Graph Colors :  |Customized -

Reset to Default | Reset to Factory Default J

Reset All to Factory Default ‘ OK I Cancel Apply l

The Text Size tab isused to set the font size for the graph. The available settings are Largest, Large,
Medium, Small, Smallest, and Fixed. For settings other than Fixed, the appropriate size is automatically
selected. For Fixed, afont size entry field is provided, and the specified font size is always applied.
*X/Y Axis Title: Font size for the axis title

*Scale: Font size for the X and Y coordinate values

L egend: Font size for the graph legend

The Optionstab is used to select if the following items are displayed on the Data Display window.
«Setup Name

*Keysight Logo: Displays the Keysight logo at the upper left on the X-Y Graph.

*Grid: Displays the grid in the X-Y Graph.

*Marker Guide Line

*Active Side Indicator

*All Subscale Values

*Unit Symbols

*Secondary Sweep Labels

*Device ID

*Setup Summary : Displays the channel setup summary information of the I/V Sweep or Multi Channel
I/V Sweep Classic Test at the bottom of the area.

eParameters: Enables the Parameters area.

*Always on Top: Displays the Data Display window on top of all the other windows..
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To Manage Data Display Window
Tools > Data Display...

© Data Display Manager |
Data Display Window Order Data Display Windows Configuration

 Keep Setup
Do not change the present Data Display
Windov figuration.

© Tiling
Resize and collate the Data Display
windows such that they fill up the entire
screen.

_oown_|

Select All linimize © Stacking

Resize and collate the Data Display
windows so that they overlap slightly with
n offset.

|ﬁninized Data Displays

© Overlaying

Resize, overlap and make transparent the
data display windows so that multiple
graphs can be viewed and superimposed
on one another.

I~ Apply same scale to all graph

Select All | Restore | close

OK

The Data Display Manager is used to control the appearances of the Data Display windows.
This window is opened by selecting the Tools > Data Display... menu of the main screen.

The Data Display Window Order area lists the Setup Name of the Data Display windows
opened. The list items from top to bottom correspond to the windows from front to back in the
screen image.

The Minimized Data Displays area lists the Setup Name of the Data Display windows
minimized.

The Data Display Window Configuration area provides the following radio buttons and a check
box to change the appearances of the Data Display windows. All functions are available for the
opened windows. See following slides for the display examples.

*Keep Setup: Keeps the present configuration of the Data Display windows.
*Tiling: Resize and collate the data display windows such that they fill up the entire screen.

*Stacking: Resize and collate the data display windows so that they overlap slightly with an
offset.

*Overlaying: Resize, overlap, and make transparent the data display windows so that multiple
graphs can be viewed and superimposed on one another.

The following check box must be checked to apply the same graph scale to all graphs.
*Apply same scale to al graph
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Tiling

File Data Display Help

® =23 (e
(O] (4)
100 m) 100m
Ibase 1o || Ibase
decadef . decade;
Jdiv] Jdiv
1 [t 1f
0 Vbase (V) 0
@& e
(O] ()
100 m 1 ({100 m|
Ibase 1o || Ibase
decadel decade
Jdiv] Jdiv]
1f 1f
0 Vbase (V) 0

Thisisadisplay example of Tiling.
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Stacking

File Data Display Help
@ 1T CummelDint /4

L
T

EEEhaaXd |

EI!;] SetupName:  [BT GummelFiot [(1) ; 9/3/2005 12:35:10 F
i X-¥ Graph Piot
1
11 @
1 100 m
1
1
Ibase
4
d
&
decade P
T [
= ST | S-S 1f
Li
m 0 Vbase (V) 100 m /div 12
1= <] >
1 ]Jm _ =
21 |7 [Etmspay
- g 1 [ ndex [ Voase | Tase | Teokector | hfe| ~
21 ov -14.531 pA 26.866 pA  -1.84887481.. -
alm)3|2 10mv 14302pA 11.183pA  -7.81918612...
! = 2RV 131034 ZEATIPA _cHIUELE. [
u] G-Plot Vbc=0V Pulse[3] 9/3/2005 12:33:52PM 1
o G-Plot Vbc=0V[3] 9/3/2005 12:33:00PM 6
o G-Plot Vbc=0V[3] 9/3/2005 12:29:18 PM 5

Thisisadisplay example of Stacking.
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Overlaying

_File Data Display Help
@ BUT GummelPlot [(1) ; 9/3/2 12

EEEbaQRE- B

| Setup Name: [BJT GummelPlot (1) ; 9/3/2005 12:

RY e mE-FA-5

[X-¥ Graph Plot | [Parameters ]
®
00 m
Ibase e
decade
|l
Lf <
0 Vbase (V) 100 m fdiv 1.2
sl )
[Gstoispiay |
Index | Vbase | Tbase | Teotector| e ] A
1 ov -14.531 pA 26.866 pA -1.84887481...
2 10my -14.302 pA 11.183pA -7.81918612.
:! gD mv -l:‘.}D? PA g?,??“ PA -l'?BEZEISA ~
Setup Name [ Date [ Count [ Device ID [Remark:
[=] BIT GummelPlot 9/3/2005 12:37:25PM 4
] BIT GummelPlot 9/3/2005 12:36:28 PM 3
BIT GummelPlot 9/3/2005 12:35:58 PM 2
BT GummelPlot 0/3/2005 12:35:10PM 1
] G-Plot Vbc=0V Pulse[3] 9/3/2005 12:33:52PM 1
O | G-PlotVbe=0V[3] 9/3/2005 12:33:00PM 6
o G-Plot Vbc=0V[3] 9/3/2005 12:29:18 PM 5

Thisisadisplay example of Overlaying.
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To tile/stack/overlay windows
Stacking

Overlaying

] v

frup wame: [ o =
1

TV g (1) 672008 9458 90 K Lo

CEE LT S

<+— Tiling

When some Data Display windows are opened, the following Windows menu functions are

useful.

Tiling
Tiles all Data Display windows on the screen.

Stacking
Stacks all Data Display windows on the screen.

Overlaying

Module 1
Getting Started

Overlays al Data Display windows on the screen. Then the position, window size, and visibility

of the most front window are applied to all windows on the screen.

The background of the X-Y Graph area is cleared except for the most back window.
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Module 2
Data Display and Management

In This Module

+ Data Display window

*  Graph Analysis Tools

* Data Status

* To Change Graph/List/Display Setup
* To See Print Preview

* To Print Display Data

* Exporting to Excel

* To Copy Graph Plot/List Data

* To Save Analysis Result

e To Use Preview Window

This section describes the above topics. Y ou will understand how to use analysis tools, how to
change display setup, and how to print/export test result data.
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Data Display and Management

Data Display window

© Vth gmMax and Id [(1) ; 2008/10/02 16:20:46] - Keysight EasyEXPERT - =

File Edit View 2Zoom Axis Marker Cursor Line Text Pointer Window Help
[ olelol~ - i 2 R S P e
EEHRMNe & F- X B S
Preference ~ |Parameters ]
24,7914 US ) Vth 502,684 mv
10m gmMax  |793.150 uS
ﬁ am Intercept: vth@rd Esq.zno mv
E -676.306 UA “6306 mS
2 stm Gradient: Gradient:
- 7.931500E-004 7.931500E-002
7m
X-Y Graph Plot
p Parameters
5m
4m
= 3m
§
5 2m
im
0 | —
-500m  -200m 0 200.. 400.. 600.. 808, 1 12 14 16 18 2
Vgate (V) 200 m /div < il v
List Display N\ Preference v
Index_| Vgate | Vsource | Vdrei | N\ Vsubs| Idrain | gm| Isubs | A
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The Data Display window is opened after measurement automatically, or by clicking the Data
Display button. And the window is used to display measurement data and analyze the data.

The Show X-Y Graph icon displays/hides the X-Y Graph Plot area. Thisisthe same asthe View
> Graph menu.

The Show List Display icon displays/hides the List Display area. Thisisthe same asthe View >
List menu.

The Show Parameters icon displays/hides the Parameters area. Thisisthe same asthe View >
Parameters menu.

Multiple data display windows can be opened while the Multi Display indicator is ON. Then the
test result data of the same test setup name will be displayed on the exclusive Data Display
window and the test result data of the different test setup name will be displayed on the new Data
Display window. To set Multi Display ON, select the Run > Options... menu of the Main
window, check the “Allocate Data Display for each test” box on the Run Option dialog box, and
click the Close button.
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Graph Analysis Tools
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The Data Display window provides marker, cursors, and lines for analyzing test result data.
Marker is used to read measurement data and draw atangent line. Cursors are used to read the
cursor position and draw a normal line, gradient line, or regression line. The cursor/marker

position data is displayed top of the graph plot area.

Clicking Y axis can select the Y axis effective for the analysis tools. On the graph, left axisis
always Y1 axis. And theright axisis selectable from Y2to Y8 axes.
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Graph Analysis Tools
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Text and pointer are the tools to decorate the X-Y Graph.

The text is used to leave notes on the graph. The notes will be measurement conditions, device
information, operator name, and so on. Up to 20 texts can be added to a graph.

The pointer is used to indicate the remarkable measurement point and show the X and Y
coordinates like the marker. The new pointer can be displayed on the marker point at first and
can be moved on the measurement data curve by using the rotary knob or the mouse wheel. Up

to 30 pointers can be added to a graph.
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Graph Analysis Tools

Show Graph Legend

Show Line Information
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When alineisdisplayed, the line information can be displayed in the graph plot area.
The Show Line Information icon displays/hides the line information. Thisisthe same asthe

View > Line Information menu.

The Show Graph Legend icon displays/hides the graph legend. Thisisthe same asthe View >

Legend menu.
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Graph Analysis Tools
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If the append measurement is performed, the data display layer is added to the Data Display
window. In this example, the Data Display window has three layers.

Use the icons shown above to organize the data display layers.

Switch Display Mode icon switches the mode, overwrite or append.
In the overwrite mode, the data is displayed in a new Data Display window.

In the append mode, the data is displayed on a new display layer in the present Data Display
window.

The Data Display window can hold up to 50 (20 if the amount of system memory isless than or
equal to 1 GB) display layers. And the earliest layer over 50 (20) will be automatically deleted.
The Hold this layer icon is available when the window holds at least two layers. If thisicon
shows the standing pin, the layer will be held. If thisicon showsthe laid pin, the layer can be
deleted. Double clicking the tab gives the same result as thisicon.
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Graph Analysis Tools

Auto Scale
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Graph control:

Display Setup... icon opensthe Display Setup dialog box used to change the graph axis setup.
Choose Active Y axisicon selectsthe Y axisthat is effective for the analysis tools (marker

control and scaling).

Change Zoom Target axisicon selects if the auto scale or zoom operation is effective for al Y

axes or only for active Y axis.

Auto Scaleicon will change the graph scale automatically to fit the trace in the graph. The right
arrow button opens the menu for enabling or disabling the run time auto scaling. Thisfunctionis
set independently for the X and Y axes. If thisfunction is enabled, the graph scale will be
changed automatically to fit the trace in the graph during the measurement.

Mouse drag operation zooms in the graph.

Undo Scaling and Redo Scaling icons are available for undo& redo scaling operation.

If multiple layers are opened on the Data Display window, the scale change is applied to the
layers. This means that the X-Y graph scale will be shared by all display layers. The auto scaling

is performed as follows.
1. Graph scale is optimized for the data on the selected layer
2. The graph scale is applied to the graph in the all layers.

(top layer).

There is also afunction for resetting the graph scale. Click Zoom > Cancel Scaling or Cancel All

Scaling.

Cancel Scaling cancels the last scaling operation. Cancel All
operations.
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Graph Analysis Tools

Marker control
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Marker control:
Marker ON/OFF icon enables or disables the marker.

Interpolation ON/OFF icon enables or disables the interpolation function of measurement data.
Y ou can read the interpolation data between two actual measurement points.

Marker Skip icon moves the marker to the next measurement curve that is added by the VAR2

variable.

Marker Maximum icon moves the marker to the maximum measurement point.

Marker Minimum icon moves the marker to the minimum

measurement point.

Marker Search icon opens the Direct Marker/Cursor dialog box used to specify the coordinate

values to move the marker.
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Graph Analysis Tools
Line control
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Line control:

Line 1 State icon enables or disables line 1 and its function: normal, gradient, tangent, or

regression.

Line 2 State icon enables or disables line 2 and its function: normal, gradient, tangent, or

regression.

Cursor to Marker icon moves the cursor to the marker position.

Adjust Gradient icon is available when a gradient lineis active. Clicking thisicon enables the
rotary knob and the mouse wheel to increase/decrease the gradient of theline. Clicking thisicon
again, clicking the rotary knob, or clicking the mouse wheel disables this function.
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Marker > Enable
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To enable maker, click the Marker ON/OFF icon, or check the Marker > Enable menu.

To enable the Line 1, click Line 1 icon and select one of the line mode. Or check the Line >
Enable 1 and select one of the Line > Mode menu.

To enable the Line 2, click Line 2 icon and select one of the line mode. Or check the Line >
Enable 2 and select one of the Line > Mode menu.

If you enable the Normal line, two cursors are available. The cursors specify the points that the

line passes through.

If you enable the Gradient line, acursor is available. The cursor specifies the point that the line

passes through.

If you enable the Regression line, two cursors are available. The cursor specify the measured

data used to draw the regression line.
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To Draw Normal Line

Line N > Norma

Cursor To Marker
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Enable the Normal line by clicking the Line 1 (or Line 2) icon and Normal.

Move cursors to draw the line. The line passes through the cursor points.

To move the cursor, you can use the Cursor To Marker icon. The cursor will move to the marker

point.
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To Draw Gradient Line
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Enable the Gradient line by clicking the Line 1 (or Line 2) icon and Gradient.

Move the cursor to specify the point that the line passes through. And click the Adjust Gradient
icon.

Use the rotary knob or the mouse scroll button to adjust the gradient of the line.

To move the cursor, you can use the Cursor To Marker icon. The cursor will move to the marker
point.

2-13



Module 2
Data Display and Management

To Set Gradient Value
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Thisis another way to draw the gradient line.

Set theline 1 or 2 enable and select the gradient line mode. Then click Line > Gradient... to

open the Gradient Vaue dialog box.

On the dialog box, enter the desired gradient value, and click OK to draw the gradient line.
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To Draw Tangent Line

Line N > Tangent
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Enable the Tangent line by clicking the Line 1 (or Line 2) icon and Tangent.

Move marker to draw the line. The tangent line will pass through the marker point.
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To Draw Regression Line

Line N > Regression /Cursor To Marker
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Enable the Regression line by clicking the Line 1 (or Line 2) icon and Regression.
Move cursors to specify the region of the measurement data used for the regression calculation.

To move the cursor, you can use the Cursor To Marker icon. The cursor will move to the marker
point.
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To Fix a Line
Line N > Fix
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Tofix aline, click the Line 1 (or Line 2) icon and Fix, or select the Line > Line Mode > Fix
menul.

While the Line Mode is set to Fix, the specified line cannot move.
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To Add Text

Text > New...
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To add atext, click Text > New... . A text editor appears. Then enter the text you desire.

The following functions are available for the selected text(s) viathe Text menu, the Text icons,
or the right-click menu.

Clicking on atext will select the text. To select the multiple texts, click the text while holding
down the Shift key on the keyboard.

Edit Mode: Edits the selected text.

Size: Setsthe font size of the selected text(s). The available setting values are Largest, Large,
Medium, Small, Smallest, and Fixed Point (6, 7, 8, 9, 10, 11, 12, 14, 16, 18, or 20). For settings
other than Fixed Point, an appropriate size will automatically be applied. For Fixed Point, the
specified font size will always be applied.

Font: Setsthe font of the selected text(s).
Text Color: Setsthe text color of the selected text(s). Click Customize to open the color palette.

Background Color: Sets the background color of the selected text(s). Click Customize to open
the color palette.

Hide Frame: Hides the frame for the selected text(s).
Delete: Deletes the selected text(s).
Dragging atext moves this text.
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To Add Pointers

Pointer > New
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To add a pointer, set Marker ON, click Pointer > New. A pointer and description (pointer ID and
X-Y coordinate values) appear. Then move the pointer you desire by using the rotary knob or
the mouse wheel.

The following functions are available for the selected pointer(s) or description(s) via the Pointer
menu, the Pointer icons, or the right-click menu.

Clicking on a pointer will select the pointer. To select the multiple pointers, click the pointer
while holding down the Shift key on the keyboard.

Clicking on a description will select the description of a pointer. To select the multiple
descriptions, click the description while holding down the Shift key on the keyboard.

Shape: Sets the shape of the selected pointer(s).
Hide Description: Hides the description of the selected pointer(s).
Delete: Deletes the selected pointer(s).

The rotary knob or the mouse wheel can be used to move the selected pointer in the VAR1
direction. The pointer can not be moved in the VAR2 direction.

Dragging a description of pointer moves this description of pointer.
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If measurement unit detects any status while measurement, the status code is recorded with the
measurement data. In this example, a SMU detected the compliance condition in the drain
channel, so the status code C is put just before the Idrain value.

SMU status code;

* C: Compliance

* T: Other channel compliance
* X: Oscillation

* V: Overflow

MFCMU status code:

» U: Unbalance

* D: I/V amp saturation
*V: Overflow
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To Change Graph Preferences

Edit > Preference > Graph...

f Graph Preference ﬁ‘
Color and Style I G;ph Trace Culc;E F;rr;a;l. T;xtisiz;l Voanns ri ]
Color Style

Background : _I
Text: -
Grid : _I i:‘

Line/Cursor : - -

VAR2 Label : - [Adjacent =]

Use Preset Graph Colors :  |Customized -

0K | Cancel | Apply

The Graph Preference dialog box is used to set the following setting of the selected Data Display
window. This dialog box is opened by clicking the Preference > Edit... button in the X-Y Graph
Plot area or by selecting the Edit > Preference > Graph... menu of the Data Display window.

The following five tab screens and settings.

The Color and Style tab is used to set the color map and style for the Data Display window.

« Y ou can change the color of the background, text, graph grid, line/cursor, and VAR2 label. The
color palette is opened by clicking the pattern of the item.

« Y ou can change the line style of the graph grid and line/cursor.

« Y ou can change the position and display style of the VAR2 label.

The Graph Trace Color tab is used to set visibility, color, style, and thickness of the data traces

Y 1to Y8 plotted on the graph.

The Format tab is used to set grid rule and value display format.

» Maximum decades to show ticks sets the maximum number of decades to show the minor ticks
for the log axis. If the number of graph decades is less than or equal to the entered value, the
minor ticks are displayed. If it is greater than the entered value, the minor ticks are not displayed.
» Analytic Value's Display Format selects the value notation and the number of digits to display
the analytic values.

The Text Size tab isused to set the font size for the graph. The available settings are Largest,
Large, Medium, Small, Smallest, and Fixed. For settings other than Fixed, the appropriate size is
automatically selected. For Fixed, afont size entry field is provided, and the specified font size is
aways applied.

The Optionstab is used to select if the following items are displayed on the Data Display
window and if the Data Display window is always displayed at the foremost layer.

« Setup name, Keysight logo, graph grid, marker guide line, active side indicator, sub-scale
values, unit symbols, secondary sweep labels, device ID, channel setup summary, and
parameters.
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Setup Summary
'@ vin gmwax [(3) ; 2015/04/08 15:23:00] - Keysight EzsyexperT I ool oo |

File Edit View Zoom Axis Marker Cursor Line Text Pointer Window Help
BEEEE e Oy at-5¢ Hl 86 5 - WA - R EHEE R .

VthgmMax [(3): 2015/04/08 _ | Vith gmMax [(2) : 2015/04/09 15. | Vith gmMac [(1) : 2016/04/09 15. ‘ Vth emMax [(3) : 2015/04/09 15. ] Vith gmMax [(2) ; 2016/04/09 15 «| »

Setup Name : [vth gmMax [(3) ; 2015/04/09 15:23:00] = X
X-Y Graph Plot Preference ~ | |Parameters
KEYSIGHT

i vth Fa9.9350 mv

L 1om | 10n gmMax 100010 uS

] 5 5

= Intercept: Intercept: -

g 9m -65.0000 pA 1700000 fA

S &m Gradient: = Gradient: =

= 1.000100E-006 0 &

7m L S
§m ////
Sm -
4m

im

Zm

Idrain (A)

im

il Intercegt; | 64.9935uy "

S00m  -200m 0 200m 600 m 1 1.2 14 16 18 i
Vaate (V) 200 m /div
(VAR1) Unit=SMU3:HR/AS, Name=Vgate, Direction=Single, Linear/Log=LINEAR, Start=-500 mV, Stop=2 V, Step=50 mV, No. of Steps=NaN
[CONSTANTS] Unit=SMU2:HR/AS, Name=Vsource, Source Mode=V, Source=0 V, Compliance=10 ma
[CONSTANTS] Unit=SMU4:HR, Name=!
[CONSTANTS] Unit=SMUE:MP, Name=Vsubs, Source Mode:

List Display preference - | |
Index | vgate | Vsource | Vdran | Vsubs | 1drain | gm | -
8/20 450.0 mv ov 100.00 mv ov 450.00 nA 1.000000000 uS
8/21 500.0 mv ov 100.00 mv ov 45959 nA_999.9000000 nS
550.0 mv oV 100.00 mV’ oV 549.590A  1.000100000 uS

If the Setup Summary on the Options tab is checked, the channel setup summary information
shown below is displayed at the bottom of the graph area.

The setup for one channel is displayed with one line as follows. Where, theitemsin {} are the
setting values.

VAR1 Channel:

For the voltage output channel:

{V Name}: [{ Start}, { Stop}] V / {No of Step}; {| Name}: { Compliance} A; { Pwr Comp} W
For the current output channel:

{I Name}: [{ Start}, {Stop}] A / {No of Step}; {V Name}: { Compliance} V; { Pwr Comp} W
Example: VDS: [0, 10] V /101; ID: 1 A; 1W

VAR?2 Channel:

For the voltage output channel:
{V Name}: [{ Start}, {Stop}] V / {Step} V; {I| Name}: { Compliance} A; { Pwr Comp} W
For the current output channel:

{I Name}: [{ Start}, {Stop}] A/ {Step} A; {V Name}: { Compliance} V; { Pwr Comp} W
Example: VGS: [0,5] V/1V;ID: 1mA; 1mwW

Constant Channel:

For the voltage output channel:
For the current output channel:

{V Name}: { Source} V; {I Name}: { Compliance} A
{1 Name}: { Source} A; {V Name}: { Compliance} V
For the common channel: {V Name}: COMMON

Example: VSUB: -1V; ISUB: 1 mA
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To Change List Display Preferences

Edit > Preference > List...

Data Status

. Physical Unit
List Display Preference ﬁ I y

Displa l
pmvoata Status ¥ Physical Unit Example: —1.2345

Number Format

= Engineering Format (with Unit Prefix) EX&mple: -1.2345 mA
 sclentific Notation Example: -1.23456789012345E-003 A
OK I Cancel | Apply ‘

Thisdialog box is used to set the data display format in the List Display area. Thisdialog box is
opened by clicking the Preference > Edit... button in the List Display area or by selecting Edit >

Preference > List... menu of the Data Display window.

Display:

Check the following check box to add the data status or the physical unit to data. Unchecking the
box removesit.

*Data Status: Adds or removes the status code before data.
*Physical Unit: Adds or removes the physical unit after data.

Number Format:

Selects the data display format from the following formats.

* Engineering Format (with Unit Prefix):

Data display with arithmetic point, Sl prefix, and unit.

Example: -1.2345 mA

* Scientific Notation:

Data display with arithmetic point, exponential part (E, +/- sign, and three-digit number), and
unit.

Example: -1.23456789012345E-003 A
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To Change Display Setup
Edit > Setup > Display...
[Displuy Setup
X-V Graph —
| | | N
Name: Sharing:  Scale: Min: Max:
FoX: [vese =l =] [unear =] [soomv 8 2v &
¢ vr: [den =] [tone) =] [tnear  +] [0A & [1oma )
€ vz fm =] [tNone) =] [tnear <] [os | [1s ]
¢ v3: [den =] [tnone) =] [rog = [rfa | [1loma ]
List Display Parameters |
| | | | Dsa| foeete| G| o] |
e [voate =l |Vt 2
e [vsource =] e [Jomwax -
C |vir =l
C |veubs =l
C  |idren -
om [ |
0K I Cancel | Apply |

This dialog box is used to change the graph scale and data to be displayed in the Data Display
window.

The X-Y Graph area setsthe X and Y1 to Y 8 axes of the X-Y Graph Plot area.
Name: Specifies the parameter for the axis

«Sharing: Specifies the group for sharing the Y axis scale. Select from Group 1, Group 2, Group
3, Group 4, or None (no grouping). The Scale, Min, and Max values are shared by the Y axesin
the same group. The scale set by Run Time Auto Scale, Auto Scale, Zoom in, and/or Zoom out
are also shared. If another layer on the Data Display window contains an X-Y trace which has
the same name for both its grouped Y parameter and its X parameter, the scaling will also be
shared by this X-Y trace.

*Scale: Scale of the axis, Linear or Log
*Min: Minimum value of the axis
*Max: Maximum value of the axis

The List Display area selects the variables to be listed in the List Display area. Upto 20
variables can be set.

The Parameters area selects the variables to be listed in the Parameters area. Up to 20
parameters can be set.
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To See Print Preview

File > Print Preview

85 Print preview s @E
SO~ DDBEB |Cose | Page =]
Print Preview &
[ Print Range
& Whole DataDisplay e e AR IR R
¢ Graph Only | Setmprme [ i ) 3500 10220 ]
[ Data to print

@ Current Data Display
¢ All opened Data Display

[~ Scaling
& AdjustTo: |100  B|% Normal Size
¢ Fit To Page

o |

I

The Data Display window provides the File > Print Preview function to show the print preview.
Thisisan example of the print preview.

*Select the File > Print Preview menu to open the Print Preview dialog box.
*Set the Print Range, Data to print, and Scaling.
«Click Preview button. The Print preview window is displayed.
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File > Print...

Print

qia

Print Range
& Whole DataDisplay
" Graph Only

Data to print

@ Current Data Display
¢ All opened Data Display

Scaling
& Adjust To:
C FitTo Page
~

100 B|% Normal Size

Next

Cancel

To Print Display Data

File > Save Image...

[ Save Image As... E
Saven: [ W = emerE-
3 Q
LD [ @wrms
My Recent @My pice,
Documerts
;':}
Desktop
<
MyNetucdc  Flo name [ = (=
Saveastype:  [Bimap image [omp) = Guncd |

e

bmp, emf, gif, or png format

The Data Display window provides the display image output capability to a printer or afile.

Before printing, connect a printer via the parallel interface or the LAN, and set up it by using the
Add Printer Wizard of Windows. After that, do following.

*Select the File > Print... menu to open the Print dialog box.
«Set the Print Range, Datato print, and Scaling.

*Click Next button.

*Select the printer, and set the Properties.

*Click OK button.

Y ou can export the display image to afile as shown below.

*Select the File > Save Image... menu to open the Save Image As... dialog box.

*Select the format (file type) from Save as Type menu.

*Enter the file name.
*Click Save button.

The file can be imported by the graphics software that supports the exported file type. The
EasyEXPERT supports the following types.

*bmp: Bitmap image
*emf: Enhanced metafile
«gif: GIF image

*png: PNG image
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Exporting to Excel
File > Export to Excel

© Vi gmMax 2nd 1d [(1) ; 2008/10/02 16:20:46] - Keysight EasyEXPERT
[Fle) edt_view zoom Axs Merker Cursor Line Text Pomter Window Help

e ww b o -9 EEHE I.

Close Al CtrleShifte W

| 2008/10/02 16:20:46]
Update

Delete.

Save Image... QUIsS (e[ £5.300 my 1.00000uA 247934 uS)

Som 20m 0 Wm
Vgate (V)

Index | Vaate | Vsource |
2 500 me ov
x 6000 mv ov
2 6500 m ov

The Data Display window provides the function to export the graph image, list data, parameter
datato Microsoft Excel directly. Microsoft Excel 2003, 2007, or 2010 is supported.

Select File > Export to Excel. The graph plot is exported to Graph worksheet and the list and
parameter data are exported to List worksheet of the Microsoft Excel.

The style of the test records to export is defined by “Excel Data Export settings’ that is opened
by selecting Results > Export > Options > Excel Export...
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© Vth gmMax and Id [(1) ; 10/2/2008 4:20:46 PM] - Keysight EasyEXPERT

To Copy Graph Plot

o=l

| File [Edit] View Zoom Axs Marker

Cursor Line Text Pointer Window Help

® - 510 T T3 G N Y B
s 2 a0-9C DEHEE®S &5 BED EN,
opy List
£ CopyPaameters CoE A e x
Y sew > 2] Document - WordPad
Preference b File Edit View Insert Format Help
MARKER| 300 mv 1
DEd ER A 3b@E- B
. 6%u Aol
=} 650u Intercept:
S 600u -676.306 UA
= Gradient:
] S0u 7.931500E-004
500 u
0 Paste to WordPad
400u
350u MARKER{ 659.300 MV 1.00000 UA 24.7914 uS )
300u “
u
. 50u 3 60U Tnterospt
= 200u S 600u -676.306 UA
= 2 sy Gradient:
g 150u R & 79315008004
u
100u 450u
2l Intercept g >
ntercept: u
660 f 04
500 m 200m 0 200m 6 = g; 4
e u
Vgate (V) £ 1m0
= 1ou
List Display S0u
Index | vaate | Vsource | Vdran | 660 f
2 550.0 mv oV 100.00 mv g E
Z S00my ov Tosam | S0m  20m 0 20m §0m 112 14
= 6500 mv ov 10000mv Vaete () 2om dv
- For e, press 1

Y ou can copy graph image to the clipboard, and paste it to aword processing software. In the
above example, the graph image is pasted to the WordPad.

Thisis an example of the copy and paste operation.
*Select the Edit > Copy Image menu on the Data Display window.
*Select the Edit > Paste menu on the WordPad.
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To Copy List Data
© Vith gmMax and 1d [(1) ; 10/2/2008 4:20:46 PM] - Keysight EasyEXPERT ek
[‘Fite [Edit] View Zoom Axs Marker Cursor Line Text Pointer Window Help P N d
| AT T = Q. Paste to Notepa
B s e ab-9¢ OEERMe & e i
opy List 4l
3 oPy Parameters L 0/2/2008 4:20:46 P 4 Untitled - Notepad LEE
XV s y File Edit Format View Hglp
Index vgate vsource vdrain o
Preference » % 500 mv ov A -163.88 ps y
2850 mv v A =815
MARKER( 659.300 mV -400 mv v 2.7 ]
i 350 m v “éed, 7t
-300 v v -3,
- 690 u 6 -2 8 v v —SJS : Es
7 =2 mwv v s
S 650u Intercept: s 2150 av v 137 ps
> 600u -676.306 UA 9 -100 mv 2.52 ps
S 50 Sradlenp: it S 1 285000000001 ps
i u 7.931500E-004 3 Soav 0V 00 av s B
500 u 13 100 mv O V 00 mv 00000000001 pS
14 150 mv 0 v 00 mv 999939399999 ps
450 u 15 200 mv OV 00 mv 000000000001 ps
16 0 m 0V 00 mv ps
400 u 17 300mv OV 00 mv -1.51 ps
18 350 mv 0V 00 mv 2560. 000000000022 5
350u 13 .-:sa v g v Jg myv 2.603 5
2 50 my 0 v mv 16.9 ps
300u 21 0o av ov E m §5.27 ps
22 my v
= 250u 23 gom ov 0 v
24 my v v
= 20u 25 700 v OV d v
S ien. 26 750 mv_0 v v 0V
A B 120 ] F G 1 ) K L = N
1 firdex  Vpste VsourceVorain Veubs ldmin  gm =t 00 mv v
2 1 500 mV ov 100 mv oV o o 00 mv v
3 2 ~450mv ov 100 my ov o 5 Qm ov
] 3 400 mv ov ov v m 0 v 5
5 x o o ¢ 00 mv OV  1.088759 ua -
6 s ov ov
7 6 ov ‘ ov -
8 7 ov 100 mv oV 200 m /div |
8 8 ov 100 my ov
10 9 ov 100 mV ov
i ov__ _wwm oV =Open by a spreadsheet software
12 oV 100 mV ov
13 ov 100 my ov 9nA  2.180922000 uS -2.336 pA
14 ov 100 my ov 1nA  6.599811000 US -2.439DA
15 5 ov 100 mv ov L7nA 1895719000 uS 2,565 pA -
M TNt /1 141

Y ou can copy the datalist to the clipboard, and paste it to aword processing software. In the

above example, the datalist is pasted to the Notepad.

Thisis an example of the copy and paste operation.

*Select the Edit > Copy List menu on the Data Display window.
Select the Edit > Paste menu on the Notepad.

Y ou can save the data as atext file, and read it by using a spreadsheet software. Data elements

are separated by atab.
Note:

As same as the Copy List function, the Copy Parameter function is used to copy the datain the

Parameter area.
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To Save Analysis Result

Select File > Update F— Saves graph information to data record.
Select File > Save Image...

—> Saves graph image as a file.

i Vth gmMax and 1d [(1) ; 10/2/2008 4:20:46 PM] - Keysight EasyEXPERT L | @
File JEdit View Zoom Axis Mrker Cursor Line Tet Pointer Window Help
i =] o =y @ e ol 2 | © - 3 it [l
BEEEEE- O ah-5¢ CHEHRES -7 KX OEHE B,
ELUT.Y D T3 Vth gmMax and Id [(1) ; 10/2/2008 4:20:46 PM X
X-¥ Graph Plot Preference ~ |Parameters |
MARKER( 659.300 mV 1.00000 uA 24.7914 uS ) Vth  [Bozesa my
900 gmMax 793,150 us
g S0 Intercept: ‘Tntercept: Vtheld [555:300 mv
S 600u -676.306 UA -784.124 uS/
S s Gradient: radient: /
& Y 7.931500€-004 3
500 u
450u
400u
3Blu
300 u
250u
= 00u
§ 150
2 u
100u
S0y
660 =
500 m 200m 0 200m 600 m 1 1.2 14 16 18 2
Vaate (V) 200 m fdiv = 5
List Display Preference -
Index_| vgate | Vsource | Vdrain | Vsubs | Idrain | gm| Isubs -
2 550.0 mv ov 100.00 mv ov 7870590 2.180922000 uUS 2336 pA
23 600.0 MV ov 100.00 mv ov 243231 nA_ 6.599811000 US -2.439 DA
i i it AREE W T DA U i

To leave the graph modification information such as scaling, marker, cursor, and line on the
graph, select the File > Update menu.

Y ou can see the al information when you open the graph again. Note that the modification
information will be destroyed if you did not do it.

To save the graph image as afile, select the File > Save Image... menu.
Y ou can save the image as a bmp, emf, gif, or png file.
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Class Exercise

Use the analysis tools.

1.

Use your test setup (for example, GMMAX in the
Demo preset group) and perform measurement .

Enable marker and draw line. Try it for all line
types.

Copy/paste/save data list, and open it by using a
spreadsheet software (optional, if you can).

Save analysis condition. Re-open the test record.

Export your test record. And import it.

Note:
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To Use Preview Window

| Proview Settings B

- [General
© Vth gmMax and Id [(1) ; 10/2/2008 4:20:46 PM] - Keysight Easyuml E
Groph Tite: [5VG Crarscearstics = —

File Edit Zoom Asis Merker Cursor Line Text Poil

BB v reen 23 2 | [ine syl m d
s L o Uner: [—————= 3] unez [ =1 E"3
SR parameters P X
X-Y Grap Legend =T | vi: | I3 [ B P | E
Line Information - v [—=== 7] v [—— ]
. - = v 5 ve | e
Preview = vr | o v | =
. g :‘;::nd F2 ) oK Cancel pply Reset
5 =~
S 600u 9 \ 3 /
b= -
g 550u Color and Thickness ot
500 u | Color and Style | Graph Trace Color | Format | Text Size | Options |
4
0 m——
4 Background: |
350u et
300u Grid : J ﬁi'
. 250u vine/cursor: [ 3
E— 200u VARZ Label : - ”m
E 150u
100u /
S0u {/
660 f
-500m  -200m 0 200m 600m
Vaate (V) Use Preset Graph Colors : [Cusomzed -
b oK Cancel

The Data Display window provides the File > Print... function to print the graph image.
However, you may want to set the graph title and change the line style. Then use the Preview
window. The Preview window is used to see and print the graph image you modified.

Select the View > Preview to open the Preview window and the Preview Settings dialog box.
And use the Preview Settings dialog box to set the title of graph, X axis, and Y axis, and change
the line style. To change the color and thickness, use the Color and Thickness dialog box opened
by clicking the Color and Thickness... button.

Clicking OK button in the Preview Settings dialog box applies the modification to the Preview
window and closes the dialog box.

Note:
The graph image in the Preview window cannot be saved.
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To Use Preview Window

© Vth gmMax and 1d [(1); 10/2/2008 4:20:46 PM] (Preview) - Keysight EasyEXPERT
File Edit View Help -

LY T B Vth gmMax and Id [(1) ; 10/2/2008 4:20:46 PM!

X-¥ Graph Plot

A KEYSIGHT
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690 u

600u r e
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500 u

450u

400u

350u

300u
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200u

150u
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50u =
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=k

Drain Current (&)

S00m -200m 0 200m 600 m 1 12 14

ID-VG Characteristics

650 u e e 7/.— -
\\ ///

Gate Voltage (V) 200 m /div

2

This example isresult of the changes shown in the previous page.
Line style was changed as shown above. Thettitles are set asfollows.
Graph title: ID-VG Characteristics
X axistitle: Gate Voltage

Y1 axistitle: Drain Current

Y 2 axistitle: Transconductance

Y 3 axistitle; Drain Current

Also color of linel was changed to red, and thickness of trace was changed.
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Class Exercise

Use the Preview window.
1. Use your test record used in the previous exercise.

2. Change the graph image as you want.
- Add graph title and change axis title.
- Change line style
- Change color and thickness

3. Print the graph image if a printer is available.

Note:
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Module 3
Classic Test Environment

In This Module

* Classic Test Execution Mode

* I/V Sweep Measurement

*  Multi Channel I/V Sweep Measurement
* I/V List Sweep Measurement

+ I/V-t Sampling Measurement

+  C-V Sweep Measurement

*  Switching Matrix Control

*  Direct Control

Note:
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Classic Test Execution Mode

Fils Data Display Hebp
g g
= - swee
| P
g .
-[ womll + Multi Channel I/V Sweep
4 =
‘;g L4 M« I/V List Sweep
= 3~ -
| W * I/V-t Sampling
g Lv-t Sampling
= & « C-V Sweep
C-V Sweep 0
« SPGU Control cet
« —
ntrol| . - -
e + Switching Matrix Control ;| ol
r"' 3 Tmg id-vd
saansva | o Direct Control & [
E . 4 Trng Sampling i
i
Name |Date |Cnunt Device ID JRemarIs |ﬂ
“I/V Trace ©2009/09/18 16:59:38 1 1d-vd ]
Vth gmMax and Id 2008/10/02 16:20:46 1
Charge Pumping 4T 0.1V step  2008/02/05 11:24:50 1 —
ALWG monitor 2008/02/01 20:36:02 1
ALWG monitor 2008/02/01 20:36:02 1
PG monitor 2008/02/01 20:35:43 1
ritial Workspace: || Thermometer OFF || Multi Display OFF 03] Standoy OFF  [30] sMU Zero OFF  [[1,] Auto Export OFF [3€] Auto Record OFF

To use the classic test mode, click the Classic Test tab. And select the execution mode. The
following modes are available.

*I/V Sweep: For X-Y characteristics measurement of [ or V.

*Multi Channel I/V Sweep: For simultaneous multi channel (up to 10) sweep measurement of |
or V.

*I/V List Sweep: For multi channel (up to 10) I/V sweep measurement using list data.
*I/V-t Sampling: For time-Y characteristics measurement of I or V.

*C-V Sweep: For DC bias-impedance characteristics measurement.

*SPGU Control: For voltage pulse output. Not available for BIS05A.

*Switching Matrix Control: For B2200/E5250 switching matrix control. Not available for
BI505A.

*Direct Control: For various measurements (e.g. C-f measurement, Quasi-Static C-V
measurement) using Keysight FLEX commands.
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1’V Sweep Measurement i
mEE|
ERERE

I/V Sweep

* To Define Source/Measurement Channels
* To Read Time Stamp Data and Data Index
* To Set Source Outputs (VAR1, VAR2, VARY’, Pulse, CONST)

* To Set Timing Parameters [ Gram et

« To Set Sweep Abort Function | = ;,( e —, et

« Range, ADC, Advanced, SPGU| “ | e

+ To Set User Functions " / S

*+ To Set Analysis Functions = i

+ To Set Auto Analysis Function [___ o e 2

* To Set Display Parameters (X-Y Graph, Data List, Parameter)

This section explains how to perform I/V sweep measurement. You will perform the above tasks
to execute the I/V sweep measurement.
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To Define Source/Measurement Channels
/V Sweep
Channel Setup Setup Name
' : ep Setup Name: |Trng Id-vd
- Channel Setup Mﬁumtmwlmtmatm|mmmﬁmw—1
tion
addswu | addsecu| ekt | |
Unit: ¥ Name: I Name: Mode: Function:

MR =fvd ‘mfid ‘m[vPULSE ]fver1 -

o [sMuzHR =lva =i =V xjver2 =

[l ETI =ljvs mis =V xljconsT =l SMU4

o BumE e o = T SMU3

o [—o
SMU Channel Definition SMU1
-V name/I name
-I/'V/IPULSE/YPULSE/COMMON SMU2
-VAR1/VAR2/VARI’/CONST
SPGU Channel Definition
-V name
-VPULSE/ALWG
tiscell Variables
Time Stamp Name: iﬁ Index Name: m

Click the I/V Sweep icon and open the setup editor. Then click the Channel Setup tab to display
the channel definition screen.

1. Enter the Setup Name for the test setup to be defined on the setup editor.

2. List SMUs used for source output or measurement, and set the following parameters.
*Unit: SMU name or number. The GNDU (ground unit) can be set instead of a SMU.
*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current
pulse), or COMMON (ground)

*Function: Source output function, VAR1 (primary sweep), VAR2 (secondary sweep), VARI’
(synchronous sweep), CONST (constant)

V Name and I Name are used to specify the parameters displayed on the Data Display window.
The display parameters are selected on the Display Setup tab screen. For the GNDU, 0 V is
returned to the V variable and no data is returned to the I variable.

To use the SPGU channels, click the Add SPGU button. The SPGU channel setup row will
appear. Then set the following parameters.

*Unit: SPGU name or number
*V Name: Variable name for the voltage data. No data is returned to the variable.

*Mode: SPGU output mode. VPULSE (voltage pulse) or ALWG (arbitrary linear waveform
voltage) for all SPGU.
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Classic Test Environment

To Read Time Stamp Data and Index it

IV Sweep

Channel Setup

: ep Setup Name: [Trng Id-vd
- Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |

Addwl AddSPGJI [»:—'::,:| Up | Do ul

Unit: V Name: 1 Name: Mode: Function:
o [oarR ~]fvd wlfid weUsE  s]ver1 |
[z =lfva =g =V =]fvara =
c |SMJ2!HF‘ ;||v; ‘dl]s §|v _:HCDNST _vJ
c [Munee v mlflsub =V =lfvarr =

Variable name for time stamp data

Variable name for data index

fiscell Variables ¥

k]
e [ 8 e )3

You can read measurement data by using the Data Display window. Parameters displayed on the
window are selected on the Display Setup tab screen. If you enter the variable name in the V
Name, I Name, Time Stamp Name, and/or Index Name entry fields, you can choose the variables
as the display parameters.

Note:
The time stamp is the time the measurement is started for each measurement point.

The index is the index number for each measurement data.
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Classic Test Environment

To Set Primary Sweep Source

Measurement Setup

@] 1 Swi Setup Name: [Tmg 1dvd
Measurement Setup [Function Setup | Auto Analysis Setup | Display Setup |
v

N————— lvm VARL' I

( unit: [EMU3 AR ﬂsma:m H Unit: [EMUTHP ]|
Name: [Vd =lfva = Name: [Vsub C
Direction: m Offset: lm
Linear/Lag: Wzl Ratio: L)
Start: 0 v wfrv E]| compliance: [l00ma 8]
Stop: |3 v ]| =8% ﬂ Pwr Comp: lm
Step: [60mV #]f500 mv H] [sMUPuise
No of Step: [51 5'3 i Unit: HR ]
compliance: [10 mA g'lmA 8] Period: |10 ms ]
\Pwr comp: [OFF (5 Il width: [Tms  §]
Timing | Base: lm
Hold: [0's 8] Delay: o5 Bl xgweep [cONTINUE AT &Ny =] status
[Eonstants ]
Unit: V Name: I Name: Mode: Source: Compliance:
e s A A T

VARI1

[
Start

IV Sweep

Stop

The Measurement Setup tab screen is used to set the source output value and timing parameters.

At the VAR area, you set the primary sweep source output.

*Unit: SMU name or number

*Name: Variable name of source output

*Direction: Single (start to stop) or Double (start to stop to start)

*Linear/Log: Linear sweep or Log sweep
«Start: Source output start value

*Stop: Source output stop value

Step: Source output incremental step value

*No of Step: Number of sweep steps

*Compliance: SMU compliance value

*Pwr Comp: SMU power compliance value
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Classic Test Environment

To Set Secondary Sweep Source £

IV Sweep

Measurement Setup

Setup Name: [Tma 1d-vd

@] 1 Swi
Measurement Setup [Function Setup | Auto Analysis Setup | Display Setup |
WV, N— ivm VARL' I

Unit: [SMU4HR ﬂtms:m ] Unit: [SMULHP ]| VARI1
Name: [Vd ] = Name: [Vsub
Direction: W Offset: lm
Linear/Lag: W Ratio: L)
Start: 0 v B|frv E||l compliance: [l00ma 8]
Stop: |3 v B2V ﬂ Pwr Comp: m
Step: [0 mv ) [500 mv H] [pMUPuse
No of Step: [51 il ] Unit: HR ] VAR2
Compliance: [10 ma Bjima i Period: |10 ms ]
Pwr comp: [OFF \JorF ) width: [Tms  §]
Timing | Base: m _‘_,—__L
Hold: [0's | elay: [ Bl wsweep [coNTIWE AT aNY =] status
[Eonstants ]
Unit: V Name: I Name: Mode: Source: Compliance:
e s A A T

At the VAR?2 area, you set the secondary sweep source output.
*Unit: SMU name or number

*Name: Variable name of source output

+Start: Source output start value

*Stop: Source output stop value

*Step: Source output incremental step value

*No of Step: Number of sweep steps

*Compliance: SMU compliance value

*Pwr Comp: SMU power compliance value
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Classic Test Environment

To Set Synchronous Sweep Source

Measurement Setup

Setup Name: [Tma 1d-vd

?”I ii Swrepﬁ

Measurement Setup [Function Setup | Auto Analysis Setup | Display Setup |

[vAr2 VARL' |
Unit: [BMUFR o 0|4 wit: TR =
Name: IVd _leQ 5 Name: [Vsub ADC /
Direction: m Offset: lm ks
Linear/Log: Wzl Ratio: m
start: 0V | '1 v 8| compliance: [1oma  &]
Stop: B v E]FV 8] ’&pwr comp: [OFF 8
Step: [60 mv g'snn v ] [SMU Pulse
No of Step: [51 0|3 i Unit: HR ]
compliance: [10 ma B][1ma 8] Period; |10 ms ]
Pwr comp: [OFF ] forr 0 width: [Tms &)
Timing | Base: m
Hold: 05 | elay: [ 5| *Sweep [CONTINUE AT &NY =] status
[Constants ]
Unit: V Name: I Name: Mode: Source: Compliance:
[smozzre Els e = Elpov Elfoma W]

VARI1

L

VARI’

el

-

IV Sweep

At the VARI’ area, you set the synchronous sweep source output.
*Unit: SMU name or number

*Name: Variable name of source output

*Offset: B value of the above formula.

*Ratio: A value of the above formula.

*Compliance: SMU compliance value

*Pwr Comp: SMU power compliance value

The VAR’ output is expressed by the following formula.
VAR’ output = A >< (VARI output) + B
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Classic Test Environment

To Set Pulse Output

Measurement Setup

@] 1 Swi Setup Name: [Tmg 16-vd
Measurement Setup [Function Setup | Auto Analysis Setup | Display Setup |
WV, N— ivm

VARL' |
Unit: [SMU4HR ﬂ'swa:m ] Unit: [SMULHP ]|
Name: [vd = vg = Name: [vsub ADC /
Direction: m Offset: m e
Linear/Log: [TEAR 3] Ratio: g e
Start: [0V i['l v #| compliance: [lloma 8]
Stop: |3 v _HJFV ﬂ Pwr Comp: m
Step: [60 mv g'sm mv & [sMUPulse
No of Step: [51 0|8 ol Unit: [SMU4HR 0]
Compliance: [10 ma B]fima i Period: |10 ms ]
Pwr comp: [OFF ] forF Il width: [Tms  §]
Timing | \_ Base: m
Hold: [0's | elay: [ Bl wsweep [coNTIWE AT aNY =] status
[Eonstants ]
Unit: ¥ Name: I Name: Mode: Source: Compliance:
[ =k R T =T

-

IV Sweep

Trigger

Width Width

«—r >

_/—\_/—\_ Base

>

Period

Hold time

Delay time cannot be set.

At the SMU Pulse area, you set the SMU pulse timing parameter and the pulse base value.

*Unit: SMU name or number
*Period: Pulse period
*Width: Pulse width

*Base: Pulse base value

Only a SMU can be set to the pulse source.
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Classic Test Environment

Measurement Setup

To Set Constant Output

@] 1 Swi Setup Name: [Tmg 1d-vd
I* Measurement Setup [Function Setup | Auto Analysis Setup | Display Setup |
v S |VAR2 VARL' |
Unit: [SMU4HR ﬂ'swa:m ] Unit: [SMULHP ]|
Name: [Vd = fva = Name: [Vsub
Direction: m Offset: lm
Linear/Lag: Wzl Ratio: L)
Start: [0V i['l v #| compliance: [lloma 8]
Stop: |3 v E]FV ﬂ Pwr Comp: m
Step: [60 mv g'snn mv & [sMUPulse
No of Step: [51 0|3 i Unit: HR ]
Compliance: [10 ma B]fima i Period: |10 ms ]
Pwr comp: [OFF ] forF Il width: [Tms  §]
Timing | Base: m
Hold: [0's | elay: [ Bl wsweep [coNTIWE AT aNY =] status
[Constants |
Init: ¥ Name: I Name: Mode: Source: Compliance:
| =k | T T 1= |
\

-

IV Sweep

At the Constants area, you set the SMU constant output.

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current

pulse), or COMMON (ground)
*Source: SMU output value

*Compliance: SMU compliance value
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Classic Test Environment

To Set Timing Parameters

Measurement Setup

@] 1 Swi Setup Name: [Tmg 1dvd
Measurement Setup [Function Setup | Auto Analysis Setup | Display Setup |
Vi

N———— lvm VARL'

Uniit: 1:HP 8

Unit: [sMU4HR ﬂ!srm:m
Name: [Vd ﬂlVQ

18] =]

Direction: m
Linear/Log: [[INEAR =
start: [Iv 0| 153 H
Stop: |3 v E] R ﬂ
step: [f0 mv 8] 500 mv O] Trigger
No of Step: [51 |8 i
Compliance: [10ma 0| e Ol Measurement time
Pwr Comp: [OFF 8] forF I
Timing 3 s -~
Hoid: 7= 5 oclay: - B | -cwecn fome sty olstatus |

e — s E[3 Hpv Efoma ] Delay time

J —
Unit: V Name: I Name: Mode: Source: Compliance: \

Hold time

At the Timing area, you set the source output and measurement timing.
*Hold: Source output hold time. Time after the measurement trigger until starting delay time.

*Delay: Measurement start delay time. Time after the hold time until starting measurement.

When a SMU forces pulse, the delay time is ignored. Source output and measurement timing
will be controlled by the pulse width and pulse period.
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Classic Test Environment

To Set Sweep Abort Function

Measurement Setup

@] 1 Swi Setup Name: [Tmg 1d-vd
Measurement Setup [Function Setup | Auto Analysis Setup | Display Setup |
Vi

S |VAR2 VARL'
Unit: [sMU4HR ﬂ'swa:m 8] unit: [SMULHP ] &
Name: [Vd = fva = Name: [Vsub
Direction: m Offset: lm
Linear/Log: [INEAR =] Ratio: 8
Start: 0 v El'l v #| compliance: [lloma 8]
Stop: |3 v E]FV ﬂ Pwr Comp: m
Step: [60mv 8] 500 mv ) | CONTINUE AT ANY
No of step: [51 Elp 5 Unit: [SMU4HR B STOP AT ANY ABNORMAL
Compliance: [10mé B]fima Il period: [10ms ] -Range overflow
Pwr comp: [OFF ] forF Il width: [Tms  §] -SMU compliance
Timing ] Base: oV §) -SMU oscillation
boit: s ] oelay: PR T8 | = cvmep [iovTiE T Slstaus |
[constants I
Unit: ¥ Name: I Name: Mode: Source: Compliance:
e al = = Epv dlm

This field sets the sweep abort function.

When this field is CONTINUE AT ANY, the sweep measurement is not aborted.
When this field is STOP AT ANY ABNORMAL, the sweep measurement will be aborted when

one of the following conditions is detected.
*Measurement range overflow

*SMU compliance

*SMU oscillation
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Classic Test Environment

To Set Ranging Mode

Measurement Setup

»| - Not available when a SMU pulse is used.

ADC /

Iy |
Measurement r
Ad- Range |
Y Up Down
g:gg Unit: Name: Mode: Range: Range Change Rule: Rate:

Setup c [gmonre |5 mummeD  ~ffina ~fey FULL RaNGE e E]
o [emuziERias Ef2 mummeD  ~ffina ~]eY FULL RANGE =] ]
c [MusHRfas |3 =[LMTED ~|fina  =]feY FULL RANGE xran |
© [BMU4HR |f14 =|UMITED ~|[ina  ~]fBY FULL RANGE [ |

The Range button opens the SMU Range Setup dialog box. The dialog box is used to set the
measurement ranging mode. This button is not available when a pulse source is used.

*Unit: SMU name or number

*Name: Variable name for the measurement data

*Mode: Ranging mode, AUTO, LIMITED, or FIXED

*Range: Range value

*Range Change Rule: BY FULL RANGE, GO UP AHEAD, or UP AND DOWN AHEAD
*Rate: Value used for range changing. See the following formula.

For the AUTO or LIMITED, SMU automatically selects the minimum range that covers the
measurement value, and performs the measurement by using the range. For the limited auto
ranging, the instrument does not use the range lower than the specified range value. For
example, if you select the 100 nA limited auto ranging, the instrument never uses the 10 nA
range and below.

BY FULL RANGE performs normal auto ranging operation.

For the GO UP AHEAD and UP AND DOWN AHEAD rules, specify the Rate value, 11 to 100,
which fixes the boundary of the ranging. The ranging occurs when the measurement data goes
across the boundary values shown below.

go up boundary = present measurement range > Rate/ 100
go down boundary = present measurement range >< Rate/ 1000
The go down boundary is available only for the UP AND DOWN AHEAD rule.
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Classic Test Environment

To Set ADC/Integration Time

Measurement Setup

Range

- ADC / A/D Converter
l Integ
Ad-

Unit: Name: ADC: Measurement:
vanced [mure Hjfin = |Hr 20d] =] [complance Side |
SPGU [sMU2:HR = = [HR ADC ~||compliance Side =l
g:; [emuz:HR )& 5 [HR ADC | [compliance side |

fsru4:R 4 ] HR ADC | [compiance side =

|Integration Time
Mode: Factor: Auto Zero:
High Resolution ADC: [suTo  ~|f6 1553 ~|
High Speed ADC: [8UTO =t ]
Close I

The ADC/Integ button opens the A/D Converter & Integration Time Setup dialog box. The
dialog box is used to select the ADC for each SMU and set the integration time for each ADC
(high resolution or high speed).

A/D Converter:

*Unit: SMU name or number

*Name: Variable name of the measurement data

*ADC: ADC type, HR ADC (high resolution) or HS ADC (high speed)

*Measurement: Compliance side measurement or Force and Compliance sides measurement.
HR ADC is not available for HCSMU, HVSMU, and the measurement which uses SMU pulse.
Force and Compliance sides measurement is not available for HRSMU, MPSMU, and HPSMU.
Integration Time:

*Mode: ADC operation mode

AUTO, MANUAL, or PLC for HR ADC

AUTO, MANUAL, PLC, or TIME for HS ADC
TIME or PLC for the measurements using SMU pulse.

*Factor: Coefficient for the reference value of the integration time.
*Auto Zero: Auto Zero function ON or OFF. For HR ADC.
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Advanced Setup
Measurement Setup

Unit: VName: IName: Series R: SMU Filter:

Range T TS TS [ G

pmiziejas E|va [z EEE =lfon
ADC /
Integ
(]
vanced
SPGU
Pulse

T R R L G
] = =T —

el 1 1a 1ol

Setup [Wait Time Control
Factor:
Output Wait: |1 ]
Measurement Wait: |1 ]
After Measurement Settings

Bias Hold after Measurement: | OFF >

Output Value after Measurement: | START -

Semiconductor Relays ( 16440A SMU/PG Selector)

CH1: |DEFAULT = CH3: |PGUOPEN ¥

The Advanced button opens the Advanced Setup dialog box. The dialog box is used to set the SMU filter
and SMU series resistor settings, the wait time, the after measurement settings, and the 16440A selector
semiconductor relay setting.

Channel Settings:

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Series R: SMU series resistor NONE or IMOHM (1000000 ohm)

*SMU Filter: SMU filter ON or OFF

Wait Time Control:

*Factor: Coefficient for the reference value of the wait time. For details, see online help or User’s Guide.
After Measurement Settings:

*Bias Hold after Measurement: Bias hold function ON or OFF.

*Output Value after Measurement: Source output value after measurement. START (sweep start value),
STOP (sweep stop value), SOURCE (sampling output source value), or BASE (sampling output base value)

Note: Pulse channel output after measurement is always Base value.
Semiconductor Relays (16440A SMU/PG Selector):

*CHI1: Default or PGU OPEN

*CH3: Default or PGU OPEN

The fields define the selector channel’s switch condition during the measurement. Default is the setting
defined on the SMU/PG Selector screen of the Configuration window.
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SPGU Pulse Setup

Measurement Setup

mnlnlmmgs Operation o e
Range Period: [Tus | | @ FREERUN € PULSE COUNT e Swich
© DURATION [f=— 4§
ADC / [Pulsa Settings
Integ SPGU setup view order:
Ad- Unit: [Primary Puise _ [paditional Pulse ]
e [ePauTRV H|  Base: pv | H
B l] p— o
SPGU =Ty B ps ]
- Pulse 1o width: [100ns ]
Setup 5 Leading: [201s []
ZETLTC Tranlm: feons & ]
Unit: |Prin|ry Pulse Jnddmon:n Pulse J
This button is F::Z"" S H%
- (s pelay: 05 ®lp:  H|
available when W‘ B - mﬁ
e Leadiny n Er|
a SPGU channel | mmem—a o= !m;—_”ﬁ
is defined in
Channel Setup.

If a SPGU channel is defined and set to the VPULSE mode on the Channel Setup screen, the
SPGU Pulse Setup button is effective. This button opens the SPGU Pulse Setup window which
is used to define the voltage pulse output by the specified SPGU channels. Maximum 10 SPGU

channels can be used. Not available for BI5S05A.
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Range

ADC /
Integ

Ad‘
vanced

SPGU
ALWG
Setup

This button is
available when
a SPGU channel
is defined in
Channel Setup.

SPGU ALWG Setup

Measurement Setup

Operation

& FREE RUN " SEQUENCE COUNT Il BI
" DURATION Il us BI
ALWG Setting ]
ALWG Source: IE ]
Close

/

This button opens the Define ALWG
Waveform window used to define the
arbitrary linear waveform.

If a SPGU channel is defined and set to the ALWG mode on the Channel Setup screen, the
SPGU ALWG Setup button is effective. This button opens the SPGU ALWG Setup window
which is used to define the arbitrary linear waveform voltage output by the specified SPGU

channels. Maximum 10 SPGU channels can be used. Not available for B1505A.
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To Set User Functions =
IV Sweep
Function Setup ©|1/vSweep Satup Name: [Tg 1
Cha'nelSetquMeasumtSeh.uAutDAndyﬂsSeb.pleplaysetw|
|user Function
( Add | ‘,«‘_ez»,l Up
Name: Unit: Definition:
e [eso mfa =|[zbs(id) 0]
Data calculation
-Measurement data/source data
-Built-in function, etc.
Analysis Function
Add Delete Up I Down |
Name: Unit: Definition:
c [gope  mifa ~lleLic1 o]

Click the Function Setup tab to display the User Function/Analysis Function setup screen. The
user functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the
Data Display window. Up to 20 functions can be set.

Name: Function name
Unit: Unit of the function

Definition: Definition of the function. The following identifiers can be used.
-Variables for the measurement/output data used in this test

-Functions defined in the above lines

-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables

For details, see online help or User’s Guide.

Note:

The Apply button performs calculation of the definition in this screen. If this button is clicked
when the Data Display window associated with this test has been opened, the display is also
updated. The associated Data Display window will be the Data Display window that displays the
last measurement data or that is recalled at last.
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To Set Analysis Functions =
V Sweep
Function Setup ©|1/vSweep Satup Name: [Tg 1
Channel Setup | Measurement Setup AutoAndwsSev.p|DsplaySEtLp|
|user Function
Ay| [oeeEl WUEN| s
Name: Unit: Definition:
e [eso mfa =|[zbs(id) 0]
[Analysis Function
( Add Delete Up I Ltw?h
Name: Unit: Definition:
c [gope  mifa ~lleLic1 o]
Data calculation
-Measurement data/source data
-Read out function
\ -Built-in function, ete. /

The analysis functions can be displayed on the Parameters area of the Data Display window. Up
to 20 functions can be set.

Name: Function name
Unit: Unit of the function

Definition: Definition of the function. The following identifiers can be used.
-Variables for the measurement/output data used in this test

-Functions defined in the above lines

-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables

-Read out functions

For details, see online help or User’s Guide.

Note:

The Apply button performs calculation of the definition in this screen. If this button is clicked
when the Data Display window associated with this test has been opened, the display is also
updated. The associated Data Display window will be the Data Display window that displays the
last measurement data or that is recalled at last.
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-
. .
To Set Auto Analysis Function A
IV Sweep
] r
Auto AnalySlS @|1/v Sweep Setup Nan'!mg 1dvd i
Channel Setup | Meastrement Setup | Function Setup At Andysis Setun | Display Setup | Apply
Interpolation [ merpolation Mode
Line 1 —_————
m— -
ﬂV Enable Type Axis \
I Fix € Normal € Gradient & Tangent  Regression V1 z
First Point
Li 1 ¢ € X-Y Coordinate @ Data Condition
ine 1 setup Condition: [vd o =1 = [ After | = E|
‘Second Point
@ X-Y Coordinate € Data Condition
% | ERRN =)
Line 2
I~ Enab Type Axis
[l— Fix 2 @ Normal € Gradient & Tangent & Regression Y1 '\
First Point
@ X-Y Coordinate € Data Condition
Line 2 setup 4| g5 v =
‘Second Point
@ X-Y Coordinate 1 Data Condition
\ X = v =] j
|Marker
[ Enable
Marker setup | oo ia = - [0 =t C|

Click the Auto Analysis Setup tab to display the auto analysis setup screen. The auto analysis capability
allows you to display/move the marker/line on the data graph automatically after measurement. The above
example displays marker at Vd=1 V point and draw a tangent line for this point.

Interpolation Mode: Check this box to enable the interpolation mode. You can position marker between
measurement points.

Line 1, Line 2: This area sets the line 1 or line 2 automatically displayed and moved to the specified
position after the measurement. Check Enable box to enable the line.

For Type, select a line type, Normal, Gradient, Tangent, or Regression.
For Axis, select the axis effective for the line.

In First Point and Second Point, specify the cursor points used to draw line.
In Gradient, specify the slope of the Gradient line.

Marker: This area sets the marker automatically displayed and moved to the specified position after the
measurement. Check Enable box to enable the marker.

For Condition, enter a variable name and a condition expression to specify where you want the marker to
display.

For After, check this box to enable the additional condition. And enter a second variable and condition
expression. This sets up a search start condition for finding specified point.

For example, you can specify the following expressions to search for a measurement point that satisfies the
first condition after the second condition is satisfied.

Condition: [DGM] = [MAX(DGM)*0.01] [x] After [DGM] = [MAX(DGM)]

Note:

The Apply button performs calculation of the definition in this screen. If this button is clicked when the
Data Display window associated with this test has been opened, the display is also updated. The associated
Data Display window will be the Data Display window that displays the last measurement data or that is
recalled at last.
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To Set X-Y Graph Display -

IV Sweep
Display Setup @ 1/v Sweep Setup Name: [Tmg Id:
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup| Display Setup
[X-¥ Graph
/ Add | D[—UE' Up | Down | \
Name: Sharing:  Scale: Min: Max:

F X [\ld j |(|‘-JG:T?J j |L|near ;] |EIV ﬂ |3V ﬂ

c vy [d =] [More) =] [rexr =] oA 8| [10ma 0]

€ vy2: [s85 1D =] [vore) =] Jinear x| [oa 8] [roma

Specify X axis and Y axis

List Display Parameters
Add I Delete | Up I Dawn | Add | [il-f.-:-'[-l Ug | Dawn |
¢ |index - 2 «  |slope -
C Vg -
c|vd hd
C d ¥ :J

Click the Display Setup tab to display the display setup screen. The X-Y Graph area is used to
set the X axis and Y axis of the X-Y Graph Plot area in the Data Display window.

*Name: Name of variable to plot on the X axis
*Scale: Linear or Log
*Min: Minimum value of the specified axis

*Max: Maximum value of the specified axis
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Display Setup

To Set Data List Display

-

IV Sweep
@|1/v sweep Setup Name: [Tmg Id:
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup| Display Setup
X-¥ Graph
Add | Dz%c-fﬁ;l Up | Bown |
Name: Sharing:  Scale: Min: Max:
F X [\ld j |(NUnE'J _j [Linear ;] |UV _ﬂ |3V ﬂ
c vy [d =] [More) =] [rexr =] oA 8| [10ma 0]
€ vy2: [s85 1D =] [vore) =] Jinear x| [oa 8] [roma 0|
Select variables to list
List Display /l Parameters
( Add I Delete Up I Down |\ Add | EJ—'EI Up | m |
€ |Index - 2 C  [Slope -
C Vg -
c v -
c [d =
. s/

The List Display area selects the variables to be listed in the List Display area of the Data
Display window. Up to 20 variables can be set.
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4
To Set Parameters Display L,-gﬁ
/V Sweep
Display Setup @|1/v sweep Setup Name: [Tmg Id:
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup| Display Setup
[X-¥ Graph
Add | DEIEPEI Up | Down |
Name: Sharing:  Scale: Min: Max:
F X [\ld j |(NUnE'J _j [Linear ;] |UV _ﬂ |3V ﬂ
c vy [d =] [More) =] [rexr =] oA 8| [10ma 0]
€ vy2: [s85 1D =] [vore) =] Jinear x| [oa 8] [roma 0|
Select parameters to display
List Display |[Parameters ‘\
Add I L’[—lz—tc—| Up I D]".“.’ﬂl Add | Elc—f;—'er Ug | Down
¢ |index - 2 «  |slope -
C Vg -
c [ -
c [d =
: -l

The Parameters area selects the variables to be listed in the Parameters area of the Data Display
window. Up to 20 parameters can be set.
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To Save Test Setup

w N My Favorite Setup button
Vith grmiMax
| = N Preset Group name.
T bane ) Use this field to
> g select preset group.
Ravall &= =
G’) —
Trng
g Samnlinn _l

The test setups you create MUST be saved to the internal hard disk drive as “My Favorite
Setup”.

To save the setup, click the Save button.
To recall the setup, click the Recall button.

You can organize the setups by using Preset Group. In the above example, the Demo group is
selected and listed in the “My Favorite Setup”.

To create a new preset group, click the My Favorite Setup button to display the function menu,
and select Add New Preset Group.

To select the available preset group, use the field below the My Favorite Setup button.
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To Export/Import Your Preset Group

My Favorite Setup button

Preset Group Export

Rename This Preset Group Preset Group Export K
e Duplicate This Preset Group Sevein: [Doma oo -] ~ @By
d Delete This Preset Group L-b oemo
Delete Al Import Preset Group e
Desictop.
LY,
My Documents.
<
Down I
Wy Netwok  Fi came:
] Swvenstpe

You can export/import your preset group.

To export the present preset group, click the My Favorite Setup button, select Export, and
specify the folder and the name of the preset group to export.

To import the preset group, click the My Favorite Setup button, select Import, and specify the
preset group to import.
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Class Exercise

Define test setup and perform test.

I

Click I/V Sweep icon and open setup editor.
. Define test setup as shown in the previous pages.

2
3
4
5

Save it as Trng Id-Vd.

. Connect device, and perform test.

. Export preset group, and import it.

-----
llllll

SMU4

SMU3
o [—o
SMUI

SMU2

Note:
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Measurement Result Example

-

IV Sweep
€ Trog 1d-Vd - Keysight EasyEXPERT BEX)
File Edit View Marker Cursor Line Window Help |
| == X ] o | — noye Emmme -
AEEE QAR d- EEHRMeE-F-2i7 [
Trng1d-Vd | Tmg 16:V [7): 471172006 5:2635... | Tmg I6-VA [8): 411172006 5:26:1... | Trmg Id-Va [15): 411172006 524:1.. |
| Setup Name: Ing Id-vd = o
X-Y Graph Plot I[P |
(®) et ik s ) 5 Slope  p7777sus
10m om
Intercept: Intercepts
378333 A 378333 A
Gradent: Gradent:
2.777783E-006 2.77TT83ED06 o
= 3
1.00m
tdv
0 Iosecrect: 136200y
] vd (V) 200 m /div 3
List Display Properties...
Index | Index [ vg| v | 1d | Time | )
4/15 15 1V 840 mv 40.5 uA 142.54 ms
4/16 16 1V 900 mv 39.5 A 152.54 ms @
417 17 v 960 mv 40.5 uA 162.54 ms )

This is a test result example displayed on the Data Display window.
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Multi Channel I/V Sweep -

To Define Channel Setup Screen

To Set VARI Sweep S Mult
e (L] 4 wee ources .
g Channel I/V
* To Set C tant Qutput
(L] 4 onstan utpu S‘"deep

Other Measurement Setup Parameters
* To Set User Functions

* To Set Data Display

This section explains how to perform the Multi Channel I/V sweep measurement. You will
perform the above tasks to execute the Multi Channel I/V sweep measurement.
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L

Multi Channel I/V Sweep a8

Multi
Channel 'V
Sweep

Voltage or current = Measurement

A
Start measurement L"

U -
Start value = Delay time
Hold ti
Voltage or current aeLHme
A\

Stop value - Delay time

Stop value

Primary sweep source

0 4 —\ Second sweep source

Start value

Voltage or current
A

Stop value

0 4 —\ Tenth sweep source

Start value

Time

Multi Channel I/V Sweep measurement is similar to I/'V Sweep measurement.
Changes from I/V Sweep are listed below.

*All SMU can be set to the VAR1 sweep source (up to 10 channels)

*All SMU can be set to the pulse output mode

*Both voltage mode and current mode are available for the VAR1 sweep output
*VAR1’ sweep output is not available

The output channels start to output in the order in which they are listed on the Channel Setup
screen.

If multiple pulse output channels are used, the DC output channels start to output in the order in
which they are listed on the Channel Setup screen, and then the pulse output channels start to
output simultaneously. And the all measurement channels perform measurements
simultaneously.
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L

To Define Channel Setup Screen -
Channel 'V

Channel Setup Setup Name
| annel I/V Sweep Setup Name: |[Tma Mt
- Channel Setup fMeasurement Setup | Function SetmlAutoAnmLﬂ—rmm—‘lm

podswu | addseeu| oot | | up |
V Name: TName: Mode: -

b =jh =y fvert

e ‘mle mv =l[vert

e =i =V =]fconsT

e =i I Sfonst

SMU Channel Definition
-V name/l name
-I/V/IPULSE/VPULSE/COMMON

-VAR1/VAR2/CONST
SPGU Channel Definition
Y name Variable name for reading time stamp data
-VPULSE/ALWG / Variable name for reading data index
Variables A /

— e R Sa——

Click the Multi Channel I/'V Sweep icon and open the setup editor. Then click the Channel Setup tab to
display the channel definition screen.

1. Enter the Setup Name for the test setup to be defined on the setup editor.

2. List SMUs used for source output or measurement, and set the following parameters.
*Unit: SMU name or number. The GNDU (ground unit) can be set instead of a SMU.
*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current pulse), or
COMMON (ground)

*Function: Source output function, VAR (primary sweep), VAR2 (secondary sweep), CONST (constant).
Up to 10 sources can be set to VARI.

V Name and I Name are used to specify the parameters displayed on the Data Display window. The display
parameters are selected on the Display Setup tab screen. For the GNDU, 0 V is returned to the V variable
and no data is returned to the I variable.

To use the SPGU channels, click the Add SPGU button. The SPGU channel setup row will appear. Then
set the following parameters.

*Unit: SPGU name or number
*V Name: Variable name for the voltage data. No data is returned to the variable.

*Mode: SPGU output mode. VPULSE (voltage pulse) or ALWG (arbitrary linear waveform voltage) for all
SPGU.

You can read measurement data by using the Data Display window. Parameters displayed on the window
are selected on the Display Setup tab screen. If you enter the variable name in the V Name, [ Name, Time
Stamp Name, and/or Index Name entry fields, you can choose the variables as the display parameters.

Note: The time stamp is the time the measurement is started for each measurement point. The index is the
index number for each measurement data.
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To Set VAR1 Sweep Sources

Measurement Setup

Setup Name: [Tmg Multi
Function Setup | Auto Analysis Setup | Display Setup |

Q| Crrannel.[.ﬂl&neep
Measurement Setup
Iwuuﬁ

—

Direction: [snge ~| Linear/Log: [LINEAR  ~| No of Step: [101 8| Rande
Unit: Name: Start: Stop: Compliance: Pwr Comp: ADC /
[eroTEe @] [vh v wesv @j[ooma &][orF | Integ
ErvzAR &|[ve =ov Blfesomv  @]Jicoma B]foFF Il
N

[¥iming |
Hold: [0 = 8] pelay: o< 8]  xgweep [CONTINUE AT ANY =] status
J
Unit: ¥ Name: I Name: Mode: Source: Compliance:
[eMUZHR |ve =[ib v Eov #][100 ma ]
[sMu4HR ifve e fic v Elov @][100 ma 0

=

Multi
Channel 'V
Sweep

SMU1
Stop
ﬂ Start

SMU2

|

Stop

Start

The Measurement Setup tab screen is used to set the source output value and timing parameters.

At the VARI area, you set VAR1 sweep sources.

Follows are common parameters for all VAR1 sweep sources.

*Direction: Single (start to stop) or Double (start to stop to start)

*Linear/Log: Linear sweep or Log sweep

*No of Step: Number of sweep steps

Following parameters can be set for each VAR1 sweep sources.

*Unit: SMU name or number

*Name: Variable name of source output

«Start: Source output start value

*Stop: Source output stop value

*Compliance: SMU compliance value

*Pwr Comp: SMU power compliance value
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To Set Constant Output

Measurement Setup

fol| ep Setup Name: [Trmg Mt
Measurement Satup | Function Setup | Auto Analysis Setup | Display Setup |

'VARL - -iii
Direction: [Sngle ~| Linear/Log: |LINEAR  ~| No of Step: [101 ICl|

Unit: Name: Start: Stop: Compliance: Pwr Comp:

[STGE ] | =Hpv Hpksv @|[ioma ][oFF |

[smuziir E][ve =ov Blfesomv  @]Jicoma B]foFF Il
[Timing |

Hold: [0 = 8] pelay: o< 8| s gweep [CONTINE AT ANY =] status
J

Unit: ¥ Name: I Name: Mode: Source: Compliance:

[eMUZHR |ve =[ib v Eov #][100 ma ]

[eMuaipr ifve e fic v Elov @][100 ma [C|
~

&

Multi
Channel 'V
Sweep

At the Constants area, you set the SMU constant output.

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), or COMMON (ground)

*Source: SMU output value

*Compliance: SMU compliance value
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Measurement Setup

Other Measurement Setup Parameters

fol| ep Setup Name: [Trmg Mt
Measurement Satup | Function Setup | Auto Analysis Setup | Display Setup |

-

Multi
Channel 'V
Sweep

'VARL — -
Direction: [Single ~| Linear/Log: [LINEAR  ~| No of Step: [101 | Rande
Unit: Name: Start: Stop: Compliance: Pwr Comp:
emue vk =ov Hlsv @|[ioma ][oFF ICI|
[smuziir E][ve =ov Blfesomv  @]Jicoma B]foFF Il
[=m
Hold: [0 = 8] pelay: o< ] [* Sweep [CONTINUE AT ANY v]statm]
Eorstants ]
Unit: V Name: I Name: Mode: Source: Compliance:
[eMUZHR |ve =[ib v Eov #][100 ma ]
[eMuair ifve e fic v Elov @][100 ma [C|

Range

For the functions of Timing, Sweep status, Range, ADC/Integ, Advanced, SPGU Pulse Setup,
and SPGU ALWG Setup, see the following pages respectively in the I/V Sweep section of this

module.

*To Set Timing Parameters
*To Set Sweep Abort Function
*To Set Ranging Mode

*To Set ADC/Integration Time
*Advanced Setup

*SPGU Pulse Setup

*SPGU ALWG Setup

If a SMU is set to the pulse output:

The Range button is not available.

The dialog box opened by the ADC/Integ button is different from the I/'V Sweep. See “A/D

Converter & Integration Time Setting” page.

The Pulse button is available which opens the Pulse Setup dialog box. See “Pulse Setup” page.
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. . i
A/D Converter & Integration Time Setup &=
ultl
Channel 'V
Sweep
Measurement Setup
Range A/D Converter
- l ADC / . Unit: Name: ADC: Measurement:
Ineg ) [eroree & i[5 a0 =] [compliance Side =
Pulse [eMuzir 8]fi2 =l [Hs aDC ] [compliance Side =l
IQWU?.:HR ﬂ|13 ﬁjHS ADC j |Can'pian:e Side j
e [EruaR = =[S ADC =] [compliance Side =
SPGU
Pulse
[sete ] [Integration Time
Mode: Factor: Auto Zero:
High Resolution ADC: | ] INaN || |
High Speed ADC: |T[ME :”2 us _ﬂ
Pulse Averaging Count
Count: |1 B
_ e |

The ADC/Integ button opens the A/D Converter & Integration Time Setup dialog box. The
dialog box is used to set the operation of the high speed ADC.

A/D Converter:

*Unit: SMU name or number

*Name: Variable name of the measurement data

*ADC: ADC type, HS ADC (high speed)

*Measurement: Compliance side measurement or Force and Compliance sides measurement.
HR ADC is not available for HCSMU, HVSMU, and the measurement which uses SMU pulse.

Force and Compliance sides measurement is not available for HRSMU, MPSMU, and HPSMU.

Integration Time:

*Mode: ADC operation mode TIME or PLC.

*Factor: Coefficient for the reference value of the integration time.
Pulse Averaging Count:

*Count: Number of pulsed measurements for averaging to get one measurement data. Not
effective for HRSMU, MPSMU, and HPSMU. The setting is automatically set to the same
setting on the Pulse Setup dialog box for using multiple SMU pulse output channels.
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‘r'dﬂ
Pulse Setup =
Multi
Channel 'V
M t Set e
casurement Setup For multiple pulse sources
Common
Period: [8UTO B
ADC /
Integ Measurement Delay Time [AUTO B
- | ik |Integration Time
Mode: Factor: Auto Zero:
e High Resolution ADC: | Y o] =
SPGU High Speed ADC: [TIME ~lRus |
Pulse
Setp Pulse Averaging Count |
. Count: |1 B
For single pulse source
Pulse Channels |
Im—| Unit: Name: Pulse Delay Time: Width: Base:
SMU1:HP Bjvi #|jos 8|1 ms Ejjov ]
wr——lL s g ] l [l
Period: [AUTO B IMHR EHVZ _iJ|0 = —i‘”]' L _iJ|0 i —i-l
Width: [1ms il
Base: [0V il
Common:

*Period: Pulse period. Entering AUTO sets the optimum value automatically.

*Measurement Delay Time: Delay time from the beginning of the pulse period to the beginning
of the measurement. Entering AUTO sets the optimum value automatically so that the
measurement is completed when the transition from peak to base is started by the pulse output
channel which starts the transition at first.

Integration Time:

*Mode: ADC operation mode TIME or PLC.

*Factor: Coefficient for the reference value of the integration time.
Pulse Averaging Count:

*Count: Number of pulsed measurements for averaging to get one measurement data. Not
effective for HRSMU, MPSMU, and HPSMU.

The Integration Time and Count settings are automatically set to the same settings on the A/D
Converter & Integration Time Setup dialog box.

Pulse Channels:

*Pulse Delay Time: Delay time from the beginning of the pulse period to the beginning of the
transition from base to peak. This value must be 0 for HRSMU, MPSMU, and HPSMU.

*Width Pulse width. The value must be the same for HRSMU, MPSMU, and HPSMU.

«Base: Pulse base value
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To Set User Functions =

Multi
Channel 'V
Sweep

Function Setup
Q]{Multi Channel I/V Swegp otup Name: [Trng Multi

Channel Setup | Measurement Setup | Function Setup | auto Analysis Setup | Display Setup |
User Function

(_ add | Toeete| | m‘}\

Name: Unit: Definition:

o [vee |y =fvb-ve |

Data calculation
-Measurement data/source data
\ -Built-in function, etc.

Name: Unit: Definition:

To add a function parameter, press the [Add] button in this area.

Click the Function Setup tab to display the User Function/Analysis Function setup screen. The
user functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the
Data Display window. Up to 20 functions can be set.

Name: Function name
Unit: Unit of the function

Definition: Definition of the function. The following identifiers can be used.
-Variables for the measurement/output data used in this test

-Functions defined in the above lines

-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables

For details, see online help or User’s Guide.
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ey
i e
To Set Data Display
Channel 'V
« Sweep
Display Setup
®|[Multi Channel I/ Sweep Setup Name: [Trng Mult] i
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup [Display Setup |
X-Y Graph ———— 7
( Add I Delete I Up l Down ] \
Name: Sharing:  Scale: Min: Max:
P ox:  |vbe =] [more) =] rexr =] fov 8] 1v &)
Gl =] [mone) =] JLog =] s 8] [100ma 8]
c vz fb =] [vore) =] ftoa = [ifa 8] [1o0ma ]
Specify X axis and Y axes
\ Select variables to list /
List Display /1 [Parameters
( Add I Delete I Up I ﬁ'cr.‘m Add | F_";l Ug | Down |
c  |vbe - =
L8] Ic hd
@ b - To add a parameter, press the [Add]
button in this area.
\ @ Vh - =

Click the Display Setup tab to display the display setup screen.

The X-Y Graph area is used to set the X axis and Y axes of the X-Y Graph Plot area in the Data
Display window.

*Name: Name of variable to plot on the X axis
*Scale: Linear or Log

*Min: Minimum value of the specified axis
*Max: Maximum value of the specified axis

The List Display area selects the variables to be listed in the List Display area of the Data
Display window. Up to 20 variables can be set.

For example, following variables are set for the Class Exercise.
Vbe, Ic, Ib, Vh, Ih
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Class Exercise ""‘

Define test setup and perform test.

1. Click Multi Channel I/V Sweep icon and open setup
editor.

2. Define test setup as shown in the previous pages.
3. Save it as Trng Multi.

4. Connect devices (NPN Bipolar Transistor and Red
Miniature LED) as shown in next several pages, and
perform test.

5. Export preset group, and import it.

Note:
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Multi

SMU Triax Connection Channel 1y

Swieep

Force Lines to Fixture 1,2,3,4 Ports

Force side Sense side
N v

| |
CMU @eee /
SMU4 2 > @.@ - 16442 A/B Fixture
SMU3 ot e o
SMU2 -7 - i =), ® ° @

9,0 -
SMUI1 c@®,.@ - B @®.@ -
GNDU

B1500A Rear View

For the non-Kelvin connections, connect only the Force lines, leaving the Sense lines open.

Connect corresponding numbers. On the 16442A/B fixture use the numbers labeled 1 - 6, not 1
3.

Your B1500 may not match the SMU configuration shown in this figure. Note that SMU1 is the
module top of the GNDU (ground unit). The SMU number become large from bottom to top as
shown.

This is the SMU cable setup that will be used in the remainder of the class exercises.
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Multi

Jumper Leads - MOS transistor Chamnel 1y

Swieep

O E
1 2 5 lso ¢
© © & {poonoooooood) e Eitter
VMU o 16 Baser
i Punnnnnnnnunm Shorter Lead 15, Colloctor

14

With the 16442 A/B fixture, note that there are two SMU numbering schemes....3 SMUs with
force and sense, or six SMUs with force only. For this class example we will use the six (6)
SMU scheme.

Connect jumper leads as follows.
Terminal 13 : SMUI F terminal
Terminal 14 : GNDU F terminal
Terminal 15 : SMU4 F terminal
Terminal 16 : SMU3 F terminal
Terminal 17 : SMU2 F terminal

Locate the bipolar transistor in the corner of the 28-pin dual in line socket as shown, with the flat
side of the device facing toward you. Unlike the MOS device, the bipolar transistor is not static
sensitive. You may touch the leads without using a ground strap.

Locate the LED between terminals 13 and 14 of the 28-pin dual in line socket.
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Measurement Result Example e
ulti
Channel 'V
Sweep

© Multi Channel I/V Sweep - Keysight EasyEXPERT mE X

File Edit View Marker Cursor Line Window Help

HHE BQARE- BEERYE P a6y
Setup Name: |M!-IM Channel [/V Sweep X

X-Y Graph Plot Properties...

® :
100m
decade
fdiv
1f
] vbe (V) 100 m /div 1

List Display Properties...
Index | be | A B[ vh | Th A
99 833 mv 21.813 mA 170.76 uA 245V 77.742 mA
100 841.5 mv 23.446 mA 188.8 UA 2475V 80.717 mA i
101 850 mv 25.087 mA 207.68 uA 25V 83.8 mA [:

This is a test result example displayed on the Data Display window.
At the start of measurement, LED lights off. Beyond the threshold voltage, the LED lights on.
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I/V List Sweep

To Define Channel Setup Screen
To Set VAR1 Sweep Sources
* To Set Constant Qutput

Other Measurement Setup Parameters
* To Set User/Analysis Functions

* Auto Analysis Setup

To Set Data Display

This section explains how to perform I/V List sweep measurement. You will perform the above
tasks to execute the I/V List sweep measurement.

I/V List Sweep measurement is similar to I/V Sweep measurement.
Changes from the I/V Sweep are listed below.

*VAR1/VAR?2 step output values are set by using a vector data. Vector data from a spreadsheet
software, either tab separated or comma separated can be copied to the Define vector data dialog
box via the Windows clipboard.

*All SMU installed in the B1500 can be set to VARI.
*VAR1’ is not supported.

For more information, see online help or User’s Guide.
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To Define Channel Setup Screen =

Channel Setup Setup Name
- ist Sweep Setup Name: [|Trng List
- Channel Setup mamtSe:mletmm]wtuAmLsamm—J
Vehennelpefirition

nadswu | [addseeu| | Dtz | o I |
: V Name: T Name: Mode: Function:
[emuLHe [vsubs ‘m[isubs E >]fconsT |
[sMuUz:HR =|[vsource ‘milsource [V =lfconsT =
[SMUS:HR > ||vgate Igate v > |[VARL >
f Ef = = =f El
[sMua:r =]vdran =]fidran =V llconst =]

SMU Channel Definition
-V name/l name
-V/I/VNPULSE/IPULSE/COMMON

-VAR1/VAR2/CONST
PGU Ch 1 Definiti
3 Sl Channclbefisidon Variable name for reading time stamp data
-V name
-VPULSE/ALWG / Variable name for reading data index
Miscellaneous Variables A /l

time Stemp Name: [ index Name: 2 T=

Click the I/V List Sweep icon and open the setup editor. Then click the Channel Setup tab to display the
channel definition screen.

1. Enter the Setup Name for the test setup to be defined on the setup editor.

2. List SMUs used for source output or measurement, and set the following parameters.
*Unit: SMU name or number. The GNDU (ground unit) can be set instead of a SMU.
*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current pulse), or
COMMON (ground)

*Function: Source output function, VAR1 (primary sweep), VAR2 (secondary sweep), or CONST
(constant). Note: Up to 10 sources can be set to VARI.

V Name and I Name are used to specify the parameters displayed on the Data Display window. The display
parameters are selected on the Display Setup tab screen. For the GNDU, 0 V is returned to the V variable
and no data is returned to the I variable.

To use the SPGU channels, click the Add SPGU button. The SPGU channel setup row will appear. Then
set the following parameters.

*Unit: SPGU name or number
*V Name: Variable name for the voltage data. No data is returned to the variable.

*Mode: SPGU output mode. VPULSE (voltage pulse) or ALWG (arbitrary linear waveform voltage) for all
SPGU.

You can read measurement data by using the Data Display window. Parameters displayed on the window
are selected on the Display Setup tab screen. If you enter the variable name in the V Name, [ Name, Time
Stamp Name, and/or Index Name entry fields, you can choose the variables as the display parameters.

Note: The time stamp is the time the measurement is started for each measurement point. The index is the
index number for each measurement data.
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To Set VAR1 Sweep Sources

Measurement Setup

ol Setup Name: [Trng List
Measurement Setup |Function Setup | Auto Andysis Setup | Display Setup |
v s — [

Unit: Sources: Compliance: Pwr Comp: LD
100 mA | |OFF il anc /
Integ
b o v:'u:d-ed
£ SPGU
4 | L-so0my Pulse
Grid button 2oy Setup
3500 mV
v
5105 v
6l11v
7l115v
[fming 8l12v -
Hold: [0's C1 o | ccal | BNY  v|status
Constants
Unit: V Name: I Name: Mode: Source: Compliance:
BwieEeks ks =P sbv  Spoms &
L T Cr e e w5
[srusirR 8] [veran ‘i idran (g Gfoomv Elooma 8]

IV List
Sweep

The Measurement Setup tab screen is used to set the source output value and timing parameters.
At the VARI area, you set VAR1 sweep sources.

*Unit: SMU name or number

*Source: Click the grid button to open the Define vector data dialog box. Enter the vector data of
VARI. For example, -500 m, 0, 500 m, 1, 1,05,1.1, 1.15, 1.2, 1.25, 1.3, 1.35, 1.4, 1.45, 1.5, 1.55,
1.6,1.65,1.7,1.75,1.8,1.85,1.9,1.95, 2, 2.5, and 3 V are set for the Vth-gmMax. Step voltages
near the gmMax are set to 50 mV and others are set to 500 mV.

*Compliance: SMU compliance value

*Pwr Comp: SMU power compliance value
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Measurement Setup

To Set Constant Output

Setup Name: [Tmg List

Olragls
& Measurement Setup || Function Setup | Auto Andysis Setup | Display Setup |
|

[VARL
Unit: Sources: Compliance: Pwr Comp: Woizd
T P T =
Integ
Timing |
Hold: [0s 8] Delay: [=].. | * Sweep [mzswt“
[Constants ]
it: V Name: I Name: Mode: Source: Compliance:
1:HP 8] [vsubs = [lsubs =V v 8100 ma 0]
HR H][vsource ] flsource ElT v 8][100 ma 0|
8] [vdran ] [icrain = 8][100 mv B[00 ma ]

At the Constants area, you set the SMU constant output.

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data
*Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current

pulse), or COMMON (ground)

*Source: SMU output value. For example, Vdrain is set to 100 mV for the Vth-gmMax.

*Compliance: SMU compliance value
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Other Measurement Setup Parameters

Measurement Setup

fol Setup Name: [Trng List
Measirement Setup || Function Setup | Auto Andysis Setup | Display Setup |
|

[VARL

(= )
Unit: Sources: Compliance: Pwr Comp: LD
[u0zrR | [w]... W[[wome  w[orF 0} e
Integ

Hold: [0 5 8] Dpelay: [a].. | [~ Sweep [CONTINUE AT ANY - statu-.-]
Constants |
Unit: V Name: I Name: Mode: Source: Compliance:

R e - T | I
N e [ e T
[eMuarR 8] [veran ‘i fidkan T Ffoomv @woma &

Ea;

IV List
Sweep

For the functions of Timing, Sweep status, Range, ADC/Integ, Advanced, SPGU Pulse Setup,
and SPGU ALWG Setup, see the following pages respectively in the I/V Sweep section of this

module.

*To Set Timing Parameters
*To Set Sweep Abort Function
*To Set Ranging Mode

*To Set ADC/Integration Time
*Advanced Setup

*SPGU Pulse Setup

*SPGU ALWG Setup
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To Set User/Analysis Functions =

Function Setup
QIEI/V List Sweep up Name: [Tmg List
Channel Setup | Measurement Setup Auto Analysis Setup | Display Setup |
User Function
Add | Delete | Up l Daown I
Name: Unit: Definition:
c [om =S | [diff(ickain, vigate) |

Data calculation
-Measurement data/source data
-Built-in function, etc.

[Analysis Function |
add 0 |
Name: Unit: Definition:
c Jowax mfs =] [maxigm) 5]
e o wv ~lfeLix |
c fth wv x|[von-tvdrainf2) ]

Click the Function Setup tab to display the User Function/Analysis Function setup screen. The
user/analysis functions can be displayed on the X-Y Graph Plot, List Display, and Parameters
area of the Data Display window. Up to 20 functions can be set.

Name: Function name
Unit: Unit of the function

Definition: Definition of the function. The following identifiers can be used.
-Variables for the measurement/output data used in this test

-Functions defined in the above lines

-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables

For details, see online help or User’s Guide.

For example, following user/analysis functions are set for the Vth-gmMax.
<Name> <Unit> <Definition>

Gm S diff(Idrain,V gate)

gmMax S max(gm)

Von v @L1X

Vth A" Von-(Vdrain/2)

For built-in functions, see online help or User’s Guide.
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Auto Analysis Setup

Auto Analysis Setup

@|1/V List Sweep Setupaial
Channel Setup | Measurement Setup | Function Setup

By

I™ Interpolation Mode

Line 1
— —

/T Enable | TYPE Axis \
I Fix € Normal € Gradient @ Tangent  Regression Y1 ht
First Point

€ X-Y Coordinate  Data Condition
Conditon: fom g = [omiax = [ afer | EN =
Second Point

@ X-Y Coordinate € Data Condition

\ Xi | = Yo dj

Line 2
[ Enable [ TYP® Axis
B Fix @ Normal € Gradient € Tangent € Regression 1 'l
First Point

& X-Y Coordinate € Data Condition
X: I 5 Y I H
Second Point
@ X-Y Coordinate € Data Condition
x| £ Yoo =

Marker
™ Enable
Condition: | CE = [T after | CHl =

IV List
Sweep

Click the Auto Analysis Setup tab to display the Auto Analysis setup screen. This screen is used
to set the automatic analysis function. When a measurement finishes, the function automatically

draws lines, a marker, or both on the X-Y Graph of the Data Display window.

You can set up two lines and one marker for the automatic analysis function.

In the Line 1 and Line 2 areas, you can set up the lines to be drawn.

In the Marker area, you can set up the marker.

For details, see online help or User’s Guide.

For example, the Line 1 is set for the Vth-gmMax.
Type: Tangent

Axis: Y1

First Point: Data Condition

Condition: gm = gmMax

3-49



To Set Data Display

Module 3
Classic Test Environment

/v List
Sweep
Display Setup
@||1/V List Sweep Setup Name: [Tmg List
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup
X-¥ Graph —_—
| Jossa| [ul foom|
Name: Sharing:  Scale: Min: Max:
P x: |Voate ] [Mere) =] fonear ¥ [soomv 8] BV &
€ ¥1: |idrain >| |(None) w| |Linear v] [-1 mA ﬂ Ilu mA E]
C v2: fom =] [Nore) =] Jnear =] o 8] [1oms ]
L
Specify X axis and Y axes
Select variables to list
List Display /’ [Parameters
Add | E:f—‘:—'f—[ / ! Down | Add I ﬂ':f?'»ﬁl Ug | Dowr
(! E\fgate - 2 € [omMax -
C |vsource - C  |Vth fud
C  |Vdrain -
G T - Select parameters to list

Click the Display Setup tab to display the display setup screen.

The X-Y Graph area is used to set the X axis and Y axes of the X-Y Graph Plot area in the Data Display
window.

*Name: Name of variable to plot on the X axis
Scale: Linear or Log

*Min: Minimum value of the specified axis
*Max: Maximum value of the specified axis

For example, following axes are set for the Vth-gmMax.

<Name> <Sharing> <Scale> <Min> <Max>
X Vgate Linear -500mV 3V
Y1 Idrain (None) Linear -1mA 10 mA
Y2 gm (None)  Linear O0S 10 mS

The List Display area selects the variables to be listed in the List Display area of the Data Display window.
Up to 20 variables can be set.

For example, following variables are set for the Vth-gmMax.

Vgate, Vsource, Vdrain, Vsubs, Idrain, gm

The Parameters area selects the variables to be listed in the Parameters area of the Data Display window.
Up to 20 parameters can be set.

For example, following parameters are set for the Vth-gmMax.
gmMax, Vth
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Class Exercise

Define test setup and perform test.

I

2. Define test setup as shown in the previous pages.
3
4

. Connect an N-ch MOSFET as shown in next several

Click I/V List Sweep icon and open setup editor.

Save it as Trng List.

pages, and perform test.

Export preset group, and import it.

Note:
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5

Vv List

SMU Triax Connection Sweep

Force Lines to Fixture 1,2,3,4 Ports

Force side Sense side
N v

| |
CMU @eee /
SMU4 2 > @.@ - 16442 A/B Fixture
SMU3 ot e o
SMU2 -7 - i =), ® ° @

9,0 -
SMUI1 c@®,.@ - B @®.@ -
GNDU

B1500A Rear View

For the non-Kelvin connections, connect only the Force lines, leaving the Sense lines open.

Connect corresponding numbers. On the 16442A/B fixture use the numbers labeled 1 - 6, not 1 -
3.

Your B1500 may not match the SMU configuration shown in this figure. Note that SMU1 is the
module top of the GNDU (ground unit). The SMU number become large from bottom to top as

shown.

This is the SMU cable setup that will be used in the remainder of the class exercises.
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o |
Jumper Leads - MOS transistor Sweep
GNDU
FO
£©
© s©
T 2
O O
7 12
Q ) O
13 14 15 16 17 18
VSu S O & € @G D
1 5) (15 s W 20 22 2, 6
@ @ 35 (000000000ODOOD| 26 16088-60002
VMU 9 I g Dual in line package
74
é) é) PDDDDDDDDDDDDE (28 pin)

With the 16442 A/B fixture, note that there are two SMU numbering schemes....3 SMUs with
force and sense, or six SMUs with force only. For this class example we will use the six (6)
SMU scheme. On older fixtures, this scheme is shown in light blue lettering. In newer fixtures,
this scheme is shown in white reverse background lettering.
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Sub

Device Orientation and Insertion Sweep

5

Vv List

15

10ouopopoooood

Insert the transistor last,
AFTER connecting the
cables and leads. Remove
the shorting wire after
insertion in the socket.

1

14
1: Substrate
2: Source
3: Gate
4: Drain

The MOS FET leads must be re-arranged into a straight line as shown.

IMPORTANT:

The MOS FET is highly sensitive to electrostatic damage. Touching the bare leads can definitely
destroy the device. The device comes with a special shorting wire attached. Bend the leads the
way you want, insert the device in the socket, and then remove the shorting wire. The wire has a
tab. Just grab the tab and pull straight out. The wire will spiral out as you pull.

Once the shorting wire is removed, you must use a wrist strap when handling the device.
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Measurement Result Example

@ Trng List [(1) ; 4/23/2007 9:12:45 AM] - Keysight EasyEXPERT BE x|
File Edit View Marker Cursor Line Text Pointer Window Help
FREE @ NG T PP EEFI RS aa ™2 BE . 7 = e
HER-QQA@-BSHHMe E -FA-EhL
Setup Name: ITrng List [{1) ; 4/23/2007 9:12:45 AM] X
[X-Y Graph Plot Properties... Parameters |
HAMEN gmMax [ 07400 ms
12m m o
1.00451 V
g Im Gradient: e
= ou 1.074000€-003 =
sy -
70y
0y
500u
i
9 u
= my
100u
-150p -3
-50m 0 som 1 15 2 25 3
vgate (V) 500 m /div <] 5 @
[Ust oispiay Properties... | |
Index | Vgate | Vsource | Vdrain | Vsubs | Tdran | gm|a
8 1.2000 v oV 100.00 mv ov 155.620 UA  1.048740000 ms =
9 1.2500 V oV 100.00 mV ov 209.960 UA  1.074000000 mS [v]
<l T 2]

IV List
Sweep

This is a test result example displayed on the Data Display window.
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I/V-t Sampling Measurement

AP
&%

* To Define Channels and Variables
\f=
* To Set Sampling Parameters I" : t
Sampling

* To Set Stop Condition
To Set SMU Outputs (CONST)
Range/ADC/Advanced/SPGU e

* To Set User Functions/
Analysis Functions t

To Set Data Display ' \\\\—\

This section explains how to perform I/V-t sampling measurement. You will perform the above
tasks to execute the I/V-t sampling measurement.
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Classic Test Environment

s

To Define Channels and Variables <
Sampling

Channel Setup

Al mpling Setup Name: [|Tmg Sampling ]

- Channel Setup |Measurement Setup | Function Setup | Auto e
Add SMU ] AddsPGJl Delete { Up | Down |
Unit: ¥ Name: IName: Mode:
[r‘ [smurre =l En [V Zl]

SMU Channel Definition
-V name/l name

SMUI
-I/'V/ICOMMON i
-CONST
SPGU Channel Definition T

-V name

-VPULSE/ALWG
GNDU

Variable name for time stamp data

Variable name for data index

Variables \

Time Stamp Name: e ______ 1= Index Name: :E

Click the I/V-t Sampling icon and open the setup editor. Then click the Channel Setup tab to display the
channel definition screen.

1. Enter the Setup Name for the test setup to be defined on the setup editor.

2. List SMUs used for source output or measurement, and set the following parameters.
*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), or COMMON (ground)

*Time Stamp Name: Variable name for the time stamp data

*Index Name: Variable name for the data index

V Name and I Name are used to specify the parameters displayed on the Data Display window. The display
parameters are selected on the Display Setup tab screen. For the GNDU, 0 V is returned to the V variable
and no data is returned to the I variable.

To use the SPGU channels, click the Add SPGU button. The SPGU channel setup row will appear. Then
set the following parameters.

*Unit: SPGU name or number
*V Name: Variable name for the voltage data. No data is returned to the variable.

*Mode: SPGU output mode. VPULSE (voltage pulse) or ALWG (arbitrary linear waveform voltage) for all
SPGU.

You can read measurement data by using the Data Display window. Parameters displayed on the window
are selected on the Display Setup tab screen. If you enter the variable name in the V Name, [ Name, Time
Stamp Name, and/or Index Name entry fields, you can choose the variables as the display parameters.

Note: The time stamp is the time the measurement is started for each measurement point. The index is the
index number for each measurement data.
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C &
To Set Sampling Parameters &
vt
Sampling
Measurement Setup
‘QIEI/V*t S. Setup Name: [Tma Samping
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |
[Sampling Parsmete——————' Stop Condition |
Dot sl —— Range
Linear/Log: [LINEAR hd Enable/Disable: |[ENABLE hd R
ADC /
Interval: {30 ms U Enable Delay: |0s ] Integ
\
No of Samples: |1EI1 B Name: |11 -
Total Sampling Time: f5 s Threshold: IE A ]
Output Sequence: [SEQUENTIAL = Event: [val < Th -
Hold Time: 100 ms ] No. of Events: |1 [l
Base Hold Time: |05 ]
Constants ]
Unit: V Name: I Name: Mode: Base: Source: Compliance:

i Efm Hm =V &by Ev S

Trigger
Measurement time

-

Hold time Sampling interval

Click the Measurement Setup tab to display the setup screen for the sampling timing parameters
and the SMU source output parameters. At the Sampling Parameter area, you set the following
sampling timing parameters.

Linear/Log:

Sampling mode. LINEAR for linear sampling. LOG10, LOG25, LOG50, LOG100, LOG250, or
LOG500 for logarithmic sampling. For the logarithmic sampling, the number after LOG
indicates the number of measurement data in a decade. For example, LOG10 mode is used to get
10 data/decade.

For the log sampling, the B1500 holds only the data that can be plotted on the log scale in the
same distance as close as possible. Only the held data is counted in the number of measurement
result data.

For the linear sampling with Interval < 2 ms, if the total measurement time runs over the
specified time Interval > No of Samples, the sampling measurement will be stopped even if the
number of measurement result data is less than the specified No of Samples.

Interval:
Interval of the sampling, in seconds. 0.002 to 65.535 s, 0.001 s resolution.

Interval <0.002 s in 0.00001 s resolution is also available for the linear sampling. It must satisfy
the following formula. For details, see online help or User’s Guide.

Interval > 0.0001 + 0.00002 > (number of measurement channels-1)
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v,"l‘,/-l
vt
Sampling

To Set Sampling Parameters

Measurement Setup

@|1/v-ts, Setup Name: [Tma Samping
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |
4 Stop Condition
Linear/Log: Wzl Enable/Disable: [MIE—ZI
Interval: [3%6—1] Enable Delay: [m
No of Samples: [101 B Name: m
Total Sampling Time: h Threshold: m
Output Sequence: [SEQUENTIAL =] Event: [Val < Th v
Hold Time: m No. of Events: [ﬁl
Base Hold Time: m
Constants ]
Unit: V Name: I Name: Mode: Base: Source: Compliance:

i Efm Hm =V &by Ev S

Trigger
Measurement time
-
Hold time Sampling interval
No of Samples:

Number of samples. Integer. 1 to the following value.
For linear: 100001 / (number of measurement channels)
For logarithmic: 1 + (number of data for 11 decades)
Total Sampling Time:

This field just displays the total sampling time that is the time from the measurement start time
for the first point to the end of sampling measurement. It does not include the hold time.

Total Sampling Time = Interval > No of Samples

Output Sequence:

Source output sequence. SIMULTANEOUS or SEQUENTIAL.

Hold Time:

Time since the Source value output until the first sampling point, in seconds. 0 to 655.35 s,
resolution 0.01 s.

The following values are also available for Interval < 0.002 s. |Hold Time| will be the time since
the sampling start until the Source value output.

-0.09 to -0.0001 s, resolution 0.0001 s.

Base Hold Time:

Hold time of the Base value output until the Source value output, in seconds. 0 to 655.35 s,
resolution 0.01 s.
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To Set Stop Condition g

V-t
Sampling

Measurement Setup

@|1/v-ts, Setup Name: [Ta Samping
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |
4 Stop Condition
Unear/tog: [TERR =] |/ Enable/Disable: FUBE =]
Interval: f0ms | Enable Delay: [0s i
No of Samples: ,hl Name: m
Total Sampling Time: m Threshold: m
Dutput Sequence: [SEQUENTIAL  + Event: al<Th  ~]
Hold Time: 100 ms ] kmu.or Events: [ﬁ]
Base Hold Time: [US—EI
Constants ]
Unit: V Name: I Name: Mode: Base: Source: Compliance:
o EFr . =Hr =V HEpv  EFv Hpome &
Trigger
Measurement time
«—
Hold time Sampling interval

The stop condition is defined by using the Stop Condition fields on the Measurement Setup
screen. This function stops the measurement as shown below.

1. Compares the value of parameter set to the Name field and the value defined in the Threshold
field.

2. Counts how many times the selected Event occurs.

3. When the count reaches the value defined in the No. of Events field, sampling is stopped
immediately.
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To Set SMU Outputs (CONST) &

V-t
Sampling

Measurement Setup

g“IN-t S Setup Name: [Tmg Samping i
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |

[5

g Stop Condition
Linear/Log: |LINEAR r Enable/Disable: [ENABLE ~
Interval: [30ms [] Enable Delay: [0¢ B
No of Samples: [101 ] Name: |[1 -
Total Sampling Time: Fs—j Threshold: |04 ]
Output Sequence: W Event: im
Hold Time: [100 s W No.of Events: [T W]
Base Hold Time: |05 []
[Sonstants I
Fnlt: ¥ Name: 1 Name: Mode: Base: Source: C i
rwm =R =V sbv  skv Som 51]

SMU constant output setup

At the Constants area, you set the SMU constant output.

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), or COMMON (ground)
*Base and Source: SMU output value

*Compliance: SMU compliance value

Base value is available for all output channels for the SIMULTANEOUS mode and the last
source channel for the SEQUENTIAL mode.
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Range/ADC/Advanced/SPGU Setup &

V-t
Sampling

Measurement Setup

g;l/\l-t S Setup Name: [Tmg Samping
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |

[

g Stop Condition (
Range
Linear/Log: [LINEAR et Enable/Disable: [ENABLE -
Interval: [30ms [] Enable Delay: [0¢ B
No of Samples: [101 ] Name: |[1 -
Total Sampling Time: ﬁs—j Threshold: |04 ]
Output Sequence: W Event: im
Hold Time: [100ms ] No.of Events: [T W]
Base Hold Time: [0 s []

[constants ]

Unit: ¥ Name: 1 Name: Mode: Base: Source:

| S T A TR

For the Range, ADC/Integ, Advanced, SPGU Pulse Setup, and SPGU ALWG Setup buttons, see
the following pages respectively in the I/V Sweep section of this module.

*To Set Ranging Mode

*To Set ADC/Integration Time
*Advanced Setup

*SPGU Pulse Setup

*SPGU ALWG Setup

Note:

If the range changing occurs during measurement, the SMU may not complete measurement
within the sampling interval. So use FIXED range if the sampling interval is top priority and the
resolution/sensitivity is second priority.
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Function Setup

@|1/v-t sampling
Channel Setup | Measurement Setup

To Set User Functions/Analysis Functions

p Name: [Tmg Samping

User Function

Definition:

Name: Unit:
¢ [peita  mfsec

| [detta(Time)

Data calculation

-Measurement data/source data
-Built-in function, etc.

[Analysis Function

Definition:

Name: Unit:
[ C !Averne !IA E”avg(n)

Data calculation

-Read out function

-Measurement data/source data

-Built-in function, etc.

v,"l‘,/-l
vt
Sampling

Click the Function Setup tab to display the User Function/Analysis Function setup screen.

The user functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the Data

Display window. Up to 20 functions can be set.
*Name: Function name

*Unit: Unit of the function

*Definition: Definition of the function. The following identifiers can be used.

*Variables for the measurement/output data used in this test

*Functions defined in the above lines

Local variables passed from the application test that calls this test as a component

*Built-in functions and global variables

For details, see online help or User’s Guide.

The analysis functions can be displayed on the Parameters area of the Data Display window. Up to 20

functions can be set.
*Name: Function name

*Unit: Unit of the function

*Definition: Definition of the function. The following identifiers can be used.

*Variables for the measurement/output data used in this test

*Functions defined in the above lines

*Local variables passed from the application test that calls this test as a component

*Built-in functions and global variables
*Read out functions

For details, see online help or User’s Guide.
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o

To Set Data Display &

V-t
Display Setup
@{I/V-t Sampling Setup Name: [Tmg Sa
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup

Sampling

X-Y Graph N
Add | Delete | Up | Down |
Name: Sharing:  Scale: Min: Max:
Fox: [Time =] [mone) =] e =] [os 8] [3s E
covi: u =] [Nore) =] Junear =] oA 8] [1zna |

Specify X axis and Y axis

List Display S
Add | Delete | Up’ | Down | Add | Delete | Up I Dawn |
[Time - [ C !Avaraue - ]
@ 188 -

Select parameters to display

C  |Delta =

Select variables to list

Click the Display Setup tab to display the display setup screen. The X-Y Graph area is used to
set the X axis and Y axis of the X-Y Graph Plot area in the Data Display window.

*Name: Name of variable to plot on the X axis
*Scale: Linear or Log
*Min: Minimum value of the specified axis

*Max: Maximum value of the specified axis

The List Display area selects the variables to be listed in the List Display area of the Data
Display window. Up to 20 variables can be set.

The Parameters area selects the variables to be listed in the Parameters area of the Data Display
window. Up to 20 parameters can be set.
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Class Exercise

Define test setup and perform test.

I

. Export preset group, and import it.

Click I/V-t Sampling icon and open setup editor.

. Define test setup as shown in the previous pages.

2
3
4
5

Save it as Trng Sampling.

. Connect device (capacitance), and perform test.

SMU1

1
T

GNDU

Sampling

Note:
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Measurement Result Example

€ Trog Sampling [(23) ; 8/17/2005 4:08:53 PM] - Keysight EasyEXPERT M= x|
Fle Edt View Marker Cursor Line Window Help
q = s a3 o - =
AEERaQR @ BHEoEREsE -
Setup Name: [Trng Sampling [(23) ; 8/17/2005 4:08:53 P
X-¥ Graph Plot | Parameters |
(%) Average E.mssxmsss
2n
1
100n
Jdiv
o
0 Time (s) 200 m fdiv
[Ustoisplay
Index_| Time | 1 Delta| |~
1 Nall s V HNaN A Nal sec [E5)
2 Hall s v Nall A Hall sec
3 Hall s v lall A Hall sec
4 Nal s V HNaN A Nal sec
s Hall s v Nall A Hall sec
6 1000ms 1145270 nA Hall sec
7 127.7 ms 6.23160 nA 28.8 msec
8 157.6ms  5.21890 nA 30 msec
9 1877ms  6.09990 nA 30 msec E
10 217.6ms _ 5.57960 nA 30 msec [

vt
Sampling

This is a test result example displayed on the Data Display window.
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C-V Sweep Measurement JJ—rui!
* To Define Channels and Variables

=V Sweep
* To Set Sweep Source

* To Set Signal Source

* To Set Measurement Timing and Abort Function

* To Set SMU Outputs (CONST) [cmmeit

o MARKER{ OV 1.17232000008-012 F  1.8915100000e-006 S
)

* Range/Advanced 2

* To Set User Functions/ ¢ -

Analysis Functions '
* To Set Data Display e \g
* To Perform Compensation

800

and Correction 5 Vo 100 v 5

This section explains how to perform C-V sweep measurement. You will perform the above
tasks to execute the C-V sweep measurement.
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To Define Channels and Variables 4

C-V Sweep
Channel Setup Setup Name
plic: ep Setup Name: [Tmg CV l
-chmnelSetuD] t Setup | Function Setup | Auto Analyse
AddswU | peete| up |  Down |
Unit: ¥V Name: I Name: Mode: Function:
c [puree =livs wfi1 v =]fconsT =1
& [z =|fvd =2 = =]fconsT =l
e [oorer =fva ] =l Zvar1 H
SMUI
Channel Definition
-CMU/SMU CMH
-V name/l name O_l —0
-I/V/COMMON CML
SMU2
Variable name for time stamp data
Variable name for data index
Variables X
Time Stamp Name: E Index Name: E

Click the C-V Sweep icon and open the setup editor. Then click the Channel Setup tab to display
the channel definition screen.

*Enter the Setup Name for the test setup to be defined on the setup editor.

+List units used for source output or measurement, and set the following parameters.

*Unit: MFCMU/SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), or COMMON (ground)
*Function: CONST or VAR1

*Time Stamp Name: Variable name for the time stamp data

eIndex Name: Variable name for the data index

You can read measurement data by using the Data Display window. Parameters displayed on the
window are selected on the Display Setup tab screen. If you enter the variable name in the V
Name, I Name, Time Stamp Name, and/or Index Name entry fields, you can choose the variables
as the display parameters.

Note: The time stamp is the time the measurement is started for each measurement point. The
index is the index number for each measurement data.
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To Set Sweep Source 4

C-V Sweep

Measurement Setup

@I" _\/ S Setup Name: [Tmg CV
%mmtﬂaw unction Setup | Auto Analysis Setup | Display Setup |
C-v

S’ [Signal Source |

Range

V Name: |Vg Frequency  adq | v_‘.=.:,_1| ip I
List:
Model: [Cp-G >

& |1 MHz B ADC f

€ Name: [C g
G Name: |G E FName: |Freq g Ad-
vanced
Direction: [Single AC Level: [30mv [l
Linear/Log: |LINEAR

A V4 ,
Start: |[SV ] C\ sweep

Stop

g _r‘_r’_|71 Step
Step: lm

compliance: 71 [Integration Time | Start

Neorstop [T | Mote: P =] rctoP ]

[Fiming |

I_ Hold: [55 5] oelay: o5 W] *Sweep [CONTINEAT AW ~|status
Constants |

||

Unit: ¥ Name: I Name: Mode: Source: Compliance:
Fuome s = S Epv Hicome &
iz 2l =i S EFv o

The Measurement Setup tab screen is used to set the source output and timing parameters.
At the C-V(VAR]1) area, you set the DC bias output of the MFCMU.

*V Name: Variable name of the MFCMU output

*Model: MFCMU measurement mode. Primary and secondary measurement parameters.
*(C) Name: Variable name of the primary measurement parameter

*(G) Name: Variable name of the secondary measurement parameter

*Direction: Sweep direction, single (start to stop) or double (start to stop to start)

*Linear/Log: Sweep output, LINEAR, LOG10, LOG25, or LOG50. where the number following
LOG means the number of sweep points in one decade.

«Start: Source output start value
*Stop: Source output stop value

Step: Source output incremental step value

*Compliance: Only for SMU. Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

*No of Step: Number of sweep steps
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To Set Signal Source

Measurement Setup

E

C-V Sweep

QI; -\ S Setup Name: [Trng CV
Measurement Setup [Function Setup | Auto Analysis Setup | Display Setup |
C-v —’mm |

R:
V Name: |Vq 5 requency Add | Delete | Ble] I D;\N S
Model: [cpG = List:
: @ [1ve W ?[?C/
C Name: |C = teg
@ Name: 'ﬁ FName: [Freq g Ad-
vanced
Direction: [Single vi AC Level: [l
Linear/Log: lm
Start: |[SV i;
Stop: Iﬁ
step: [l0mv & \
compliance: ] (et |
No of Step: [101 ]| Mode: [pLC | Factor: 2 5
S |
I_ Hold: [0s 8] Dpelay: s | * Sweep [CONTINUE AT ANY ¥|status
constans |
Unit: Y Name: 1 Name: Mode: Source: Compliance:
I R 2 Epy  #om 3§
[smizFR Blfvd =iz =% Hlpv Boome &

At the Signal Source area, you set the MFCMU output frequency and oscillator level.

*Frequency List: MFCMU output frequency

*F Name: Variable name of MFCMU output frequency

*AC Level: MFCMU oscillator level, 10 mV to 250 mV, 1 mV resolution
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Measurement Setup

To Set Meas. Timing and Abort Function

E

C-V Sweep

Sweep abort function

* [CONTINUE AT ANY

@I! -\ Swi Setup Name: |ng v
Measurement Setup lfumegup|AummSe'!w|m5€m]
c-v

STOP AT ANY ABNORMAL

Timing parameters

S [Signal Source |
T SRR == - range | -Range overflow
E ci - S| oqueney asan| [oseis| | sl -MFCMU error
glmia 2| & [T ] ﬁ;g’ -SMU compliance
Gihame: [ = -SMU oscillation
G Name: [G g FName: [Freq g Ad-
vanced
Direction: [Single v1 AC Level: [30mv []
Linear/Log: |LINEAR v;
Start: [-SV i] Trigger
Stop: 5V ]
Step: [100mv 5| Integration time (AUTO or PLC) Measurement time
Compliance: 8] Integration Time
No of Step: |101 §]| Mode: [PLC zl Factor: |2 | >,
e |
Hold: [75 Bl oeloy: ps W] | *sweep [ONTBLEATANY v]status ] =
-—>
X =" \/
Unit: V Napie: I Name: Mode: Source: iance: 3
[gMozHe ifvs / it =V [ ][100 ma 0 Delay time
[zirR 5 =2 Hpv Blooms 8] Hold time

At the Integration Time area, you set the integration time of the impedance measurement by the MFCMU.
*Mode: AUTO or PLC. Rule to decide the integration time. For details, see online help or User’s Guide.

*Factor: Coefficient for the reference value of the integration time.

At the Timing area, you set the source output and measurement timing.

*Hold: Source output hold time. Time after the measurement trigger until starting delay time.

*Delay: Measurement start delay time. Time after the hold time until starting measurement.

The Sweep [ ] status field sets the sweep abort function.

When this field is CONTINUE AT ANY, the sweep measurement is not aborted.
When this field is STOP AT ANY ABNORMAL, the sweep measurement will be aborted when one of the

following conditions is detected.
*Measurement range overflow
*MFCMU error

*SMU compliance

*SMU oscillation
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To Set CONST Outputs

Measurement Setup

@I; -\ S Setup Name: [Trng CV
Measurement Setup [Function Setup | Auto Analysis Setup | Display Setup |
C-v —lwm |

V Name: m Frequency  sdd | g-,:-,q_;_l U I Down | =R

List:

Model: [Cp-G > e m :;I:;g /
chame:fc =
G Name: Iﬁ F Name: m Ad-
Direction: [;m AC Level: [30mv [l
Linear/Log: lm
Start: |[SV ]
Stop: Iﬁ
Step: lm
compliance: [ & Integration Time |
NoofStep: [io1 ]| Mode: [Pec x| Factor: |2 |
[Fering |
I' Hold: [o5 | oelay: [o: ] " Sweep [CONTINUE AT anY ~|status

Constants |

|
|Euz:m Blfvd =iz =% Hlpv 8100 ma O]

Init: ¥ Name: I Name: Mode: Source: Compliance: ]

SMU output setup

A

C-V Sweep

At the Constants area, you set the SMU constant output.

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), or COMMON (ground)
*Source: SMU output value

*Compliance: SMU compliance value
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Range Setup for C-V Sweep F

C-V Sweep

Measurement Setup

-l Range | CMU Measurement Range
ADC / Unit: Mode: Range:
Integ CMULMF ][auto =lFochm |
Ad‘
vanced
SVIU Measurement Range |
Unit: Name: Mode: Range: Range Change Rule: Rate:
© [sMuLHe B mummed  vffina ~|BY FULL RANGE =|[pen 8|
C [EMUZHP )= #LMTED  ~[tna =By FULL RANGE | ]
Close

The Range button opens the Range Setup dialog box. The dialog box is used to set the measurement
ranging operation.

CMU Measurement Range:
*Unit: CMU name or number
*Mode: Ranging mode, AUTO or FIXED

*Range: Measurement range. This field is effective when Mode=FIXED.
Available values are 50 ohm, 100 ohm to 300 kohm (=<200 kHz), 100 ohm to 30 kohm (=<2 MHz), and
100 ohm to 3 kohm (=<5 MHz) in 1, 3 step

SMU Measurement Range:

*Unit: SMU name or number

*Name: Variable name for the measurement data

*Mode: Ranging mode, AUTO, LIMITED, or FIXED

*Range: Range value

*Range Change Rule: BY FULL RANGE, GO UP AHEAD, or UP AND DOWN AHEAD
*Rate: Value used for range changing. See the following formula.

For the AUTO or LIMITED, SMU automatically selects the minimum range that covers the measurement
value, and performs the measurement by using the range. For the limited auto ranging, the instrument does
not use the range lower than the specified range value. For example, if you select the 100 nA limited auto
ranging, the instrument never uses the 10 nA range and below.

BY FULL RANGE performs normal auto ranging operation.

For the GO UP AHEAD and UP AND DOWN AHEAD rules, specify the Rate value, 11 to 100, which
fixes the boundary of the ranging. The ranging occurs when the measurement data goes across the boundary
values shown below.

go up boundary = present measurement range > Rate/ 100
go down boundary = present measurement range > Rate/ 1000
The go down boundary is available only for the UP AND DOWN AHEAD rule.

3-73



Module 3

Classic Test Environment

ADC & Integration Time for C-V Sweep A

C-V Sweep
Measurement Setup

R A/D Converter
. Unit: Name: ADC: Measurement:
— [emuHP B]jr = [HR ADC] | |compliance Side =l
.,:ﬁed ] [Eozie EE "R A0C =] [Fompliance Side =]

|Integration Time
Mode: Factor: Auto Zero:
High Resolution ADC: [suTO  ~]f ][orF |
High Speed ADC: [sUTO  ~][1 ]
_ dew |

The ADC/Integ button opens the A/D Converter & Integration Time Setup dialog box. The
dialog box is used to select the ADC for each SMU and set the integration time for each ADC
(high resolution or high speed).

A/D Converter:

*Unit: SMU name or number

*Name: Variable name of the measurement data

*ADC: ADC type, HR ADC (high resolution) or HS ADC (high speed)

*Measurement: Compliance side measurement or Force and Compliance sides measurement.
HR ADC is not available for HCSMU, HVSMU, and the measurement which uses SMU pulse.

Force and Compliance sides measurement is not available for HRSMU, MPSMU, and HPSMU.

Integration Time:

*Mode: ADC operation mode
AUTO, MANUAL, or PLC for HR ADC
AUTO, MANUAL, PLC, or TIME for HS ADC

*Factor: Coefficient for the reference value of the integration time.
*Auto Zero: Auto Zero function ON or OFF. For HR ADC.
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Advanced Setup for C-V Sweep e

C-V Sweep

Measurement Setup [Aters/oc s Monitor Setings
Unit: AC Level Monitor Name: DC Bias Monitor Name:
e | = =
Range
ADC (Channel Settings
Integ
ZEE— Unit: VYName: IName: Series R: SMU Filter:
' Ad- e i =i Hfvore =lfon =
s T R | T — o =
\Wait Time Control
Factor:
Output Wait: |1 L]
Measurement Wait: |1 L]
\After Measurement Settings
Bias Hold after Measurement: |OFF hd
Output Value after Measurement: [START -
{Semiconductor Relays (16440A SMU/PG Selector)
cH1: [PEFAUT & cH3: [PEFAT E]
Close

The Advanced button opens the Advanced Setup dialog box used to set the following functions.

AC Level/DC Bias Monitor Settings:
Defines the variables for the AC level data and the DC bias data monitored by the MFCMU
while the capacitance measurement is performed.

Channel Settings:

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data
] Name: Variable name for the current measurement or source data
*Series R: SMU series resistor NONE or IMOHM (1000000 ohm)
*SMU Filter: SMU filter ON or OFF

Wait Time Control:

*Factor: Coefficient for the reference value of the wait time. For details, see online help or
User’s Guide.

After Measurement Settings:
*Bias Hold after Measurement: Bias hold function ON or OFF.

*Output Value after Measurement: Source output value after measurement. START (sweep start
value) or STOP (sweep stop value)

Semiconductor Relays (16440A SMU/PG Selector):
*CHI1: Default or PGU OPEN
*CH3: Default or PGU OPEN

The fields define the selector channel’s switch condition during the measurement. Default is the
setting defined on the SMU/PG Selector screen of the Configuration window.
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Function Setup

To Set User Functions/Analysis Functions

QHE-TSWeep s up Name: [Tmg cv

Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |

User Function
Add | Delete |
Name: Unit: Definition:
[ c [peita mfsec | [detta(Time)
Data calculation
-Measurement data/source data
-Built-in function, etc.
[Analysis Function
add |
Name: onit: Definition:
[ o) |Average H[F _:”avg(()
Data calculation
-Measurement data/source data
-Read out function
-Built-in function, ete.

A

C-V Sweep

Click the Function Setup tab to display the User Function/Analysis Function setup screen.

The user functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the Data

Display window. Up to 20 functions can be set.
*Name: Function name
*Unit: Unit of the function

*Definition: Definition of the function. The following identifiers can be used.

*Variables for the measurement/output data used in this test

*Functions defined in the above lines

*Local variables passed from the application test that calls this test as a component

*Built-in functions and global variables

For details, see online help or User’s Guide.

The analysis functions can be displayed on the Parameters area of the Data Display window. Up to 20

functions can be set.
*Name: Function name
*Unit: Unit of the function

*Definition: Definition of the function. The following identifiers can be used.

*Variables for the measurement/output data used in this test

*Functions defined in the above lines

*Local variables passed from the application test that calls this test as a component

*Built-in functions and global variables
*Read out functions

For details, see online help or User’s Guide.
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To Set Data Display

E

C-V Sweep

O] /c-v sweep

Setup Name: [Tmg CVrl‘ i

Channel Setup | Measurement Setup | Function Setup | Auto Analysts Setup| Display Setup

[%=Y Graph

| —

Add I Delete |

Name:

Sharing:  Scale: Min:

Max:

F x [

=] [Mene) =] [rear #] ISV

Oy e

:_l I(Nune) _v_I |L|neal _vJ |SIIIPF

Ol —
HFF W

c vz e

=] [nore) =] [unear =] fos

O

Specify X axis and Y axis

) | Bown | add Delete

| B

—)

Select parameters to display

Select variables to list

Click the Display Setup tab to display the display setup screen. The X-Y Graph area is used to
set the X axis and Y axis of the X-Y Graph Plot area in the Data Display window.

*Name: Name of variable to plot on the X axis

*Scale: Linear or Log

*Min: Minimum value of the specified axis

*Max: Maximum value of the specified axis

The List Display area selects the variables to be listed in the List Display area of the Data
Display window. Up to 20 variables can be set.

The Parameters area selects the variables to be listed in the Parameters area of the Data Display
window. Up to 20 parameters can be set.
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To Perform Compensation and Correction_

V Sweep

@ Calibration bUtton ‘Advanced Options for CMU Calibration ‘
|

[Frequency [Reference Standard Value
& Use factory specified frequencies (Default) Open Reference
 specify list of calibration frequencies Model: | 0.6 =
Capadi oF L}
[ g
Conductance: [0 5 §
[Catibration | I
MU Galbraton CMU Galbration Short Reference
[cMu calibration 4 Model: [Ls =l
=L J Inductance: [0 H 0}
¥ Open Correction Measure...  Specify frequencies by range Reslstunce: [0 dhm 5
start: | 5] stop:f g Load Reference
steps: | 5 scale: | g Model: [ 157 3
¥ soncomain | ‘ b
Integration Time: . S o 0l
} © AutoMode & PLC Mode Factor: |16 5
™ Load Correction ey p—
ancet
¥ Phase Compensation (e, A d d 0 .
vance ptions...

Close.

Calibration

The MFCMU is equipped with the error correction function used to realize accurate impedance
measurements. The correction function minimizes the effects of the error elements in the
extension cables and the DUT interface such as manipulator and probe card.

*Phase compensation: Corrects phase error caused by extending measurement cables.
*Open correction: Corrects for stray admittance. Effective for high impedance measurements.
*Short correction: Corrects for residual impedance. Effective for low impedance measurements.

*Load correction: Corrects any error by using the working standard (load standard).

Click the Calibration button to open the Calibration window. And click the CMU calibration tab
on the window to perform the compensation and correction data measurement.

*To measure the phase compensation data, open the measurement terminals at the end of the
device side and click the Measure... button.

*To measure the open correction data, open the measurement terminals at the end of the device
side and click the Measure... button.

*To measure the short correction data, connect the measurement terminals together at the end of
the device side and click the Measure... button.

*To measure the load correction data, connect the load standard that has the reference value or
calibration value. Then, click the Measure... button.

For details of the error correction (CMU calibration) and the Advanced Options, see online help
or User’s Guide. The Advanced Options window is used for the compensation/correction data
measurement setup.
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Class Exercise fi“i

Define test setup and perform test.
1. Click C-V Sweep icon and open setup editor.

2. Define test setup as shown in previous pages. And
save it as Trng CV.

3. Open measurement terminals, and perform phase
compensation and open correction.

4. Connect device, and perform test. S
CMH
5. Export preset group, and import it. o e,
SMU2

Note:
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Measurement Result Example

© Trng CV [(20) ; 8/17/2005 12:43:32 PM] - Keysight EasyEXPERT BEx]
File Edit View Marker Cursor Line Window Help
== .| s EE B - =
EEE QA2 - BRHEMHe E-FA-5 7
Setup Name: [Trng CV [(20) ; 8/17/2005 12:43:32 FM]
X-¥ Graph Plot | [Parameters
® MARKER{ OV 1.1723200000¢-012 F 1.69151000008-006 S ) Average ,m
2p u
C
100f
fdiv
a00f
5 vg (V) 1.00 fdiv
||.istDlwhv
Index | v c| G| Index | Time | Deka| ~
43 -800 mv 1.50343pF 2740728 43 496225 118.2msac
44 =700 mV' 1.42850 pF 2.54577 uS 44 5.0804 s 118.15 msec
45 600 mv 136454 pF  2.38035uS 45 519855 118.1 msec
46 500 mv 131409 pF  2.24966 US 46 531665  118.15msec
47 400 mV 1.27579 pF 2.15420 uS 4 54348 s 118.15 msec
48 300 mv 1.245290F  2.07649 uS 48 555295 118.1 msec
48 200 mv 1.21895pF  2.01644 uS 48 567105 118.15msec
50 -100 mV' 1.19657 pF 1.94813 uS 50 5.7892 s 118.35 msec
51 oV 1.17232pF  1.89151uS 51 590775 118.3msec
52 100 mv 1.13482 oF 1.80326 uS 52 6.02585  118.1 msec o

E

C-V Sweep

This is a test result example displayed on the Data Display window.
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Switching Matrix Control e, 7
ey
Switching

* To Define Switch Setup Matrix

This section explains how to define the switch setup for B2200/E5250 Switching Matrix. Not
available for B15S05A.

Note: Standard revision of EasyEXPERT cannot support the E5250. The E5250 control is
optional function of B1540A-002/B1541A-002.

Note: EasyEXPERT supports the E5250A installed with the ES252A matrix card.
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. vw;‘
To Define Switch Setup ot
witching
etup Name Matrix ...
(@] Switching Matrix Control Setup Name: [Trmg Switch |
L J
Add | Delete | ‘) |
Operation: Input: Outputs: Rule:
Sl =T 3 ) Y I - |
© [[switchsetup  =flswming  =]fx | | | ijfem x|
o [prmses Sfowie dF @ @ @ e 3
© [[switchsetup ~Jlswmns — ~]f5 ]| ]| | E!BBM =l
¢ |[switchsetup  >JfswmINg — ~][7 &][ &][ [ 0 =X
S~ =
-Open All -BBM
-Switch Setup -MBBR
-Close Range To specify Output Channel
-Open Output
-Open Range To specify Input Port
-Open Input

This setup screen is used to create the relay control setup (switch setup) for Keysight
B2200A/B2201A/E5250A Switching Matrix.

To send the switch setup to B2200/E5250, click the Single button. Before doing this, you have to
establish the GPIB connection to B2200/E5250 by using the Switching Matrix tab screen of the
Configuration window and B1500A is set to system controller. See Module 8.

This screen provides the following GUI.

Add: Adds a setup row for relay connection.

Delete: Deletes the setup row. To select the setup row, use the left radio button.

Up: Moves the selected setup row upward.

Down: Moves the selected setup row downward. The setup row provides the following entry fields.

Operation: Relay control operation. Open All, Switch Setup, Close Range, Open Output, Open Range,
or Open Input. See the next page.

Input: B2200/E5250 input port number or label. Available for the Switch Setup, Close Range, and
Open Input operations.

Outputs: B2200/E5250 output channel number or label. Four entry fields are available for the Switch
Setup and Open Output operations to specify the output channels. Two entry fields are available for the
Close Range and Open Range operations to specify the range of output channels.

Rule: Relay connection rule. BBM or MBBR.
*BBM: Breaks the previous connection and then makes the new connection for the specified outputs.

*MBBR: Makes the new connection and then breaks the previous connection for the specified outputs.
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Operation and number of Qutputs

s

’ ’%
Swiitching
Matrix ...

Operation Description Number of
Outputs
Open All | Opens all relays. 0
Switch Setup|Makes the connection from the specified input port to 4
the specified output channels. Up to four output
channels can be specified at once.
Close Range | Makes the connection from the specified input port to 2
the specified output channels. They are between two
channels given by the Outputs fields.
Open Output|Opens the relays connected to the specified output 4
channels. Up to four output channels can be specified
at once.
Open Range | Opens the relays connected to the specified output 2
channels. They are between two channels given by
the Outputs fields.
Open Input |Opens the relays connected to the specified input port. 0

Note:
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e

Class Exercise

Define switch setup and send it to B2200/E5250.

1. Click Switching Matrix Control icon and open setup
editor.

2. Define switch setup as you want. And save it as Trng
Switch.

3. If B2200/E5250 is available, establish the GPIB
connection between B15S00A (must be set to system
controller) and B2200/E5250, and apply your switch
setup.

Note:
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Direct Control Lﬁﬂ
=

To Define Channels and Variables Direct

* To Set Measurement Conditions Control
* Advanced Setup

To Set User Functions

* To Set Data Display

This section explains how to use Direct Control to perform various measurements (e.g. C-f
measurement, Quasi-Static C-V measurement) using Keysight FLEX commands.

3-85



Module 3
Classic Test Environment

Channel Setup

Setup Name:

Tmg C-f
Function Satup | Auto Analysi

To Define Channels and Variables

N

- trol
- Channel Setup | Measurement Setup
ition

Variable name for time stamp data

AddSMJl Z'-“.wl AddSPGU| Delete | Up | Dowr |
Unit: ¥V Name: 1 Name:
o [oome =|[veiss Ell =
e [eMunne =1 w1 =
CMU Channel Definition: V Name
SMU Channel Definition: V Name and I Name
SPGU Channel Definition: No variable
Additional Data Variables
Additional Data Variables Add
nit: Type: Name:
e [ovonwe =Rty =G = j
o [omosme =]fcMu imiy) =l =
e foonme = ]feru OC Bias Moritor Data ] [octon =) .
Miscellaneous Variables
Time Stamp Name: Index Name: lj

Variable name for index data

E8

Direct
Control

Click the Direct Control icon and open the setup editor. Then click the Channel Setup tab to

display the channel definition screen.

1. Enter the Setup Name for the test setup to be defined on the setup editor.

2. List channels used for source output or measurement, and set the following parameters.

*Unit: Name or number of the channel

*V Name: Variable name for the voltage measurement or source data. For SMU and CMU.

] Name: Variable name for the current measurement or source data. For SMU only.

V Name and I Name are used to specify the parameters displayed on the Data Display window.
The display parameters are selected on the Display Setup tab screen.

You can read measurement data by using the Data Display window. Parameters displayed on the
window are selected on the Display Setup tab screen. If you enter the variable name in the V
Name, I Name, Additional Variable Name, Time Stamp Name, and/or Index Name entry fields,
you can choose the variables as the display parameters.

Note: The time stamp is the time the measurement is started for each measurement point. The
index is the index number for each measurement data.

For example, the Trng C-f test setup has defined the following additional variables to monitor.

<Unit> <Type> <Name>
CMUL:MF CMU Re(Y) G
CMUL:MF CMU Im(Y) B
CMUIL:MF CMU DC Bias Monitor Data  DcMon
CMUI:MF CMU AC Level Monitor Data AcMon
CMUI:MF CMU Frequency Freq
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Measurement Setup

o
* Measurement Setup fFunction Satup | Auto Analysis Setup | Display Setup |
| —

To Set Measurement Conditions

Setup Name: |Tlnq cf

Ad-
vanced

Command Setup

Add

Delete |

|

el

Command: Arguments: Ignor
1 Jr =X =
2 [ =r =
3 MM 2. cmute =
4 [WTFC =lpo =
5 [WMFC =l -
6 |WrC T]fcruriv,4,1e3,5e6,50 =
7 T bz =5r
8 |acv ~][eMuLMF,30e-3 =
g [focv | SR =
10 [re =lfemurvro =
u [T =l —jim
12 [€ =l =

=

S/

Command Setup

E8

Direct
Control

The Measurement Setup tab screen is used to set Keysight FLEX commands for measurement.

For example, following FLEX commands are set for the C-f Sweep Measurement.

<Command> <Arguments>

1 FMT 13,1

2 TSC 1

3 MM 22,CMU1:MF

4 WTFC 0,0

5 WMFC 1

6 WFC CMU1:MF,4,1¢3,5€6,50
7 ACT 0,2

8 ACV CMU1:MF,30e-3
9 DCV CMUI1:MF,1

10 RC CMUI1:MF,0

11 TSR

12 XE

13 ReadDataBuffer

See B1500 Series Programming Guide for more details about FLEX commands.
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Measurement Setup

Advanced Setup ‘

Advanced Setup

Adyaﬂcﬁcj Setup

Options

E8

Direct
Control

Primary Setup: |OFF -

iChannel Settings

Unit: VName: IName: Series R:

SMU Filter:

Ee HfT =it ‘=] [NONE

EE

=

[After Measurement Setting

Bias Hold after Measurement: | OFF s

[Semiconductor Relays ( 16440A SMU/PG Selector)

cH1: [oEFauT x| CH3: [PGUOPEN r|

The Advanced button opens the Advanced Setup dialog box. The dialog box is used to set the
option setting, the SMU filter and SMU series resistor settings, the after measurement settings,
and the 16440A selector semiconductor relay setting.

Options:
*Primary Setup: ON or OFF.

If Primary Setup=ON, the primary setup is applied to the instrument when the Direct Control test
is started. For the primary setup condition, see the online help or User’s Guide.

Channel Settings:

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Series R: SMU series resistor NONE or IMOHM (1000000 ohm)
*SMU Filter: SMU filter ON or OFF

After Measurement Settings:

*Bias Hold after Measurement: Bias hold function ON or OFF.
Semiconductor Relays (16440A SMU/PG Selector):

*CHI1: Default or PGU OPEN
*CH3: Default or PGU OPEN

The fields define the selector channel’s switch condition during the measurement. Default is the

setting defined on the SMU/PG Selector screen of the Configuration window.
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E8

Direct
Control

To Set User Functions

Function Setup

@] Direct Control Sotup Name: [Tmg C-f
Channel Setup | Measurement Setup auito Andlysis Setup | Display Setup |
Anply
User Function
Add | Delete | Ug I Down |
Name: Unit: Definition:
c p | zlpa4s |
(o] |ImY !Iﬁ j[cu'ruen[mY(Freq,G,B) ﬂ
@] |R9Y jis ;]lcmperﬁeY(Freq,G,B) EJ
ok [ =]fimv/(2*P1*Freq) |
Analysis Function
add | [C (e |
Name: Unit: Definition:
To add a function parameter, press the [Add] button in this area.

Click the Function Setup tab to display the User Function/Analysis Function setup screen. The
user functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the
Data Display window. Up to 20 functions can be set.

Name: Function name
Unit: Unit of the function

Definition: Definition of the function. The following identifiers can be used.
-Variables for the measurement/output data used in this test

-Functions defined in the above lines

-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables

For details, see online help or User’s Guide.
For example, following user functions are set for C-f Sweep Measurement.
<Name> <Unit> <Definition>

PI 3.1415

ImY S compenImY (Freq,G,B)

ReY S compenReY (Freq,G,B)

C F ImY/(2*PI*Freq)
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To Set Data Display Lm

Control
Display Setup
@] Direct Control Setup Name: [Tmg C-
channel Setup | Measurement Setup | Function Setup | Auto analysis Setup | Display Setup

TRy Graph ———
add | Dekete | ) F Down |
Name: Sharing:  Scale: Min: Max:
F % [|freq =] [mere) =] foa =] [1ke OR
covi: o =] [mNore) =] [irear =] [2s0rF 8] [poorF O

Specify X axis and Y axes.

List Display [Parameters.
add | 2| || Add Delet
c  [time -]1) =
(@] Freq -
(@ |9 - To add a parameter, press the [add]
button in this area.
[l c] bt
=

Select variables to list

Click the Display Setup tab to display the display setup screen. The X-Y Graph area is used to
set the X axis and Y axes of the X-Y Graph Plot area in the Data Display window.

*Name: Name of variable to plot on the axis

*Scale: Linear or Log

*Min: Minimum value of the specified axis

*Max: Maximum value of the specified axis

For example, following axes are set for the C-f Sweep Measurement.
<Name> <Scale> <Min> <Max>

X Freq Linear 1kHz 5MHz

Y1l C Linear -250nF 500 nF

The List Display area selects the variables to be listed in the List Display area of the Data
Display window. Up to 20 variables can be set.

For example, following variables are set for the C-f Sweep Measurement.
Time, Freq, C, G, B
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Module 3
Classic Test Environment

Y

Direct
Control

Class Exercise

Define test setup and perform test.

1. Click Direct Control icon and open setup editor.
2. Define test setup as shown in the previous pages.
3. Save it as Trng C-f.
4

. Connect a device (capacitance) as shown in next
several pages, and perform test.

5. Export preset group, and import it.

Note:
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Classic Test Environment

Cable Connections Eﬂ
Control
-/’
CMU | .
SMU4 T+ *®.@ 16442 A/B Fixture
SMU3 TP +®.@
SMU2 T - @.@-
e -@.@-
SMU1
GNDU @®
B1500A Rear View

The following cables are required to perform this class exercise.
CMU cable (Keysight N1300A-001/002), 1 ea.

One side of the CMU cable forms the attachment used to join and fix it to the CMU. And the
other side provides four BNC connectors used to connect the fixture as shown.

Connect the cables between the B1500 and the test fixture as follows.
Hcur : PGUI1 (red)

Hpot : PGU2 (orange)

Leur : VSUI (black)

Lpot : VSU2 (gray)
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Classic Test Environment

L3

Direct
Control

Jumper Leads — Capacitance

SMU GNDU
1 4 5

F O Fé)) Fg@ FO |FO© Fé@ FO© ®
cO [cO 6O |[cO [cO® |cO s©

PGU
‘ T 0 Q%900
CMUH 7) Cs) O(, 9 O 9
ch_© ,;@ I Q O O 11 O
3 M I5 6 17 8
ot O Q Q
2 | 19 28 20 21 22 23 15 (%;
= (0000000000000 &
VMU
1 2 | ¥ |pooyoooopoooon)
© © %

0.1uF

This class exercise requires four jumper leads to connect the DUT. Connect the jumper leads
between the following terminals.

PGUI : terminal 4
PGU?2 : terminal 4
VSUI : terminal 1
VSU2 : terminal 1
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Classic Test Environment

Measurement Result Example

rU'ng C-[(1) ; 5/10/2007 6:42:51 PM] - Keysight EasyEXPERT

BE =]

File Edit View Marker Cursor Line Text Pointer Window Help

AL

B D-QaAaXd-MoER3¥e E-M-G6Ells
X

SetupName: [Trg C-f [(1) ; 5/10/2007 6:42:51 PM)

X-Y Graph Plot Properties...
500n
8
s
<
g :0n
2500
100n
0
[
© 1000
-50n
1k 2k 3k S5k 0k 20k S50k 10k 200k 50k 1M 10H
Freq (HY) decade /dv
List Display Properties... | |
Index_| Time [ Frea | cl 6l I
1 336.08 ms. 1.000000 kHz 103.7413656 nF 7.66515 uS :*‘
2 617.26 ms 1.189842 kHz 103.5854829 nF 9.22423 uS |,‘11

t&

Direct
Control

This is a test result example displayed on the Data Display window.
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Module 4
Measurement Functions

In This Module

*  SMU Pulsed Sweep Measurement

* I/V-t Sampling Measurement

* Negative Hold Time for High Speed Sampling
*  Auto Analysis

* SMU Filter

* Standby Function

* Bias Hold Function

There are too many measurement functions to conveniently cover in one module. Ultralow
current measurement and capacitance measurement are covered in separate modules.

This module covers the key features listed above.
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Module 4
Measurement Functions

SMU Pulsed Sweep Measurement

* Use PULSE mode for precise force/measure timing

* Use PULSE mode for repeatable high current
measurements

» To eliminate heating during IV sweeps
» To avoid device damage

* Set the expected maximum measurement value to
Compliance

*  Multiple pulsed source/measurement channels are
available for Tracer Test and Multi Channel I/V Sweep
Classic Test

SMUs can be pulsed for precise force/measure timing, or to reduce heating of the device when
forcing high currents.

The measurement unit performs measurement by using the compliance range. It isthe minimum
range which covers the Compliance value. The Compliance value should be the expected
maximum measurement value or greater.
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Module 4
Measurement Functions

SMU Pulse Mode

VARI1

Primary H
VAR2
Secondary

VAR2 l |
Secondary |

Multiple pulsed channels are available for Tracer Test and
Multi Channel I/'V Sweep Classic Test

Tracer Test and Multi Channel 1/V Sweep Classic Test support multiple pulsed channels. VARL,
VAR2, and CONST can be pulsed.

For the other Classic Test such as1/V Sweep and I/V List Sweep, only one SMU can pulse while
another follows. VARL, VARY', VAR2, or CONST may be pulsed.
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Measurement Functions

Pulse Setup Parameters

1. Using one pulse output channel
Pulse period

Voltage or current R
Measurement time

Peak value )
: Hold time 1/
Previous value { ———— !
Base value . ,E
Pulse width '
2. Using multiple pulse output channels
Pulse period

Voltage or current ; i
& Measurement delay time  Measurement time

I
Peak value Hold time
i
1
Previous value 4 ——
Base value I n

Delay time " Pulse width

> Time

When you select VPULSE or IPULSE on the Channel Setup screen, the Pulse button is available
for the Measurement Setup screen. Click the Pulse button to open the Pulse Setup dialog box,
and set the pulse setup parameters on the dialog box.

For the test which supports one SMU pulse, use the SMU Pulse area on the Measurement Setup
screen to set the pulse setup parameters.

Pulse period may be adjusted from 5 msto 5 sin 100 us steps. Pulse period is measured from the
base value to peak value transition, between two consecutive pulses.

Pulse width may be adjusted from 0.05 msto 2 sin 2 us steps for HCSMU or 0.5 msto 2sin 2
us steps for the other modules. Pulse width is measured between the transition from base value
to peak value and the transition from peak value to base value.
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Measurement Functions

Hints on Pulsing the HPSMU — B1500A

* Use the HPSMU or GNDU as the current return
path

* Use Kelvin connections (must use on GNDU)

* Use 16493L GNDU cable for the GNDU connection

Example for B1500A:

Sense PSMU 1.0 A

Force
HRSMU
or

MPSMU
Foree "CNDU  4.2A

Sense

The 1 A SMU (HPSMU) cannot use another MPSMU or HRSMU as the current return. It must
be used with the other HPSMU or the GNDU that can sink enough current. The GNDU isthe
unit that you can use without defining in the Channel Setup.

The GNDU can sink upto 4.2 A, and it isdesigned for the Kelvin connection. The force and
sense lines must be shorted near the DUT.

For the connection of the GNDU, do not use the normal triaxial cable. The GNDU israted for
up to 4.2 A, while the maximum current rating of the triaxial cableis1 A.
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Measurement Functions

Class Exercise
SMU Pulse Mode

« You will observe a MOS FET family of curves
« You will edit VAR from V mode to VPULSE mode
« You will learn how to properly define a "pulsed" algorithm

To Get Started:

« Use the next several pages as you guide
« Get the IDVD setup
« Follow the instructions on the following pages

Y ou will setup abasic MOS family of curves without VPULSE. Then change VAR to
VPULSE.
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Measurement Functions

CMU

@e®®

SMU4 -4 - ©@.@°

SMU3 o - ©.@
smu2 = - @.©-

SMU1

GNDU

B1500A Rear View

SMU Triax Connection
Force Lines to Fixture 1,2,3,4 Ports

16442 A/B Fixture

°

wo@ E:

*@.@-

Thisisthe SMU cable setup that will be used in the remainder of the class exercises.

Connect the cables between the B1500 and test fixture as follows.

SMU1: SMU1
SMU2 : SMU2
SMU3: SMUS3
SMU4 : SMU4
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Measurement Functions

Jumper Leads — MOS transistor

Sub

1: Substrate
2: Source

7 )]u.nnnnnnnnnnn 2 3: Gate

" 4: Drain

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with
force and sense, or six SMUs with force only. For this class example we will use the six (6)
SMU scheme. On older fixtures, this scheme is shown in light blue lettering. In newer fixtures,
this scheme is shown in white reverse background lettering.

4-9



Module 4
Measurement Functions

VPULSE
Data Display Window

(A) MARKER( 3.0000000000E+000 V  5.469S000000E-003 A ------ )

40 m

1d

5.00 m
Jdiv

0 vd (V) 500 m /div 5

Make a measurement to verify the setup is correct. Y ou should see the above family of curves.
The algorithm is defaulted to standard staircase sweep on VARL1 (no pulsed SMU).
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Measurement Functions

VPULSE
Channel Setup

Enter new name before save

@| 1/V Sweep Setup Name: |IDVD-Puse
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |
Channel Definition
Unit: V Name: I Name: Mode: Function:
c [smup wl|vsub =[lsub =V wljconsT  +|
 [sMuz:Hp wlvs =i m|common ~ffconsT  ~|
© |SMUB:HR =|lva =l =V x||var2 |
B ——
o [smMua:Hr ~][vd =1 | vPULSE “)|vAR1 |

Drain pulse

Switch VAR1 from V mode to VPULSE mode. A new panel will pop up on the Measurement

Setup.

Before saving this new setup, enter new name into the Setup Name field, then click the Save

button.
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Measurement Functions

VPULSE
Measurement Setup

Range and
ADC/Integ
are disabled

Maximum measurement value

[VARL VAR2 | SN
Unit: [SMU4:HR | EEER i N
This box pops up T
g o ly if VPULSE
Direction: |Sngle - onty 1 . :
Linear/Log: |LINEAR = or IPULSE is set Ad_d
start: 1V 0| 5 on Channel Setup. "7
Stop: |5V E|f5v |
Step: |50 mV B H| [SMU Pulse |
No of Step: [101 e ] Unit: [SMU4:HR i
Compliance: [100 mA 10 mA ] Period: |10 ms §
Pwr Comp: #iFF 8| JOFF | ‘Width: |1 ms B
Timing | Base: [0V []
¥ i
Hold: [0 ¢ / 8| petay: | B «gweep [CONTHUEATANY =] status
[Constants — J |
Unit: l V Name: I Name: Mode: Source: Compliance:
[smu:HP / 8][vsub ] [1sub =V Hov 8[100 ma W

Default pulse conditions for the Measurement Setup are shown here. The base is 0, and the pulse
duty cycleis 10 %. These settings are OK for this class exercise. Click the Single button to start

a pulsed sweep measurement.

Range and ADC/Integ buttons are disabled for pulsed measurement. The measurement range is
always the compliance range. And the integration time cannot be changed.

For example, if you change the Compliance value to 30 mA, the data beyond 30 mA cannot be

measured.
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Measurement Functions

I/V-t Sampling Measurement

Voltage or current

Starts sampling Time=Hold time +a  Time=Hold time + Interval + b
g g

Source . v
/ Channel 1 output ‘1] \_

Interval

4
_—

Time=0 (origin)
= : Measurement

Voltage or current l Hold Time

A

Measurement time
Bias hold time J .
Source - |.—. 1 ﬂ
Base _j_/ Channel 2 output

¢ . . Time
a, b : time from measurement start to integration start

B1500 supports the sampling measurement which performs the operation shown above.

With the SEQUENTIAL output sequence, the source channels start to force the Source value
sequentially. Then the last source channel forces the Base value, and forces the Source value
after the Bias hold time. After the Hold time, the measurement channels start measurement
sequentially, and repeat thisin the specified interval if the measurement channel is ready to
measure. After the last sampling measurement, the source channels stop output sequentially.

The order of source output is defined in the Channel Setup. Top of the channels on the setup
screen starts output first. And the following channels start output sequentially. After the
measurement, the source channels stop output sequentially in the opposite order.

With the SIMULTANEOUS output sequence, the source channels start to force the Base value
simultaneously. And the channels force the Source value after the Base hold time. After the
Hold time, the measurement channels start measurement sequentially, and repeat thisin the
specified interval if the measurement channel is ready to measure. After the last sampling
measurement, the source channels stop output simultaneously.

For the measurement channels which use the high resolution A/D converter, the order of
measurement is defined in the SMU Range Setup. Top of the channels on the setup screen starts
measurement first. And the following channels start measurement sequentially. For the
measurement channels which use the high speed ADC, the channels start measurement
simultaneously.

4-13



Module 4

Measurement Functions

I/V-t Sampling Measurement

« LINEAR
« Sampling interval: >=2 ms
0.1 ms to 1.99 ms (limited)
« Number of samples: 1 to 100001

« LOG
« Sampling interval: >=2 ms
« Number of samples: 1 + number of data for 11 decades
« Remaining data:
10/25/50/100/250/500 data are plotted into one decade
of the log scale in the same distance

There are two sampling mode. The linear sampling repeats the sampling in the specified interval
until the number of measurement data reaches the specified number of samples. High speed
sampling is available if the following conditions are satisfied. The high speed sampling

allows you to set the sampling interval 0.1 msto 1.99 msin 0.01 ms step.

1. Sampling mode isLINEAR
2. High speed ADC is used for al measurement channels
3. Interval >=0.08 ms + 0.02 x (number of measurement channels) ms

The log sampling repeats the sampling in the specified interval and gathers the measurement data
which can be plotted on the log scale in the same distance. The sampling will be stopped

when the number of measurement data reaches the specified number of samples.

4-14



Module 4
Measurement Functions

Class Exercise
Sampling Measurement

You will:
« Monitor the charging voltage of an RC circuit

« Learn LOG10 data interval
« Learn how to properly define a sampling algorithm

To Get Started:

« Use the instrument setup as same as the SMU pulse exercise
« Connect the RC components as shown in the next page

« Get and run the RC-sampling-log setup

« Change the range or ADC and perform append measurement
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Measurement Functions

Jumper Leads — Sampling Exercise

SMU4 X GNDU
6
FO ‘F@ F© FO ®
¢® [0@ [c@ | [s©
R EE
b O O s
CB) )) 0.5M
14 ‘ b
: 25: SMU2
20
[Pﬁ —I—O.luF
22: SMU4
0.sM 00000000DOD|
1 14

The 0.5 M ohm and 0.1 uF values were chosen because these values are readily available, and
they give a RC time constant suitable for observing 2 mstime steps.
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Measurement Functions

Sampling Exercise — LOG10, 2 ms interval
RC Measurement

W) MARKER( 1.0130000000E-002's 3.4150000000E-001V -—---)

z | X data

R R

——— 10 data
——~—— 10 data
= 10 data A~
Y data
200 m
[div
X+Y=20
0
im I Time (s) decade /div T 1k
I A
3 ms Sdecades 5004

The RC-sampling-log setup isfor the LOG10 sampling with 2 msinterval and 51 samples.

LOG10 sampling obtains 10 data in one decade. And the data will be plotted onthe log scalein
the same distance. However this rule cannot be kept at the beginning of sampling because of
long interval.

In this example, there are 10 datain each decade from 100 msto 10 s, and 20 datain the
remaining decades. Thefirst datawill be near zero second. Seethe List Display.
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Measurement Functions

. L -
Sampling Exercise — LOG10, 2 ms interval
[Gst Display Propertics..
Index | Time | v2| )
19 10 1.6674 Vv | )
20 126.13 ms 1.7874 V
21 158.14 ms 1.8764 V
2 200.13 ms 1.9385 V
23 25213 ms 1.8727 v
24 316.13 ms 1.9886 V } 10 data/decade
25 400.13 ms 1.8959 V
26 502.13 ms 1.8983 V
27 632.13 ms 1.5089 V
28 796.13 ms 1.9092v_ J
29 1.00213 s 1.9996 V | )
30 T.26213 TV
31 1.58813 s 1.9999 V
32 2.00013 s 2V
33 2.51813 5 2.0004 V
4 3.17013 s 2.0001 V } 10 data/decade
35 3.99013 s 2.0004 V
36 5.00413 ¢ 2.0001 V
37 6324135 2.0003 V
138 7962135 2 g 5
E& 10.02413 5 2.0002v]
) 12.62013 5 3.0003 V
41 15.88613 s 2.0002 V
42 20.00013 5 20002V
43 25.17813 5 2.0003 V
44 31.69813 s 2.0001 V } 10 data/decade
45 39.90613 5 20003V
46 50.23813 5 2.0002 V |
47 63.24613 5 2v
48 79.62213 s 2.0003Vv _J o
49 100.23813 5 2.0002 V v
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Measurement Functions

Sampling Exercise
Channel Setup

@|1/v-t Sampling Setup Name: |RC-ssmping-og
1‘:3:77 :l’-UEJ:l Measurement Setup | Function Setup | Auto Analysis Setup] Display Setuﬁ]
Chal Definition
add | oele | |
Unit: V Name: I Name: Mode:
[sMusHp vt =1 =V =
[sMuz:Hp v2 =2 =l =l
[sMu4HR lvs =3

=conmon ¥

4

Miscellaneous Variables

Time Stamp Name:(_|Time :a: ] Index Name: Q

Variable for time data
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Sampling Exercise

'SMU Range Setup

Measurement Setup s )
nit: 2 ode: : ha le: .
 [sMurHe H|n : g LE'\IT‘ED - ::L -JE:’Z:LLR»ZI’::: : =l : B

o [sMuzHp i

© [SMUSHR E||B3

[Fxep

LIITED ~ :«..-. = FIXED ral;ge _%

Qf I IV‘I‘. Sampling Setup :IIDDCmvmerﬁ Integration Time Setup I
Channel Setup (Mi §e€uj;| Function Se:upl A
Sa ing P Unit: Name: ADC:
oy B I [siurrp B [ kR ADC ~|
Linear/Log: [LOG10 ~l ][SMUZ:W’ ﬂ?z a_lus ADC B
SM4HR [l .
Interval: [2 ms § H[gh speed ADC
No of Samples: |51 B
Total Sampling Time: |158.866 s 8 T
Output Sequence: [SIMULTANEOUS ~ ode: Facha Ao Zaro:
Hotd i [0s 5 High Resolution ADC: [4UT0 +]f6 8o -]
= High Speed ADC: [#UTO =1 []
Base Hold Time: |0 s
Constants
Unit: V Name: I Name: Mode: iBase: Source: Compliance:
|sMU1:HP Bw =i =V g||o v ajzv Bioms @
SMU2:HP B|v2 12 1 H]jo A |0 A H|3V ]
[ i = =] 8| 8|

Use the FIXED range and the high speed A/D converter to get 2 msinterval.

Change the range to AUTO. Or change the ADC to the high resolution ADC. And perform
append measurement. Y ou may not get 2 msinterval at the beginning of sampling.
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Negative Hold Time
Available for Interval <2 ms

-90 ms =< Hold Time =<-0.1 ms, 0.1 ms step

MARKER( 05 5,0000000000E-003 V ===~

10

Vi

Bias starts at0s

1.00
[div

-5m Time (s) 2.00 m /div 15m

For the sampling measurement, the available hold time value is 0 to 655.35 s, in 10 ms step.

However, the negative hold time -90 msto -0.1 ms, in 0.1 ms step is also available for the high
speed sampling which the Interval islessthan 2 ms.

This measurement result example is obtained by the setup shown in the following pages.
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Jumper Leads — Negative Hold Time

¥ lo.sm 0000000000) %

14

28: SMU1

% 0.5M

25: SMU2
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Negative Hold Time
Channel and Measurement Setup

@ 1/v-t Sampling Setup Name: [R-sampneg-nod
Channel Setup | Measurement setup | Function Setup | Auto Analyss Setup | Display setup |

[Channel Definition
_l _I J
Unit: V Name: I Name:
c [mrHe =]V EI 4|{ I Current source
c [smuzHe ]2 =2 mconmon  +|
g'uv-t Sampling Setup Name: [R-samp-neg-hold
Channel setup Measurement Setwp | Function Setup | Auto Anayss Setup | Display Setup |
[Sampling Parameter |
Range
Linear/Log: |LINEAR
ADC/
_ Interval <2 ms g
No of Samples: |101 Ad-
Total Sampling Time: |20 ms [] winosd
Output Sequence: [SINULTANEOUS
m Negative Hold Time
Base Mold Time: [05 @]

Constants ]
Unit: V Name: 1 Name: Mode: Base: Source: Compliance:
[shurHe Ei wfir =i oA Hjowa @0y £l
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Measurement Functions

Auto Analysis

GM max

Hands-off marker

and line fitting

Early Voltage

Isub max

Vth

Auto analysis automates the task of doing scalar calculation on swept data. Computed
parameters such as Vth or GMmax can be displayed in the Parameters area on the Data Display
window. The built-in user functions allow data to be plotted and analyzed according to any
arbitrary formula. The B1500 has built-in functions such as axis intercepts, logs, regression
lines, area integration, max/min, and many more. The ability to automatically extract important
parameters such as threshold voltage without the need to manually manipulate screen cursors or
markers isimportant in process devel opment.
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Measurement Functions

Auto Analysis
Vth Example

X-Y Graph Plot Properties... | | |Parameters l
() MARKER( 1.3500000000E+000 V  2.8057007673E-002  8.0311895965E-002 ) VTH 1.00028 V
200m | //
Intercept: " intercept BETA E.45000E-003
-0.0803341 s -0.0321336
Gradient: .
8.031190€-002 1247¢
=
5
&
2
200m
[div
0 s Intercept: 1.00028 V
Z
0 vg (V) 500 m fdiv 5
List Display Properties... | |
Index_| vg | SQRT_Id | PEAK | ~
26 125V  20.1330573932... 77.3309160467...
27 1.3V 24.0848500099... 79.5395027933...
28 135V 28.0870076725... 80.3118959648... =

Here we see a full-featured example of auto analysis. GMmax and Vth are automatically
calculated each time a measurement ismade. Even if you alter the analysis, say by moving the
line, you can restore the original analysis by clicking the Apply button on the Auto Analysis

Setup screen.

IMPORTANT!

Please note that formulas for auto analysis are not hard coded into the B1500. Y ou define the
formulas, and so you can customize the method of performing the analysis.
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Measurement Functions

Vth Measurement
A Tedious Process Now Automated

« Plot square root of the drain current (SQRT Id)

« Plot rate of change of SQRT Id (PEAK)
« Find Peak Value of the PEAK plot

« Drop down to the SQRT Id plot

« Draw a tangent line on the SQRT Id plot

« Read the X-intercept of the tangent line as Vth22

In the previous example of graphically determining Vth, the above steps were automated. There
are other definitions of Vth which are less complex, but now you don't have to worry about
complexity. The B1500 can perform the process without you having to interact with the screen.

Not only automation removes human error, but also it allows computer controlled analysis to
proceed without interruption.
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Measurement Functions

Class Exercise
Auto Analysis

You will:

« Make a MOS threshold voltage (Vth) measurement

« Observe how parameters for the analysis are defined

« Observe how the user functions and analysis functions are
used in the analysis

To Get Started:

« Use the standard MOS device and pin connections
« Get the GMMAX setup

« Make a measurement and turn the knob

« Click the Apply button to restore the analysis

In this exercise you will observe how auto analysis works. Y ou will understand each setup
screen required to implement an auto analysis process.
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Vth Measurement
Damaged MOS FET Device?

Good BAD
Continuous Curve Broken-Lumpy Curve
No Static Damage Severe Static Damage

The class exercise uses a packaged MOS FET device which is very susceptible to static damage.
If the device has been handled or moved in and out of the socket afew times, you may see a
BAD response as indicated above. Replace the device with a new one.

At the wafer level, you can have the same problems. Putting a charged probe with cables
attached down on a gate junction can weaken or destroy the device. Also, the B1500 offset
cancel (zero cancel) sends signals down to the probes. These voltages can damage a sensitive
gate junction.
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Vth Measurement
Channel and Measurement Setup

VARL
— | [odes| [ 05| Loow]
Unit: [SMUS:HR - Unit: V Name: I Name: Mode: Function:
Name: |Vg = | ~ [snoree =|[vsus = [1sub =y ~|lconsT  +]
Diectolblisnoe H o [smuzHe =]lvs [l =[common ~|[consT =
Linear/Log: |LINEAR ad
sacfov &®| © [stu3:HR =]lva =l =V ~|[vart =
stop: [5 v 8| -~ [sMuamR =va w1 v ~fconst +]
Step: §50 mv L]
No of Step: |101 ]
Compliance: 100 mA ]
Pwr Comp: |OFF ]
Timing |
Hold: [0 < B| Dpelay: [05 Bl - sweep [CONTHUEATANY =] status
|
Unit: V Name: I Name: Mode: Source: Compliance:
|smu1:HP 8||vsub = [lsub =V Bljov 8][100 mA [
|SMu4:HR B||vd o [1d = Blf2v 8|[100 ma ]l

Nothing new here. Thisdlideisincluded for completeness. Y ou will notice that these variables
are heavily used on the Function Setup screen.
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Vth Measurement
Function Setup

User Function
Add | |
Name: Unit: Definition:
 [serT_id | ~][sare(18) O
o [pEak | [df(SQRT_1d,vg) ]|
Analysis Function
Add | |
Name: Unit: Definition:
o vm o =y ~|[eLix 8
c [eeTa = ~|leuie2 |

Here are definitions for the Y 1-axis plot (SQRT_ID) and the Y 2-axis plot (PEAK).

@L1X means the X-axis intercept of LINE 1.

@L1G"2 means the squared gradient value of LINE 1. Inthiscase, itisjust calculating line 1
dlope. It issguared to account for the fact that the Y 1-axis is a square root.

Click Help > Keysight EasyEXPERT Help to open the online help. And visit the Read Out
Functions page for all of these functions.
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Vth Measurement
Display Setup Page
X-Y Graph
atd | [ooete| 0| I
Name: Scale: Min: Max:
Fox: [vg =] [tnear =] fov 8 [sv I
€ vi: [SQRT_H =] [unear =l 8] Jo2 ]
cova o [PEAK =] [tnear ER0 ] [o08 O
List Display [Parameters
add_| | I add_| | |
c W H e 4
c [eRTe ] T |
o

VTH and BETA are values which will be displayed at the Parameters area on the Data Display
window.

These variables are defined in the Function Setup screen.
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Auto Analysis

Analysis Setup Page

Line 1
W Enable Type Axds
 Normal ¢ Gradient & Tangent ( Regression vi
First Point
€ X-Y Coordinate @ Data Condition
Condition: [PEAK  m = [max(PEAK) = [ After | ==
Second Point
& X-Y Coordinate ¢* Data Condition
X = Y: |
Line 2
I~ Enable [ TYP® s
@ Normal ¢ Gradient ¢ Tangent ¢ Regression ot
First Point
& X-Y Coordinate " Data Condition
L | = vi |
Second Point
& X-Y Coordinate ¢ Data Condition
X: | 5 Yz [
|Marker
¥ Enable
Condition: [PEAK = = [max(PEAK) = [ After o = |

This screen is the heart of auto analysis. Y ou define custom procedures for graphical analysis

with fill-in-the-blank ease.

(End of This Class Exercise)
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SMU Filter

H Filter OFF &
| o Force
: |vapac — —L\N‘O
] —O0
: Filter ON Series Resistor
SMU (I Mohm) | Sense
i ‘ (V or I mode)

—_—

Time
Filter setting

The filter is mounted on each SMU. It assures clean source output with no spikes or
overshooting. However, using afilter may increase the SMU settling time. 1f measurement
speed istop priority, set the SMU Filter OFF.
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SMU Filter

Range

ADC/
Integ

@|1/v Sweep Setup Name: [IV-res
Channel Setup Imlwnctm Setup [ Auto Analysis Setup I Display Setup ]
Jvars [
Advanced Setup
Channel Settings
Unit: VName: IName: Series R: SMU Filter:
[smuazee 8fve | [ none jlon :I
[stuz:p 2 =R [ nonE [on C |

SMU Filter: ON (add filter)
or OFF (no filter)

Ad-
vanced

Bias Hold after Measurement: | OFF Ml

Output Value after Measurement: | START v

|wait Time Control
Factor:
ouputwait: |1 8|
After Measurement Settings
H Compliance:

To change the SMU filter setup, open the Advanced Setup window by clicking the Advanced
button on the Measurement Setup screen. And specify ON or OFF by using the SMU Filter pull

down menu.

In the power on state, the Classic Test setsthe SMU Filter to ON.
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Standby Function
Vlaa
force V
SMU1 Idle state Idle state
1 1
1 ]
1 [}
1 I
1 1
1 1
V2. . -
SMU?2 | forceV |
Standby ON 1 H
! i i -
\ 1 ] f
1 ! 1 1
1 | I 1
1 1 1 1
1 1 ] [l
V3o l 1 '
i | forceV | i
SMU3 —— T standby OFF L
1 I
Idle state i Standby state | | Standby state E Idle state
; Measurement state '

Standby function sets any SMUs (except HRSMU with ASU) to specific output values and
compliances before starting or after stopping measurement. Standby function is useful for power
supplies of complicated device (eg. Smart TEG), defect analysis, and so on.

This slide shows the standby and measurement operation in the following setup. This example
assumes that the channel setup is defined in the Standby Channel Definition as followsin the
order, and the output value in the standby state is the same as the output value in the

measurement state.

*SMU1: Voltage source, non-standby chan
*SMU2: Voltage Source, standby channel
*SMU3: Voltage Source, standby channel

nel
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To Use Standby Function
E ©|1d-vg Setup Name: [1275 -
214 # |Device Parameters
v QHoS __
Direct Corol Polarity: [tich O} 1g: [100om 9] wg: [10.0 0
Dl Temp: [0 ce; @ IMax: 10074 W
Hemory |'Standby Channel Definition
MexedSignal v
Ubrary  -|[Test
B et standtry channel cutputto: [ (1) Standby ON R
Vg » 'd
[Standby Channel Definition Cv-1MHz
I Lo | Lo i &
-Vg(3] Sandby:  UmIt Mode: Source: ‘Compliance: b
L pamad |© F o [smunee =lv =RV Bioma 8]
‘ e r[swess =l oV ] (| ‘
P Gat —
Vg pulse c r[sswe =V =lov ] FCEC | s
Ve | [ =l[v =lpv O | 2
' vgstof | r[swshs =V =lov ] | -‘
10V 3
W:ué] VgSted ?‘ GUMMEL
Vth gmMax
~ DVO-Puse
ol | —
Trng Idvd vth |
Trng Idvd Vth 4/16/2007 2:51:05PM 4
Trng Idvd Vth 4/16/2007 2:50:08 PM 3
Trng Idvd Vth 4/16/2007 2:49:18PM 2
Trng IdVd Vth 4/16/2007 2:44:11PM 1
Trg Vth 4/16/2007 2:43:10PM 1 v
Do s zeoor [l Aso EoortOFF 3] At Recard O

Click the Standby Channel Definition button to open the Standby Channel Definition window.
Define Standby channels (Unit, Mode, Source, and Compliance).
Click the Standby ON button to set standby channel outputs. The Standby indicator will change

from OFF to ON.
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Bias Hold After Measurement

End of Single measurement
or
Start of next measurement

Bias Hold ON -

I Source or Base value for Sampling

CONST | L s s, 5 it B i o T 5

VAR2 ‘_’_, Stop value

Bias Hold OFF
CONST kil

VAR1/VART1’/CMU [ ‘ I | f | |J oV
VAR2 ‘_I_’_ oV

Bias hold function keeps bias output after a measurement is made. For instance, the user may
need to keep one or more SMUs on between measurements to bias up a Ve pin of an IC.
Without this function, auser is forced to connect an external power supply. Now there isno
need for extra supplies.

When this function is ON, the source channels apply the following value.

Constant source: Base value or Source value (1/V-t sampling)

Constant source: Source value (1/V Sweep or C-V Sweep)

VAR1/VARL' source: Start value or Stop value (I/V Sweep)

VAR?2 source: Stop value (I/V Sweep)

CMU: Start value or Stop value
(C-V Sweep)
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Class Exercise
Bias Hold Function

You will:

« Perform Repeat Measurement

« Measure the LED I-V characteristics

« Monitor LED during Repeat Measurement

To Get Started:

« Use the connection as same as the SMU pulse exercise
« Add an LED and jumper leads per following pages
« Get the LED setup
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Jumper Leads — Bias Hold Exercise
GNDU
6
r O O 5©
¢O© s©
o O
5 6
QO O
11 12 '
7 18 13 14
o O
1 2 3 3 '58
© © % [00000000000000] %
VMU 27 D 28 ‘
i 2 * 1000000000000
@ @ : 7 Shorter Lead

Connect test leads as shown. And add the LED between terminals 13 and 14 of the 28-pin dual
in line socket.
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Bias Hold Exercise
Channel and Measurement Setup

O] 1/v Sweep Setup Name: [LED
(G 3] Measuremant Setup | Function Setun | Auto Analyss Setup | Display Setun | T = 5
iniGon B IR [u‘“'d Setup l
Unit: SMU l F_unction to VARI J ﬂ,ﬁ Unit: VName: IName:  Series Rt SMU Filter:
o [ =] = v T T B =n =frione ~|fon El
- [EEE = = = Sl [eruzae wjfw [ i[one =ljon =l
Channel Setun ‘{lijs;?inﬁii'éé&;i‘{mmr Setup | Auto Analyss Setup | Display Setup |
[VART
unit: [SUTHP ] _"
Name: [\ - m g ]
Direction: [5n) - i
Linear/Log: Factor:
|55 outputwait: 1 &
Vh=0to 2.5V messurementwait: T EJ
o er— i ]
No of Step: [101 ] _
Compliance: m Rias Hold after Measures
Pwrcomp:[oFE &) Output Value after Meas: 1
[ : S - | Bias Hold to ON
Hold: [0 5 E| Delay: [0s ] B [conmowe aTany =]
o - S - Output Value to STOP
Unit: V Name: T Name: Mode: Source: Compliance:
SMUZHP Hjfa =i v alpv W][100 A |

Set the SMU1 Function to VAR1. The VAR1 output 0to 2.5V isenough to light the LED.

Set the Bias Hold after Measurement field to ON to enable the bias hold function. And set the
Output Value after Measurement field to STOP. This setup keeps 2.5 V output between sweep

measurements. So the LED can light between the measurements.
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Bias Hold Exercise Repeat butfon
Repeat Measurement Setup l

Repmt I’h-omdll'es

Start Procedure:

I ,d Browse...
Arguments: | =

Iteration Procedure:

| = Browse... |
Argumenm:| -

Final Procedure:

I = Bowse.. Repeats three times
Arguments: | El

¥ Automatically fill in Device ID

/

/
/
I” Enable Thermo-trigger N1265A Thermo-triggeaList... l
Repeat Condition .
__ | Run Click Run to start
Stop repeating by:
[¥ Counter reaching

Com— Abort measurement
¥ Reset counter befose repeating
Cancel I

¥ Procedure return condition

Click Repeat button to open this window which is used to set and run the repeat measurement.

This example performs the LED 1-V sweep measurement three times and then finishes the repeat
measurement.
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Bias Hold Exercise

LED lights on
(A) ——
100 m

Ih

10.0m
Jdiv

0 Vvh (V) 500 m /div 5

~—

LED lights off

During the measurement, leave the fixture lid open. And monitor the LED. This measurement
does not force dangerous voltage.

At the start of measurement, LED lights off. Beyond the threshold voltage, the LED lights on.
After the measurement, the LED keeps lighting until start of the next sweep measurement. And
this cycle isrepeated until the end of the repeat measurement. After the repeat measurement, the
LED lights off.
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Module 5
Modifying Application Test Definitions

In This Module

* To Open Application Test Definition

* To Modify Test Definition

* To Use Debug Tools

* To Use Built-in Functions

*+ To Add Data Display

* To Use Auto Analysis

* To Use Test Setup Internal Variables

* To Use Auto Analysis twice (as Class Exercise)

* To Use Vector Data (as Class Exercise)
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Module 5
Modifying Application Test Definitions

Modification Overview

Open an application test definition to be modified
Open test definition editor

Save the definition as your test definition

Modify the definition as you like

Resave and close the definition

S L

Export your test definition as your backup

This module explains the modification example using the Vth Const 1d test definition. After the
modification, the new definition can perform the Vth Const Id measurement, display the 1d-Vg
curve, and additionally display the gm-Vg curve.
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To Open an Application Test Definition

Example: Select Vth Const Id as template

Category__~| @) Vth Const 1d Setup Name: [V Const 12 - |
& ~ [Device Parameters
v CHOS _] |
Dire<t Contd Polarity: [iich Ol Lg: [100 nm wg: [100um N
st Temp: Z50ce0 W ldMax: [[00m &
Memory
MixedSignal v
Ubrary - |[Test Extended -
H
©-vgl3) »
Drain: [SMU4HR =
>
. IntegTime: [MEDIUM  ~ vd: 200V 8 ;
1d-Vg puise 1dovth: [1.0606-(vigiLg) & - 6

Kvg Gate: [SHUIHR = Subs: |SMULHP = —
pulse(3] vgstart: [s00mv W] % > vsubs: [0V ]
. vgstop: 200V B e «

Vith gmMax vostep: [fo0 v 1]

5 } Source: [SMUSHE ~
7th Const i %
) —_—
T

Click atest definition in Library list area, and click Select button to open the test definition.
For example, open VVth Const Id.
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To Open Test Definition Editor

Click Library>Open Definition of This Test...

Category -| g Vth Const Id Setup Name: |Vt Const o - ]
T ~ |Device Parameters |
v CHOS
Direct Cont Polarity: ic: ) Lg: [100 om wg: [1000n W)
::‘:::: Temp: m IdMax: [10.0 mA ]
Memory
MixedSignal v

=, y— S

Open Definition of This Test...
I6-vgl3] Delcte Definition of This Test ”»
[ J Drain: [SMU4HR =
b
o |&

Import Test Definition...

. Export Test Definition...
> T — | % vd: [2.00 V
1d-Vg puise 1dovth: [1.0506-(vigiLg) § - .

vy Gate: [SHUTHR <] N é subs: U1 ~]  |—
puise(3] vgstart: [s00mv W] |1 : Vsubs: [0V (]

. vgstop: 200V B & «
bl vostep: [0 8] 3
s i| Source: [SMUSHE « C

h Const 38

Click Library and select Open Definition of This Test... to open the test definition editor.

The following pages show the modification example to display the gm-V g curve given by the
Vth Const Id test result.
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-

To Save Definition As Your Definition

Save the definition as your definition (ex: Trng vth)

T ®E<)
=)
ile_JHel, Mu!ﬁsd
Save Ctrl+S) [Test Output i
Close
Unselected:
Category: [Exercie [,
BIT ~
Test Name: [0 = cHos
————— Drrect Contrl UC
new test name OEEETG fowe. | dear| | o )
[Device Parameters Definiion Hemary new category
Add HanoTech
Name: Default: Description: HETI 7
= - pulsed IV
c [poBray =i “B]fe the spechied vale) or peh (shUs forg PuDevice
06 > Q5-CV
e o =100 ] [Gax febity
e [we wie.0um ~][Gate vt Structure
TFT %)
e [remo =[50 deg 1][Temperature
- T ey = Iser Defined
SRR
Background: [CProgram Fiss|Aglent 81500 Ess/EPERTIG: Browse...| Clear
Name: Type: Default: Description:
¢ [mtegTme  ml[stng <][MEDIM ~][integraton tme OK Cancel
e [HocTme  m[tumeic =[5 ][0 tme B B i || | | LIk
C [peayTme  mlliumene =|fos 8][Dely tme o P ] [] il
e feeven  mfumenc  <|[1.06-08"(vg/Lgy W [oren current to decde the Vi = wfoo @hzo §)ize &r
© porwnrag m[stma  w][inA l[rmum range for the dran current messreme ] ] Ol
& Pomd  m[lumeic  |[tomw "] [Power compiance of ran temina o Flo we wke 8- -

Test Definition editor

Create anew Category (ex. Exercise), and change the Test Name (ex. Trng Vth).

After changing the test name, save the test definition. Saving the definition will change the
window title to the new test name. Window title will be changed from Vth Const Id to Trng Vth

in this example.

In this example, the Trng Vth definition belongs to the Exercise category only.
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Modifying Application Test Definitions

To Modify Test Definition

Change default values and add parameters (ex: Pcomp_d)

[@Tmgvn mEx
[ File Help
Tes 55

[wal| [oee| Dom| [owm] This area sets the
properties of the

specified parameter.

= *Min
M *Max
*Digi
Background: |C:\Program Fles\Agient\B1500\EasyEXPERT\G Browse...| Clear Add s ™ .R g tls t‘
Name: Type: Defautt: Description: Align: X: v: width:  Ext: ¢solution

€ [incegTme  mi[stng ~jmeomn =]fincegration tme = @0 0 @0 Er- A 'Ullit
et mfe W O e o “Typical Values
e Hpre O +Symbols
- [0 T E B T R ym
N T e e W e [
A T Rl owe comobnes ofdan e = e o e s “F

Test Definition editor

On the Test Specification tab screen, you can add new parameters or change parameter settings.

This example changes the default value of the Module parameters for the MOS FET class exercise typical
setup and adds the Pcomp_d test parameter (drain terminal power compliance).

The Module parameter default values are changed as follows. See the actual settings on the test definition
editor.

Drain: SMU4

Gate: SMU3

Source: SMU2

Subs: SMU1

The Pcomp_d parameter is defined as follows.

Name=Pcomp_d, Type=Numeric, Default=1 mW, Description=Power compliance for drain terminal,
Align=check, X=550, Y =120, Width=80, Ext=uncheck

Properties: Min=1 mW, Max=20 mW, Digits=4, Resolution=1 mW, Unit=W

For Align, X, Y, and Width values, consult the settings of the other parameters for the same termina (ex.
Drain). For example, Pcomp_d must be located between Vd and Subs entry fiel ds (see application test
screen on the main window). So X and Width should be the same as the settings of Vd, and Y should be
between 90 and 180 (see the actual settings of Vd and Subs on the test definition editor).

Typica Vaues... button opens a dialog box used to define the typical values used for the selections of the
parameter value in the Application Test mode. For example, set 2 mwW to 20 mW in 2 mW step for
Pcomp_d.

Symbols... button opens a dialog box used to map a numeric value to astring. For example, Vaue=1 and
Symbol=ON are set, typing ON enters 1, and typing 1 enters ON. The value must satisfy the Min, Max,
Digits, and Resolution settings. The value and the symbol must be one by one. The definitionis effective
only for the parameter.
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To Modify Test Definition

Change or set test parameters (ex: Pcomp_d)

[@Trngvin B

File Help
En O ® H & A
-

BLOCK LooP 0R ASSIGH  COMMENT  END ERROR

Program Component [ Appication Test | Analysis | Cassic Test | Mscelaneous| My Favortte Setup

5 @|1/V Sweep Setup Name: [V Const 16 =
B Delete || Channel Setup Measurement Setup | Function Setwp | Auto Analysis Setwp | Dsplay Setu |
— Selection
H [VART
Range
& unit: [SM0i=Gaze 8] ”
2 o Name: [Voste = o
Direction: [570% e Integ
Local Variables Defimi =~ 5 - ad
2 |LINEAI v
BLOCK Linear/Log: [LIIEAR s
ek Start: [VgStanPoarty W
IFY nregry i Stop: [Vostoo Pokrty W
AdcFacto Step: [Vosten-Poary W
ELSE IF IntegTime="M
Rrie No of step: [izil ]
IntegMode = "PLC P

AdcFactor = 1 Compliance: [loLm= §
ELSE IF IntegTime="L _

IntegMode = "PLC" DT CUme:

AdcFactor = 16 Timing

END IF
prrasv 5| oetay:[oearTme B« sweep [CNTHEATANY 7] status

) IV _Sweep **+
Vth Const Id

Unit: V Name: I Name: Mode: Source: Compliance:
[sMU=source  W][veource  m[isource [ T H|[vepoamy  W][iaMax [
[iUz=Dran  &]|varan " [idran =V B|[Vaoary  ][taax |

[sHu:=subs Wl[Veubs i f1subs v l[Vsubs™Pobrty ilisubsims Wl v

Test Definition editor

On the Test Contents tab screen, you can change the test execution flow (program flow),
measurement conditions, display setup, and so on.

To add the Pcomp_d parameter to the measurement setup, click the Vth Const Id line in the

program list. Andinthel/V Sweep setup editor, display the Measurement Setup tab screen.
And enter Pcomp_d to the Pwr Comp entry field.
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Modifying Application Test Definitions

To Modify Test Definition

Change display setup and define external variables

© Trng Vth Lokd
File Help

BE h O ® g A

BLOCK F LOOP FOR ASSIGN  COMMENT  END ERROR

External variables must

b 5
P @] 17V Sweep Setup Name: [vth Corst 18 =| be defined before making
bt s:’:{“:‘m Delete || Channel setup | Mazsurament Setup | Functon Setup | Auto Analss Setup Doy Secwp | the matching table.
F I Assign to extemal variables... ‘
8 X-Y Graph !
T copy at i Irxum.l Variable
ame: Scale: Min: [variable ‘
E X Vgate =] [tnear =] [resarpourd
< | | | |
5 et (% =] [trear =l [ External variable: Measurement data:
= [oo =] Esrea Lo [ven_constid =l [ven E |
[r_’ﬁ_ﬂ_éa:a =] [gm S |
= | ) Bl [Voate B |
add | [0 [ o =l [t6ran |
[Vgate - o (ol (T
o |[Foures 5 External variable
rrr— Test setup internal variable
. ;
Test Definition editor

On the Display Setup tab screen, you can change the graph scale Min/Max values or add/delete
the list parameters.

This example makes the matching table between the External variables and the Measurement
data. The measurement data can be referred outside the test setup via the external variable.

Where, the measurement data means the variables used in the test setup. And the external
variables means the parameters defined in the Test Specification, the Local Variable Definition,
or the Test Output’s Analysis Parameter Definition.

This example sets the matching table as follows.
Vth_constld external variable: Vth internal variable
GM_data external variable: gm internal variable
VG_data externa variable: Vgate internal variable
ID_data external variable: Idrain internal variable

External variables must be defined before making the matching table. In this example, the
variables are defined in the Analysis Parameter Definition. See the next page.
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Modifying Application Test Definitions

To Modify Test Definition

Define Test Output and Analysis Parameters

3 x|

Define Analysis Parameters...

® Trog Vth -
| File Help
v own aras

Name: ‘Scale: in: :
F x [ve_da | [tnear =] [vosta=poarzy @] [voStop=Pof

© v [ =] [trear =] [o& 8] [iaMax™Poar)
© v [oM_cera | [tnear =] fos 1] [loms

Test Definition editor

This example defines the Test Output and the Analysis Parameters.

1. Display the Test Output screen.

2. Check the Define own Output Parameters.

3. Click the Define Analysis Parameters button.

4. Define the analysis parameters (ex. GM_data, VG_data, ID_data, and VVth_constiD).
5. Define the X-Y Graph, List Display, and Parameters.

Note

External variables must be defined before making the matching table shown in the previous
page. In this example, the following parameters can be the external variables.

Parameters defined in the Test Specification

Variables defined in the Local Variable Definition

Variables defined in the Analysis Parameter Definition (this example€)

Note

If thistest definition is used in the other test definition, the analysis parameters can be referred
outside thistest definition. This means that the analysis parameters can be the Measurement data
in the External Variable Setup as shown in the previous page.
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To Modify Test Definition

Add local variable (ex: Yes for Message box)

File Help
Tos: Saschicaton [ TEE L] .e

©Teng Vih B

EH ' O ® M O © A

BLOCK  ONERROR  FINALLY F LOOP FOR ASSIGN  COMMENT  END ERROR

Program Component [ADplication Test | Analyss| Cassi Test] Miscelneous] Wy Favorts Setup

& ||[Local Variables Definition statement.
Run Add Numeric | Add Vector | Add Sting | Add Module
g Variable Vanable Variable Vaniable
i B '
T Break Name: [Integiose m value: [PLC m Description: [Varabs for ntegraton mace

Local Variables Defini |
BIOTR
P I on T
IF IntegTime="SHORT" Numeric Variable
IntegMode = "MANUA e H T picm: [Dorreome. ]
e CRE e Name: ves = value: [0 8| Description: [User ressonse
ELSE IF IntegTime="M
IntegMode = “"PLC™ = o = e
AdcFactor = 1 Variable Yes is used in

ELSE IF IntegTii

Value: [1 W] Description: [Varabie for ADC facter

IntegMode = "PLC” the message box.
AdcFacteor = 16
END IF

** I-V Sweep ***

LJL

Test Definition editor

Click Local Variables Definition line to display the local variable |

ist. And define variables.

This example defines Y es variable as follows. Thisvariable isused in amessage box. Seethe

next page.
Name=Y es, Vaue=0, Description=User response
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. . .
To Modify Test Definition
Define Message box
: BEx .
‘.F,;"::,"p CEE This message box
"W““WW‘- asks you clicking the
B U E = OK button to display
GFIB VO Message C;Lrl(fs::: DT:‘::::F the gm curve
Frogam Component] Appcston Tes] ] Come To aceloneous [ Fovorts Semud
i =
§ This setup displays the message
(e “To display the gm curve, click OK.”
Zocal varianies perin: o|| ON the message box.
ED?EK * Integration T
IF IntegTime="SH
IntegMode
Adci‘ac‘:o: .
R i3 e This setup makes the OK button on
B18e 15 fntest the message box.
;dca‘ac:cr = 16 UseriRacponce J
END IF i Label: Selected:
s constaa sutont ¥ ] g The value of the local
- variable Yes is set to 1
|| :xi from 0 by clicking the
. | o OK button.
Test Definition editor

Click the Message line in the program list. And define the message box.

This example defines the message box that opens after the VVth Const |d measurement and
displays a message and the OK button.

1. Enter the message.

2. Enter the button name.

3. Select the variable used to keep the status of the button.
4. Repeat 2 and 3 for al buttons you want to add.
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Modifying Application Test Definitions

To Modify Test Definition

Example: Displaying Message box

® Vth Const Id - Keysight EasyEXPERT =08
File Edit View Marker Cursor Line Window Help
== ¢ = s =8 S [ T = =]
BREEEbQQS@-BoaREenE-FA-EEHCl
SetupName:  Vth Const Id x
%-¥ Graph Plot Properties... [Parameters |
cursoa(
(A) Vth 1.10910 v
1m
| @ Hhessage B
& To display the gm curve, click OK.
5
b1
1.00m
i T
<500 m Vgate (V) 200 m/dv 2
[Ustoisplay Properties...
Index | Vgate | Vsource | Viran | Wsubs | drain | gm &
1 500 mv ov 2V ov 23304 -165.28 05
2 asomv 0 2y 0 5934 0 46.87 95 [
<] 2 |

In this modification example, the message box opens after the Vth Const |d measurement is
completed. This message box asks you clicking the OK button to display the gm curve.
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Class Exercise

Perform the following modification example.
1. Open 1Id-Vd test definition.

2. Modify it as follows.
If Yes is clicked after Id-Vd test, move marker and
tangent line to Vdrain=1 point.
If Yes is clicked, perform Vth gmMax test.

Use the debug tools.

.

Save the definition as a new one (ex. Trng IdVd Vth).

Perform the test.

=Y T NV

Export the new definition, and import it.

1. Add the Yesvariable to the Local Variable Definition.

2. Insert the following lines between the lines Id-Vd and END BLOCK.
Message
IFYes=1
Auto Analysis
END IF
Message
IFYes=1
Vth gmMax
END IF

3. Define the first message box.

Message: Do you perform auto analysis?
Buttonl Label: Yes, Selected: Yes
Button 2 Label: No, Selected: (blank)

4, Define the second message box.

Message: Do you perform Vth gmMax test?
Buttonl Label: Yes, Selected: Yes

Button 2 Label: No, Selected: (blank)

5. Define the I F statements.
Condition Expression: Yes=1

6. Definethe Auto Analysis.
Line 1. Enable, Tangent, Axis: Y1, Data Condition: Vdrain=1
Marker: Enable, Condition: Vdrain=1

7. Changethe Vth gmMax test parameters as follows.
Drain: Drain
Gate: Gate
Source: Source
Subs: Subs
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Module 5
Modifying Application Test Definitions

To Use Debug Tools

Test Spechicacon Tast Contants | Test Ovtout |

ReturnPort = SMU1

Break point ReturnCh = OUT1

Variable Inspector

This slide shows an example of using the Variable Inspector for debugging. Confirm whether
the correct values are passed to the variables properly.

Set the break point, and click the Run button. After the program is paused, click the Inspect
button. The Variable Inspector isdisplayed. You can check the values by using the variable

display fields. Thefield can be displayed by using the Add XXX X Variable button. XXXX will
be Numeric, Vector, String, or Module.
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Module 5
Modifying Application Test Definitions

To Use Debug Tools

Test Spectication Test Contents | Test Outoue |

B- b ® 1 O ® B O & A

BLOCK  ONERROR  FINALLY F LooF FOR ASSIGN  COMMENT  END ERROR

s Test ] Wscelaneous | My Favork Setws |

Local Variab.
BLOCK

END BLOCK Ld R“ n

*Abort N
Stop Pt i
*Break
*Inspect

The Debug tab menu provides the following buttons:

*Run button starts the debug (executes the test flow). During execution, the label changes to
Pause. Clicking Pause button pauses the execution, and changes the label to Run that is used to
continue the debug (execution).

«Abort button aborts the debug (execution).

*Step button executes the highlighted line of the test flow. Clicking the button repeatedly
continues the execution by aline.

*Break button sets/releases the break point. For the break point, this button rel eases the break
point from the highlighted line. Program execution will break at the break point automatically.

eInspect button is available when the debug (execution) is paused or broken. This button opens
the Variable Inspector used to monitor value of device parameters, test parameters, analysis
parameters, local variables, or system variables.
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Module 5
Modifying Application Test Definitions

To Use Debug Tools

Debug: Inspect button

| @Tmg idvd ievg B3]
File Help
Test Spaciication  Test Contents ‘ Test Qutput

Enmwr OB MOo A

BLOCK ELSE ELse LooP FOR ASSIGH  COMMENT  END ERROR

Program Component | Application Test | Analysss| Classic Test | Mscalaneous| My Favorite Setup |

H IF statement |
R G S ) [@Voriabie iapector )
b 1F || agdnumenc | add vector | addswing | add module
|} Vanable Vaniable Vanable Variable
Break. Inspect
Numeric Variable ]
Tocal Variables Definmi = e = valee: i 5
. BLOCK =1
Break point @ 5
\ Message
[ IF Yes=0
END
. END IF v
Paused point Idvg

The Variable Inspector is displayed by clicking the Inspect button after the program is paused,
and is used to monitor or change the value of the device parameters, test parameters, analysis
parameters, local variables, or system variables. For the vector variables, only data monitor is
available. The Variable Inspector provides the following buttons to add the variable monitor
area.

» Add Numeric Variable
» Add Vector Variable

* Add String Variable

* Add Module Variable

The following functions are available for the menu displayed by clicking the banner of the
variable monitor area.

*Up: This button shifts the variable monitor area upward.
*Down: This button shifts the variable monitor area downward.
*Remove: This button deletes the variable monitor area.
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Module 5

Modifying Application Test Definitions

To Resave and Close Your Test Definition

Close the definition editor, and overwrite your test definition

[umm BER)

fFile § Help
Save Ctri+S Feggontants] Test outout|
[Close |
Category: [Erercee Description: [ <anguagz00ten ang=1a > -
| 3 VEh Const I0: EBRVEN (.01.20) ==
Test Name: [Tmg Vi = -
_ HOSFETOI-VOREEMEL, BB LTLABRENT 418
Tcon: [C\Program Fies|Agient|B1500\Eas/EXPERTIG! Browse...| Clear | He. -
[Device Parameters Definition Dropertics
| | | S| o
Name: Default: Description: e
« [poBrey i “][re the speciad valie) or peh (Sl Force the negata Fad i “j Max: |20 m i
Confirm Test Definition Save & its: [+ ]
o w100 o &][Gate Lo B oo
Resolution: |1 ™ 8
o« |wg ! 10.0 um B||Gate widt) < Unit: ’ﬁ
Te =250 ce [Temperat
¢ |Temp [25.0 deg ] Tanpecs [ypical Values... | _symbols... |
p— Confirm Test efinition Overwrite a
Background: [CProgram Fies|Agient 81500 E3s/EXPE

Test defiuton: Timg v
Test categores: CMOS

| ) An appication test definition of the same name aiready exists.
‘ Y s
|

‘Name. ﬂn«pe: J‘Dehnlt: Do you want toreplace it?

c [ntegTme sting ~][meDIUM

¢ [HokiTme  mlftumenc  x][os Wffogtme ‘ =) e |
 [DeayTme  mlflumerc  ~|[0s W[oeay tme w F | o

c [eeveh mifuumenc  3][1.0E06"(wolLo) &[[oran curent to decde the vth = oo o &0 W[
 [ornknRng mllstng  ¥][inA ][ range for the dran curent measureme 11| B 3

@ [promod  miftumerc  <][10 mw “W][Power comolance of dran termina w w0 mho Eke mr

Test Definition editor

After you create your test definition, save the definition and close the Test Definition editor.

Click File > Close. Confirm Test Definition Save dialog box is opened. Click Y esto save your
test definition and continue the close operation. The Confirm Test Definition Overwrite dialog
box isopened. Click OK to overwrite your test definition.
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Modifying Application Test Definitions

To Export/Import Test Definition
Click Library>Export Test Definition or Import Test Definition
Category ~| @] vth Const 1d Setup Name: [Vt Const 12 -
[ ~ [Device Parameters 1
= g:f,w Polarity: [lch 0| Lg: [100 ~m nI Test Definition Import B%]
Discrete Lock in: [ 23 test_gefintion Ea R = = s
Exercise Temp: [25.0 ceg IdMax: [10.0 mA P -
Memory _\b =
MoedSignal v et
-l Ubrary ~llcancel Q
Define New Test... i
Open Definition of This Test... ]
1-vgl3) initi i g
Import Test Definition... 1 s
Xpol es IE ni lon:‘. \_‘ o wé’;‘v
id-Vg pulse 1d@vth: [1.0606-(vigiLg) B a o Q
. T tetintion oot lﬂﬁ&’
T Gate: [sHU3 MR + Sovein: [Sow Aeonin -mem 1
Ay ®c
- vgStop: 200V W Doty
VR vgstep: [0 §] E?.,
N A
o J ey
\th Const 1 6 ;
v 5
1y Compctar
b
MyliSuekc  Ferane

The test definition can be exported as the EasyEXPERT test definition file format or XML file
format. And the file can be imported to the EasyEXPERT later.
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Modifying Application Test Definitions

To Use Built-in Functions

Absolute value: abs(A)

Averaging: avg(A), mavg(A,B)

Data conversion: string(A), value(A)

Difference: delta(A)

Differentiation, integration:  diff(A,B), integ(A,B)

Exponent, logarithm: exp(A), Igt(A), log(A)

Maximum, minimum: max(A), min(A)

Reading data : getNumericData(A), getVectorData(A)

Square root: sqrt(A)

Trigonometric function: acos(A), asin(A) , atan(A), atan2(A,B),
cos(A), sin(A), tan(A)

The EasyEXPERT software provides the built-in functions to calculate the display data and
parameter or to get the test result data. The built-in functions can be used in the user function
and analysis function of the test setup, and in the test execution flow of the test contents.

The following functions are also available.

at(A,B), at(A,B,C), ceil(A), cond(A,B,C,D), diml1Size(A), dim2Size(A), floor(A), index(A,B),
isvalid(A), setDeviceld(A), storeAt(A,B,C,D), substring(A,B,C), swmToModule(A)

For details of the functions, see User’s Guide or online help.
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Modifying Application Test Definitions

To Use Built-in Functions

User function setup example

[@ Trng tavg Auto Ana B
ng ldvVg JES
Fie rep

Test Spechicaton Test Contents | Test Output

o 4
IVt GV Sweep
sampling

Program Component | Appication Test | Anavss] cassic Test !Nscenneaus
5 e ep Setup Name: [1dvg -
Selection | Insert Delete || channel setup | Measurement Se:uul Functon Setup IumY setup |
5 User Function
& oo ot Paste add g
Name:  Unit: Definition:

Local Variables Defini 2

BLOCK e fm s v][6#1d;vo) O]
feieass L o R e 0l
= £ = dif(10. Vi)
VG=getVectorData(Vg) s amMax = max(gm)
IF Yas=1l

VG = getvectorDa

ID=getVectorData(Id)
ID = getVectorDa
GM=getVectorData(gm) W G = getvectorda

VTH=getNumericData(Vth) s gecvect x| | | B

Y Rier 7 Name: Unit: Definition:
GM_MAX=getVectorData(gmMax) euo'se 0¥ P A 1
e BrocK
‘ | o

Thisisan user function setup example. This example uses the diff function to calculate gm
values and the max function to get the maximum gm value.

Also, the getVectorData and getNumericData functions are used in the test execution flow to get
the test result data.
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Modifying Application Test Definitions

To Use Read Out Functions

Marker index value: (@M1

X coordinate value: @MX, @CX

Y coordinate value: @MY, @MYn, @CY, @CYn
Regression line parameter: (@L1CO, @L2CO

Line slope: @L1G, @L.1Gn, @L2G. @L2Gn
Line X intercept: @L1X, @L2X

Line Y intercept: @L1Y, @L1Yn, @L2Y, @L2Yn
Intersection of lines: @IX, @lY, @IYn

n: integer. 1 to 8.

The EasyEXPERT software provides the read out functions to read the marker position, cursor
position, line slope, line intercept, and so on. The read out functions can be used in the analysis
function of the test setup.
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Modifying Application Test Definitions

© Trng IdVg Auto Ana

To Use Read Out Functions

Analysis function setup example

END IF
END IF
END BLOCK

c o wfv ~lfeux

Vth = @LIX

[l

=%
Fie Heb
Tost Spectication. Test Contents | Test Output |
da|o 4
PVt GV Sweep
Sampling
Program Component | Appikaten Tesz] Anass| cassi Test | |
e weep Setup Name: [1cVg -
lo
Y selection | Insert Delete || channel Setup | Messurement se:upschysem\
E User Function |
13 e I Lt W (]
Name: Unit: Definition:
Local Variables Defini =
s e fm =[5 sy |
Message o ml[s =]fraxtom O]
E iss=
*
Futo Analysis
Message
IF Yes=1l
VG = getVectorDa
ID = getVectorDa
&M = getVectorDa | |ASiysis FURCHOR
VTH = getNumeri
GM_MAX = getVect Add
Display, Vth and Name:  unit: Definition:
Auto Analysis

Thisisan analysis function setup example. This example uses the @L 1X function to get the X

intercept value of theline 1.
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Modifying Application Test Definitions

To Add Data Display

Analysis: Display Data Setup

© Trng 1dVg Auto Ana Lo
Fie reb

Test Specfication  Test Contents ]Te; output |

2 ]
Auto  [Display Data Pata Disploy
Analysis Setu) Control
Program Component | Applcation Tesy Analysi it
g Block [ e
|
| Selection it b |I Setup Name:  [Dspy, Vih and Tangent Lne C}
w
§ Coy cut Past | S
Py aste
o= EE| TR EE|
Measurement, Local Variables Defini = Mame: Scale: My (=
. BLOCK F ox: [v6 =] [unesr =] ovovester W] [iavo_vosteo M|
data display, and Message
data save | 2 c o [0 o [eer =R O Ol
(o T [T] =] [inesr =l 5] oo |
- [|Ostoisplay [Parameters
Data display BB [T 5iceiey ven 5ad] P T I— A O a—
KR 2% e 3 [ L |
END IF
END BLOCK e fen =]
: | o]

The test setup performs measurement, displays the test result, and stores the test result data to the
test record.

In addition to the default test result display, you can make additional data display by using the
Display Data Setup statement. The statement provides the user interface as same as the Display
Setup of the Classic Test or the Test Output of the test definition. The above example displays
the ID-VG/GM-VG curves, GM_MAX and VTH values, and tangent line by using the extra Data
Display and Auto Analysis function. See next slide.

Note:
This additional display data cannot be saved to the data record. However only the last display

data can be saved if the Test Output has not been set.
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Module 5
Modifying Application Test Definitions

To Add Data Display

Additional data display example

@ Display, Vth and Tangent Line - Keysight EasyEXPERT ==
Fie Edit View Marker Cursor Line Window Hep
T == | Y ' KR I [ o]
BEFEhaQX @ CRHREMEe E-FA-EE
Setup Name: |Display. Vth and Tangent Line
X-Y Graph Plot | Parameters ]
0 MARKER( 5 1 ) GM_MAX [5454 1
1m ——r 1 e
ntercs .
oy [297.854785478:
Gradient:
S50y
o]
100 u
[div i
/
0 _J/ Intercept: ~297.855m
-500 m VG () 200 m /div 2
[Gstpisplay
Index_| VG| o o | E
10 -50.00 m 135.640 u 520.62 u
11 0 162.420 u 540.8 u
12 50.00 m 189.720 u 545.4u v

Thisisatest result example displayed on the Data Display window.
The auto analysis setup for this example is shown in the next page.
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Modifying Application Test Definitions

To Use Auto Analysis Function

Analysis: Auto Analysis

® Trng 1dVg Auto Ana 8= %]
Fie veb
Tost Spectication. Test Contents | Test Output |
.
1o |
* Linel RG]
Auto Pisplay Data Data Display
2 Setwp  Control
.
[ ] L]ne 2 ‘ Program Component | Appication Tesc] Analyss ] Cassic Test| Micelaneous|
= = [ Interpolation Mode
W edon | nsert Delete  |[line 1
*  Marker H o [ “E =
i c. @ (s i i
a oy o Paste Normal Gradient Tangent Regression 1
— First Point
v © XY Coordinate  © Data Condtion
Local Variables Defini =
BLOCK Condition: |GM - = GH_MAX g ™ After g= i
Message Second Point
IF Yes=1 GM=GI\1_|\’|AXMM
< | = ¥: =
|Gnez
- " Type Axs
Enable @ Normal € Gradient " Tangent (" Regression 3
First Point
@ X-¥ Coordinate € Data Condition
pi ] = T =
d Point
@ X-Y Coordinate € Data Condition
<] = [ =
[Marker
|| enabie
= e - = -
i | Condinon [ o = I aer [ Rl =

The Auto Analysis statement is used to apply the automatic analysis function to the last test
result before this statement. When the test finishes, the function automatically draws lines, a

marker, or both on the X-Y Graph of the Data Display window. This statement provides the
same GUI asthe Auto Analysis setup in the Classic Test.

Y ou can set up two lines and one marker for the automatic analysis function by using the setup

editor.

Inthe Line 1 and Line 2 areas, you can set up the lines to be drawn.
In the Marker area, you can set up the marker.

This example draws the tangent line for the Y 1 data at the maximum GM point.
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Modifying Application Test Definitions

To Control Test Result Data Outputs

Analysis: Data Display Control
Test Specification  Test Contents ITest Oumuzl

[ | p— —

]

=)

Auto Analysis Display Data Data Display
Setup Control

Program Component | Application Test | Analysis || Classic Test | Miscelaneous | My Favorite Setup
Data Display: OFF/ON

Miscellaneous: Data Store Control
Test Specification  Test Contents I Test Outpntl
) & [ =

GPIB /O Message Command Data Store
Execution Control

Program Component | Applcation Test | Analyss | Classic Test | Miscelaneous | My Favorite Setup
Data Store: OFF/ON

By the default setting, the results of the tests defined in your test definition are displayed on the
Data Display window and are stored to the data record.

Y ou can control the data display of the tests by using the Data Display Control statement. Insert
the statement, and remove the check from the Enable Data Display box to disable the data

display.

Y ou can also control the data storage of the tests by using the Data Store Control statement.
Insert the statement, and remove the check from the Enable Creating Test Result Record box to
disable the data storage.

The functions cannot control the following data output. They are always enabled.
-Data output by the Test Output of the test definition
-Data output by the last test setup if the Test Output has not been set
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Modifying Application Test Definitions

To Use Test Setup Internal Variables

© Uniiied Jokd

From Display Setup screen
of Classic Test setup

Setup Nama: 12 =

g

External Variable Setup

© Unciied 5]
[

o Variable assignments
Delete
5. External variable: Measurement data:
i i B el =l
5 }f . sy Internal variable

«Local variable
*Device parameter
«Test parameter
*Analysis parameter

iose

: T, | L oo 8 External Variable Setup
From Application Test setup

Y ou may want to read the parameters/variables used in Classic Test setup or Application Test
setup defined in the Test Contents. Then use the External Variables Setup window used to make
amapping table between the test setup internal variables/parameters and the external variables
(local variables, device parameters, test parameters, or analysis parameters).

To open the External Variable Setup window from a classic test setup:
Specify the classic test.

«Click the Display Setup tab.

*Click the Assign to externa variables... button.

To open the External Variable Setup window from an application test setup:
Specify the application test.
*Click the Assign to externa variables... button.

Note: Application test internal parameter/variable to be connected to an external variable must
be the analysis parameter in its test definition. For the analysis parameter, see “To Define Test
Output” in Module 6.
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Modifying Application Test Definitions

To Use Test Setup Internal Variables
Setup example | Assign to external variables... |

: 3

External Variable Setup
Variable assignments
| = o e
External variable: Measurement data:
~ v =] [veh =
- I =
- [ 3 B =
r [eM_max ~| [omitax |
c B =l fi H

This example makes the mapping table between the test setup internal parameters and the
analysis parameters.

*Define VTH, GM_MAX, VG, ID, and GM as the analysis parameters.
*Set these analysis parameters to the display parameters.

*Open the External Variable Setup dialog box.

*Assign VTH to the internal parameter Vth.

*Assign VG to theinternal parameter Vg.

*Assign GM to the internal parameter gm.

*Assign GM_MAX to theinternal parameter gmMax.

*Assign ID to the internal parameter Id.

For the example definition, open the Trng idvd idvg2 definition stored in the ¥data folder on the
Manua CD. The Manual CD stores the example test setup and definition data used in this
manual.
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Modifying Application Test Definitions

To Use Test Setup Internal Variables
Result example

'© Trog idvd idvg? - Keysight EasyEXPERT o=
File Edit View Marker Cursor Line Window Help i
2o T =1k Y T = o] [
BEREERDEQQAXI@-HMEREsmEm-FA-EFlL]s
Setup Name: |1'|"ng idvd idvg2 X
X-Y Graph Plot Properties... [ |Parameters f
) s VTH 1.02606 V
im 1L.5m
GM_MAX 112100 mS
a 2
100 u
fdiv
0
-500 m V6 (V) 200m/dv 2
(73] [F— | (2
[tst Display Properties...
Index_| V6| | | o]
1 =500 mv 460 fA  -296.000000000...
2 480 mv -2.5 A -147.5 95
2 =480 ZHIR o 1703 v

Thisisaresult example of the test output setup shown in the previous pages.
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To Use Test Setup Internal Variables
Using built-in functions

Display parameters of
the last Data Display window

(NS~}

Local Variables Definition
BLOCK
IdVg < Test setup
VG = getVectorData(“Vg”)
ID = getVectorData(“Id”)
GM = getVectorData(‘“gm”) :
GM_MAX = getVectorData(“gmMax”)
VTH = getNumericData(“Vth”) Vg, Id, gm, gmMax, and Vth
IdVd«— Test setup must be the display
parameters of IdVg.
END BLOCK

This example shows another way to read the value of the internal variables (Vg, 1d, gm, gmMax,
and Vth). Inthis example, you do not use the mapping table but use the getV ectorData and
getNumericData built-in functions. The functions can be used to read the value of parameters
displayed on the last data display.

To read the value:

*Define VG, ID, GM, GM_MAX, and VTH asthe analysis parameters.
Set these analysis parameters to the display parameters.

eInsert the ASSIGN statements to add the formula shown above.

Note: Application test internal parameter/variable to be connected to an external variable must
be the analysis parameter in its test definition. For the analysis parameter, see “To Define Test
Output” in Module 6.
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Modifying Application Test Definitions

To Use Test Setup Internal Variables
Using built-in functions, setup example

i il e o
File Help

pechiation Test Contents | Test outout |

E & O ® B O & A

BLOCK F LOOP FOR ASSIGN  COMMENT  END ERROR

Setup

[Message

gram Component | ADDICaton Tast] Analysss | Cassc Tast] Mscelanaous| My Favorze
ck Delete Do you perform Id-Vg measurement?
ction

Blox
Sele:

|Debug| Edt |2

Copy n

Message
IF Yes=1

Messa

=

END 500K sumonz o =i
=

CH

Ll & ]

This example sets the following test flow:
Local Variables Definition ! Defiles Yes variable
BLOCK

Message ! Do you perform Id-Vg measurement?
IFYes=1
Idvg ! Classic test setup for I1d-V g measurement
V G=getVectorData(*Vg")
ID=getVectorData(“ |d")
GM=getVectorData("“ gm”)
GM_MAX=getVectorData(* gmMax”)
VTH=getNumericData(“ Vth")

END IF

Message ! Do you perform Id-Vd measurement?
IFYes=1

ldvd ! Classic test setup for 1d-Vd measurement
END IF

Message ! Click OK todisplay VTH and GM_MAX values and end the test
END BLOCK

For the example definition, open the Trng idvd idvg3 definition stored in the ¥data folder on the

Manua CD. The Manual CD stores the example test setup and definition data used in this
manual.
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Modifying Application Test Definitions

To Use Test Setup Internal Variables
Using built-in functions, result example

‘Trng idvd idvg3 - Keysight EasyEXPERT L.J [=) E
File Edit View Marker Cursor Line Window Help
% | B || = [ Y == 1,° B THENToRTT |
BEEEERIQQl@-BaaREaE-FA-Eal ]y
SetupName: [Trng idvd idva3 %8
X-¥ Graph Plot Properties... [Parameters |
®) (s VTH 1.02693 V
im 1.5m
GM_MAX  |1.12600 mS
a
100 u
fdiv
0
500 m VG (V) 200 m/dwv 2
<l | &
List Display Properties... I
Index | V6 | [ [l s
1 500 mV. 390 fA  -292.000000000... =
2 490 mv .53 pA -128.5 pS
3 480 mv 2.18pA -2.99999999999.., [w]

Thisisaresult example of the test output setup shown in the previous pages.
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Class Exercise
To use Auto Analysis twice

You will:

« Make two kinds of MOS threshold voltage (Vth) measurements

« Observe how the user functions and analysis functions are used in the
analysis

« Observe how auto analysis works twice

To Get Started:
« Use the standard MOS device and pin connections
« Get the Vth gmMax setup
« Open test definition editor
« Modity the definition for Vth measurement by using the constant
current method.

In this exercise you will observe how auto analysis works. Y ou will understand each setup
screen required to implement an auto analysis process.
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To Modify Test Definition
Opening Vth gmMax test definition

category _~| @] Vth gmMax Setup Name: [vth gmiax 1
’I BT ~ |Device Parameters
vl CMOS
Discrete Polarity: [Nch | Lg: loorm & wg: [100um  ®]
Exercise
45 GenericTest Temp: 2S0deg 8 Idvax: [100ma &

Memoy
3‘%_‘.0’“‘ Extended Setun__~

A Define New Test
Open Defiition of This Test 4
Delete Definition of This Test

Simple Vth Import Test Definition Drain: [SMU4HR ~
Export Test Definition.
% Tntegrime:  MEDIOM ™ =] vd: [100mV &
Vth Const Id 9
9 ‘ B Gate: UEHR <] Subs: @GP <]
Yth gmits vgStart: ‘S00mv & & vsubs: [0V ]
s34 VgStop: E oov B
ol vt B
Source: ESG_JJ?H?/: hd
Vih-Wg 3

1. Select the CMOS category.

2. Open the Vth gmMax test definition.

3. Click the Library button.

4. Select the Open Definition of This Test... menu.

The test definition editor is opened with the Vth gmMax test definition.
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To Modify Test Definition

Setting properties of numeric variable

a1 5
1 Eie [Heb
a5t Speciication JTest Contents | Test Qutout |

Test Information ]

‘I - Category: [CMOS,Sample Description: Clrg.zge0ntion lng=3a
=

">
Vith griMax: §RRZSRNEVth (A.01.20) + C-lds
Test Name: [Vth omMax and 1d

Tcon: [C¥PrOgram Fles¥AQIeNtYB1S00VESYEXPERTYC Browse...| Ciear

(%)
MOSFET I0-volEOMRZHIT —SGREAWIECAD. LEVIBR

[Device Parameters Definition [Properties ]

| [oses| oo L) |f” 3
Name: Default: Description: ] 0 £
i . — — . £ = - == Max: [10.00 mA L]
cla =100 rm “|[Gate Length C e —
- C =T CR | P
o [Tere =[Eods §][Femperature = wnit: [+
o [tdMax =[100ma ] foran cusrent complance = | Ipicalvaes. | Symbok.
Test Parameters Definition ]
Background: [C¥Program Bowse.. | _Cear | Layout.. Deete| _w | oo |
Name: Type: Default: Description: Align: X: y: Width:  Ext:
s i, v e v = e mpe me g
o [igumit m[umenc ~[Lo0ma “1][Gate current complance = Flo 8o w5 §6~
© fsbsimt  ml[Numenc < ][10.0ma "] [Substrate curent complance = r[E0 E8F0 & Ee
c [odTme  mamenc  ~]0s 8] tme = Flo §F 5F 8@
N [==T= B o o
© [orarMinkng  mi[sting  ~][1na “~]fum range for the dran current measwement w7 [0 W|[io0  @J[0 B W
2 -  fdovh e <]L00uA W] current t dece the v = v am a8 |,

1. Save the test setup as a new one. For example, saveit as Vth gmMax and Id of the Exercise
category.

Click Add button to display the entry fields for the parameter.
2. Select the Id@Vth variable and the type of Numeric.
3. Set properties of the Id@Vth variable.
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To Modify Test Definition

Analysis function setup

Vih@em. 81d [-)[=]x)
Eile  Help
1 ‘ et et (FEEEIRE] et o |
5 0 4 m = *
4 4 @3 v o [
IV Sweep Multi IV List Mt C-VSweep  SPGU Switching Direct
Chamnel L. Sweep  Samplng Contol  Matrix..  Control =
Program Component | Appication Test | Andysis classic Test [Miscelaneous | My Favasite Setup
ES @|1/v Sweep Setup Name: [vth_gmmax |
w o Delete || Channel Setun | Measurement Setup | Function Setup | Auto Analyss Setup | Display Setup |
E user Function I
L& || | |
Copy cut Name: Unit: finition:
c fm = (Idrain, Vigate) ]
Local Variables Defini ~
BLOCK
prEarx Integration T

IF IntegTime="SHORT"
IntegMode = "MANUA
AdcFactor = 8

ELSE IF IntegTime="M
IntegMode = "PLC"
AdcFactor = 1

ELSE IF IntegTime="L | [AnalysisFunction

J
IntegMode = "PLC" acd

AdcFactor = 16
Name: Unit: Definition:

END IF :

2- N T - fom=E I [
END BLOCK e [von v ~fetix |

e v =]Vor-iva*rolarty/2) §

(¢ e =V ~Jlowx O] |

Display the Test Contents screen.

Highlight the Vth_gmmax line.

Click the function Setup tab.

Add the Analysis function. Set the following parameters.
<Name> <unit> <Definition>

Vth@ld V @MX

A wDd PR

Thisisan analysis function setup example. This example usesthe @M X function to get the X
coordinate value.
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Auto Analysis Setup

.
Auto Analysis Setup |
sis | Classic Test | Miscelaneous | My Favorite Setup
Q} I/V Sweep Set| e: [Vth_gmmax -
Channel Setup | Measurement Setup | Function Setup [(E0T0 Anase Sotup ) Display Setup |
¥ Interpolation Mode
Line 1 ]|
¥ Ensble | T9PE ‘ s
2 -‘ ¢ Normal ¢ Gradient @ Tangent  Regression 1 2
st Point
€ X Coordinate @ Data Condition
Check this box. || condton: fom = = fomivax Elarta == =
Second Point
& X Coordinate € Data Condition
X | = v =
Line 2 ]|
I Enble | TIPS &3
I Fix ¢ Normal @ Gradient ¢ Tangent  Regression i
First Point
iy € XY Coordinate & Data Condition
condtion: [ o= = I oafer [ = = =
Gradient
Gradient: E
™ Enable
Condition: | H - | 5 I~ After | 5 a I 5

1. Click the Auto Analysis Setup tab to display the Auto Analysis setup screen.
2. Check the box to fix the Line 1. If the box is not checked, the line will be moved when the

2nd Auto Analysisis done.

The 1% Auto Analysisisset in this dlide.
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.
To Set Display Setup 1
Display Setup
@|1/v Sweep Setup Name: J!lthfgrw'
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |
Assign to external variables...
[X-¥ Graph
asd_| | | |
Name: Sharing: Scale: Min: Max:
v x: [voate ~] [ -] finear ~| [vgstart*eolarity 8] [vostop*Polaity 8]
C y1: [idran =] [(vone) ] [unear | joa 8] [idmax*Polaity 8]
C vz fom = [tone) ] Jmear ] Jos Bl s Ll
© v3: [idran | [™ore)  +| [Log v| [1E-15*Plarity ] [ldMax*Polaity 8]
List Display Parameters
o | | 87 Do ] ooee| o] _w |
© |voate 5 @ e [vth ~]
¢ [vsource =l e fomMax -l
©  |vdrain | 3 [r: [vthetd j]
C [vsubs |

1. Click the Display Setup tab.

2. Click Add button to display the entry fields for the parameter.

3. Select Vth@ld to display.
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Auto Analysis Setup
The 2" Auto Analysis Setup

Eile Help

B | BEE
Test Specification |'rest Contents Ifesl cutput |

el St |

3 [
Auto isplay Data Data Display

Analysis ) Setp Control

Program Comporent | Applcation Test] anlyss | Cissc Test ] Mscelaneous |y Favorte Setup
; £ty [lne 1

| ¥ interpolation Mode |

A=) =

\gebu,| Edit

™ Enable Type s
 Fix @ Normal € Gradient € Tangent € Regression ¥
First Point
Copy Cut @ X Coordinate € Data Condltion
% | CHR =
Local Variables Defini = o & % Coodinate € Data Condition
BLOCK i
|**x** Integration T x| = v E|
IF IntegTime="SHORT" |fees
IntegMode = "MANUA . -
AdcFactor = 8 ™ Enable ype P
ELSE IF IntegTime="M P Fir @ Normal C Gradient C Tangent © Regression ¥
IntegMode = "PLC" Fitst Port . -
AdcFactor = 1 @ X Cootdnate € DataCondltion
ELSE IF IntegTime="L xi | o v |
IntegMode = "PLC" T
AdcFactor = 16 & %Y Coordinate € Data Conddtion
END IF
PxxEEs I-V Sweep *** x| = vi | =
Vth_gmmax Marker
Auto Analysis
END BLOCK ¥ Ensble
Condition: [idran i = [ld@Vth*Polarity = 1 After [ R =

Idrain=Id@Vth*Polarity

Display the Test Contents screen.
Click the Analysis Setup tab.
Highlight the Auto Analysis icon.

Hit Insert button.

Check the box of Interpolation Mode.

o A~ wDdh PP

Vth.

The 2™ Auto Analysisis setin thisdlide.
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To Use Auto Analysis Twice
Result example

Vth emMax and Id [(1} : 2008/10/02 16:20:46] - Keysight EasyEXPERT [__I t @

File Edit View Marker Cursor Line Text Pointer Window Help
2 — |« Y. 7 R IS = Be mm =
IHEEE-QQX @ DEHRM® E FA-E55 )
Setup Name: [Vlh gmMax and Id [(1) ; 2008/10/02 16:20:46] b 4
X-Y Graph Plot Properties... Parameters |
MARKER( & 001y 7 007 A 149 005 S ) vth Bozeeimy
UL 1
€ gp : gmMax 1150 uS
€
g &m '% vth@id 300 v
m
6m
sm
4m
2 3m
g m
im —
0 Intercept: 2684 Y 0
~largeph J25% 0
S0m -200m 0 200m 600 m 1 12 14 16 18 2
Yaate (V) 200m fdv < >
List Display Properties...
Index | vaate | vsource | Vdrain | Vsubs | Ickain | gm A
1 -500.0 mV ov 100.00 mVv ov 10.053 p& -62.44000000 pS
2 -450.0 mv ov 100.00 mv ov 6,931 pA  -46,68000000 pS ~
< >

Thisisaresult example of using two times Auto Analysis shown in the previous pages.
Vth, gmMax and Vth@Id are automatically calculated.
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Class Exercise

To Use Vector Data.
1. Open the Cgg-Vg test definition.

2. Modify it for the multiple frequency test using a
vector variable.

Use the debug tools.
Save the definition as a new one (ex. Trng Cgg-Vg).

Perform the test.

o W &

Export the new definition, and import it.

See the following pages which show an example to use avector data. The Cgg-Vg test definition
is used as the reference of this example. The FREQ variable in thistest definition will be
changed from the numeric type to the vector type.

5-42



Module 5
Modifying Application Test Definitions

To Modify Test Definition
Opening Cgg-Vg test definition

category _~| @ Cag-Vg Setup Name: [Coa-Vg i
1 - EEL +|[Device Parameters

= %J Polarity: [ch | Lg: 1l0om 8] wg: [100um 8|
] Exercise
] GenericTest Temp: PS0ceo 6
] Memory
O MixedSignal =
3- mﬂ > Cancel i Extended Setup __~
Linear A DefineNewTest...
sl 4
| * Delete Defintion of This Test
Cgg-Freq Innport Test Definkion. ..
Log Export Test Definkion... =
'.L_k-" L -]
= FREQ: [1.00MHz &
v —
? qu | Osclevel: S0mv 8] T o -
2 5 Y
T Gate: Eﬁm -I
VgsStart: |-2.00 V il
a
ﬂ VgsStop: E.DDV il
I pules vgsstep: [0 mv 8]
iq‘-‘
Tel-wirl _'J

1. Select the CMOS category.

2. Open the Cgg-Vq test definition.

3. Click the Library button.

4. Select the Open Definition of This Test... menu.

The test definition editor is opened with the Cgg-V g test definition.
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. . .
To Modify Test Definition
Setting properties of vector variable
1 _ ~lolx
Test Specification ast(mrmlslel Qﬁtﬂll
fest Information ]
1 Deein [mﬂ m%‘} 11) il!
Test Name: [Tmg Caa-va (%)
v R I ) MOSFET()F ~FSR(Con/ MR L. CogVoR1ER 707193, q
[Device Parameters Definition [Properties ]
Default: Descnptbn . = = Min: [Infrity He 0]
e mlr e speciied valu | AL
ol Hiwm Dim1Min: B | e [ mHz :
= — Dim1iMax: [3 i = unit: iz = |
A - 5| 3 mm
[LeaH R A e 3108 W SO Dim2Max: l1 iI
Background: [GProgam Fiesta 4 Layout... Delete
Name: Type: ¥ Width:  Ext:
o m,&%; b messremr p yﬂkm—gmr &
C fosstrt mwmenc  zlfzoov "81[OC bias start voltage = F[io spo s 8-
o fosop mamerc ]V 5o bis stop voktage = Pl Spo @ Er-
C [oster m[tumenc =][1o0mv 5o bis step votage = Pl Spo @ Er-
C e mwmenc Sffomy Bpreszement sl leve o Flw & Hk E-
2 o fea  mve I W emrement ey = F[® 5> HF Er
= Bekimme allemor <M< ki e & ol e e wle =

1. Save the test setup as anew one. For example, saveit as Trng Cgg-Vg of the Exercise
category.

2. Select the FREQ variable and change the type from Numeric to Vector.

3. Click the Dimension... button. The Define dimensions dialog box appears.

4. Set the dimension of the FREQ variable.

The example in this slide sets the one dimension and three elements vector variable.
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To Modify Test Definition

Setting vector data

Trng Cog-¥g =10/
e e |
e ]
Category: s Description: [<lngusge0pton ng= )5 =
3 L Ew-Vu: {w—vﬂg‘%\ﬁil) :|!
Test Name: [Tmg Cag-va =

[#53)
MOSFET()Y -HE 1 (Coa) MR L. Cog-VgHitt e 707 M 93,

—_—————————————
Wil Dchine vectordate
[pevice Parame £y g

1

Align: X: Width:  Ext:

: X: ¥

7 * | | coad | |3 o g wm a2
o [Vosstart = rho Sko S S
N o e O 3 cfw o Tk -
© osstep milpumenc <[00V B][oc B step votage = Flo Sk Sk 8-

=

E

-

il

e s e o e

O [ostev mmmency F]Fomy
m {1} 8] resmement frequency Pl = Hp E8r
P o ey [rp— = Py Sl e

chim e el W =

1. Click the Grid button of the FREQ variable. The Define vector data dialog box appears.
2. Define the vector values for the FREQ variable.

The example in this slide sets the value 1 MHz, 2 MHz, and 3 MHz to the FREQ three elements
vector variable.
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To Modify Test Definition

Using the at( ) function to read vector data

=10l
1 Il’estc:ﬂtaﬂs Imel
n O ® I & A
F LooP FOR ASSIGN  COMVENT  END ERROR
3 Component. tion Test | Analysis | Classic Test | Mscelaneous | My Favorite Setup
= @ c-v sw Setup Name: [C00-v0 =
s:gm frert Delete || Channel Setup | Messurement Setup | Function Setup | Auito Analysis Setup | Display Setun |
3 = 5 |
Range
v Name: [Vsts Frequency i
= _, fa H | remency | o] Woml Ko
copy cut paste et oo = o
C [t(FREQ,L,1) W -
Eheme: il o ftFEQz) W
Lecal Variables Defini A G Name: [Gva = Fhame: frea
BLOCK ~ [tFREQ3 D W]
' Direction: [Gnde =] ACLevel: [Osclevel W]
1B S RATC/TRER] SR Start: [rubsStart-Polaity B 3
IF IntegTime = "MEDI
IntegMode = "BLC" Stop: [subsStop*Polaity &
m.ﬁgciﬁai =1-'1 step: [subsStep"polaty 8] e J
ntegTime = : = ,
Integiode = "PLC" Noof Steps [ & Made: [integhiode =] Factor: [AdcFactor 0

AdcFactor = 16 [fiming |
ELSE IF IntegTime =

IntegMode = "AUTO" Hold: iokiTme ]  Delay: [pelrTme Bl + gyeep [conTE AT ANY <] status

AdcFacter = 6

e, Constants ]
! unit: v Name: 1Name: Mode: Source: compliance:
VsubsStart = -Vgssta

VsubsStop = -VgsStop

VsubsStep = -VgsStep There is o item to display in this area,

\

2‘ o — fl e _,:1

1. Display the Test Contents screen.
2. Highlight the Cgg-Vg line.
3. Click the Measurement Setup tab and set the Frequency List using the at( ) functions.
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Module 6
Creating Your Test Definitions

In This Module

*  Whatis Test Definition

*  Whatis Test Contents

* To Open Test Definition Editor
* To Define Test Specification

* To Define Test Contents

* Available Elements

* Available Variables

* To Define Test Output

This section explains how to create your test definition. You will perform the above tasks to
create the definition.
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Creating Your Test Definitions

What is Test Definition

Test Specification

*Test name
*Test description
*Variables
*Device parameters
*Test parameters
*Entry fields

Test Output

*Multi display mode
*Variables

*Analysis parameters
*Test result display

*X-Y graph

*Data list

*Parameter display

*Local variables
*Test execution flow
*Test setup
*Classic test
*Application test
*My Favorite setup

Test Contents

Test definition consists of test specification, test contents, and test output setup. The test
specification contains test name, description, device parameters, and test parameters. The
parameters will be the variables used to pass the test conditions to the test execution flow or test
setup defined in the test contents. Especially for the test parameters, you can specify the position
of entry field for each parameter. Y ou can see the entry fields when the main screen displays
this application test setup. The test contents are the core of the test definition. Y ou will define
the local variables, test execution flow, and test setup. Y ou can define the test setup by selecting
application tests, classic tests, or my favorite setup, and entering the test conditions.

The test output setup isoptional. If you have the following requirements, declare the analysis
parameters and define the display parameters on the Test Output tab screen.

-To send the test data to the subsequent tests

-To make the program branching depends on the test data

-To display/record the calculation result using the test data

-To display/record the test data of this application test

-To change the multi display mode of this application test

Note: You can use the device parameters, test parameters, and analysis parameters in the test
execution flow (program flow) of the test contents without declaration of local variables.

Note: If the multi display mode is Disabled, the al test result datawill be displayed on the
singular Data Display window. If the multi display mode is Enabled, the test result data of the
same test setup name will be displayed on the exclusive Data Display window and the test result
data of the different test setup name will be displayed on the new Data Display window.
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What is Test Contents

Test Specification Test Output

Variables
*Analysis parameters

Variables
*Device parameters
*Test parameters

Local variables |

Program Component

Miscellaneous

Application Test My Favorite

Test contents are the test execution flow (program flow), and is the core of the test definition. In

the test contents, the following elements can be defined.
eLocal variables

*Program components

«Application tests

Classic tests

*My Favorite setup

*Analysis components

*Miscellaneous components

*Device parameters defined in the test specification
*Test parameters defined in the test specification
*Analysis parameters defined in the test output

The program is executed from top to bottom in the test execution program list.
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To Open Test Definition Editor

Bpplication Test

v} Exercise
[J GenericTest

) Memory

[ MixedSignal |

Lll‘ﬂ v  Cancel

I.-l.a.i

Trng Idvd
vth

=
Trng
Cgg-vg
Ll
s

- =1 choose test categories from the left area.

@ Define New Test...

plication test object from the left area.

Trng idvd
idvg2
Al

To start test definition, open the test definition editor.

Select the Application Test tab, click the Library button, and select the Define New Test...
function. The test definition editor will be opened. See next slide.
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To Define Test Specification

=10l x|
Fie Help
[Test specitcation | est contents | Test cutput
Test Information
category: | | Description: [Description of this test. B
Test Name: nted | Set test information
fcon: [ Browse...| Clear il
Device Parameters Dmhi?hm Properties
Name: Default: Description:
Set properties
To add a device parameter, press the [4dd] button in this area.
of parameter
Define device parameters
st Parameters Definition
Background: [ Browss... | Clear (T a A e 0 o
Name:  Type: Default: Description: Align: X: Ve Width:  Ext:
To add a test parameter, press the [add] button in this area.

The test definition editor provides three tabs, Test Specification, Test Contents, and Test Output.
At first define the test specification. Click the Test Specification tab.

In the Test Information area:

«Click the right button in the Category field to specify the category the new test definition
belongs.

*Enter the Test Name.

*Select the Icon that will be displayed on the list area below the Library button of the main
screen. Itistheimage file used to select the test definition. See previous slide.

*Enter the Description of the test.
In the Device Parameters Definition area:
«Click Add button to display the entry fields for the parameter.

Set the Name, Default value, and Description for the parameter. When you add a parameter,
you will seethe entry fields at the Properties area. The area shows you the properties (minimum
value, maximum value, number of effective digits, resolution, and unit) for the device parameter
or the test parameter specified by the radio button put on the left of the parameter name.

For the Typical Values... button and the Symbols... button, see online help or User's Guide.
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To Define Test Specification

=lolx|
Fie Help
[Test specitcation | est contents | Test cutput
Test Information |
category: [ B Description: [Description of this test. B
Test Name: [Untitied =
Icon: | Browse...| Cear |
[Device Parameters Definition Properties
Add ot ; r
Name: Default: Description:
Set properties
To add a device parameter, press the [Add] bution in this area.
of parameter
Test Parameters Definition
Background: | MI@ Layout... Add Uy W
Name:  Type: Default: Description: Align: X: Ve Width:  Ext:
To add a test parameter, press the [add] button in this area.
Define test parameters

In the Test Parameters Definition area:

*Select the Background that will be displayed on the application test setup area of the main
screen. Usually it is the image that shows the device connections.

*Set the Name, data type, Default value, and Description for the parameter. When you add a
parameter, you will see the entry fields at the Properties area. The area shows you the properties
(minimum value, maximum value, number of effective digits, resolution, and unit) for the device
parameter or the test parameter specified by the radio button put on the left of the parameter
name.

*Set the X, Y, and Width values to specify the position of entry field displayed on the application
test setup area.

*Check the Align box to set the X origin of entry field to the left edge of the entry field.
Uncheck this box to set it to the left edge of the parameter name placed |eft next to the entry
field.

«Check the Ext box. The entry field will be put on the Extended Test Parameters dialog box that

is displayed by clicking the Extended Setup button on the application test setup area of the main
screen.
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ol
Fie Help
Test Speatication | st contents | Test outout |
[Test Information |
H tion: T X -
Category: [Exercise B Description: [Ths .*)clmwi ?fnmngn TE\[::mm[ and Id-vg ==
Test Name: [Trmg idvd idvg =
u:nn:E:\Prwam Files\Aglent\B1S00\EasYEXPERT\Gr Browse...| Clear =
[Device Parameters Definition [Properties ]
Add Up
Name: Default: Description:
o o = e =
€ [pelay =ps 5] ey tine =
[Test Parameters Definition |
Background: [CProgram Fies\Agient \B1500|EasyEXPERT\Gr Browss... | Cear e S R
Name: Type: Default: Description: Align: X: Y: width:  Ext:
€ [oran modde  v]lsMusHR =5mu for drain = Ffo Gz §k 8 =
c [cate Eodde  ~]lsMUzHR =[5 for gate = P 6o §eo @C
c [source E[odde  ¥]pMuzR =[5m0 for source = ~Roo Epo e EC
C [oubs m[vodie vfsmure ][ for suos = ~foo @l ke 8
¢ [idvd_v2start ml[wumeic  <[1.000 v “8][1dVd gate start voitage w Fluo @ §Sk 8-
© [idvd_vzstep mi[numenc  ]j500 mv “8][idvd gate step voltage = M0 Eko  EE Er-
i vonon mllemen w1l W rhar of stane frr oud var? = ohn wlbn @l wr- =

This example sets:
Category: Exercise (This category may be created by the class exercise in Module 5)
Test Name: Trng idvd idvg
Icon: MOSFET.bmp
Device parameters:
Hold and Delay
Background: Vth_Const_Id.PNG
Test parameters:
Drain, Gate, Source, Subs, Idcomp, Igcomp
IdVd_Vistart, IdVd_Vistep, IdVd_V1stop, IdVd_V2start, IdVd_V2step, IdVd_V2nop
ldvg Vistart, IdVg_V1stop, ldVg Vlstep, IdVg Vdrain
Vsource, Vsubs
Entry field properties: 80 (width) x 30 (distance in vertical direction)
Press the Layout... button to open the Define Layout dialog box.
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Setup example - Layout

Define Layout 5 -_

Flle Edit Wiew Align Distribute Centralize Tab Order

% Idvd_vistart: OV

Idvd_V2nop: .

Idvg_Vistart: |-S00 mV

Idvg_Vistep: [10mv B[t

Idvg_Vistop: [2.000 v

Primary Entry Field

The Define Layout dialog box is used to define the layout of the test parameter entry fields displayed on the
application test setup screen.

The following methods are available for selecting the entry fields.

«Click on the entry field. Multiple entry fields can be selected by clicking on the entry field while holding
down the Ctrl key on the keyboard.

*Drag the mouse to draw arectangle around multiple entry fields.
*Select Select All fromthe EDIT menu to select al entry fields.

The selected entry fields are outlined by the blue rectangles. The primary entry field, which is the base for
layout operations, is surrounded by a highlighted blue rectangle. Only one primary entry field can be
selected. To change the primary entry field, click on a selected entry field. The entry field is always that was
most recently clicked will be the primary entry field.

The following methods are available for releasing (unsel ecting) the selected entry fields.

*Click the selected entry field while holding down the Shift key on the keyboard.

«Click outside of the selected entry fieldsto release all selected entry fields.

The following methods are available for defining the layout of the selected entry fields.

*Drag & drop with the mouse to move the selected entry field(s).

*Changethe X/Y valuesin the property window to move the selected entry field(s).

Press the arrow keys on the keyboard to move the selected entry field(s).

*Use the functionsin the Align menu to align the selected entry field(s) to the primary entry field.

*Use the functionsin the Distribute menu to evenly distribute the selected entry fields horizontally or
vertically.

*Use the functionsin the Centralize menu to move the horizontal or vertical center of all selected entry
fieldsto the horizontal or vertical center of the entry field area.

For more information, see online help or User’s Guide.
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Result example

Category ~| @| Trng idvd idvg Setup Name: [T idvd idvg
18T A Parameters
C ;g;e Hold: [0 i Delay: 05 0
£ GenercTest
] Mamory
] MedSignd =
- Fﬂm Extended -

Idvd_Vistart: [0V ]

u Idvd_v2start: [1mov il
Idvd_Vistep: Ia—omv o |

| Tmaldvd 1dvd_v2step: [500 mv il

vih
ﬁli Idvd_VZ2nop: F il Idvd_Vistop: E.CIIW i]
=
c;;'a,g Gate: a5 = o Drain: AR 3]
ﬁ Igcomp: IiDmA Il Idcomp: Em []

Teng idvd
"ggz Idvg_Vistart: FSOO my il |E ]
# 1dvg_vistep: [0mv 8]

Teng idvd 1dvg_Vistop: E.IIOV il

idvg3
ﬁ Source: R Subs: @nﬁ vl
7"'::'3 vsource: [0V 0] Vsubs: oV ]

Thisisaresult example of the test specification setup shown in the previous pages.
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To Define Test Contents

Fie Heb
Test Speciication Test Contents | Test cutput

Bo & & 1 O ® M O & A |
ement

=lolx|

BLOCK ONERROR  FINALLY IF ASSIGN  COMMENT END ERROR

4. Select available el

Program Component | Application Test | Analysis | Classic Test | Miscellaneous | My Favorite Setup

B s

Selection

H

S 5, Click Insert or
desired button .

1w [T rer 2. Define the local variables used

BLOCK in this test contents
END BLOCK

3. Specity the line
to insert element No Parameter Settings
or to be edited

6. Define the setup required for
the highlighted line (element)

Starting to define the test contents:

1. Highlight the Local Variables Definition line.

2. Define the local variables used in this test contents (test execution flow).
3. Highlight the line that an element has to be inserted.

4. Highlight an element of Program Component, Application Test, Analysis, Classic Test,
Miscellaneous, or My Favorite Setup tab menu.

5. Click the Insert button of the Edit tab menu. The element will be inserted between the
highlighted line and the next line.

6. Define the required setup.

To edit the test contents:

1. Optional. Highlight the Local Variables Definition line.

2. Optional. Define the local variables used in thistest contents (test execution flow).
3. Highlight the line to be edited.

4. Highlight an additional element if you need.

5. Click the desired button if you need.

6. Define the required setup if you need.

Repeat this to create the test contents (test execution flow).
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Available elements

=] ?[ L A

EeLesEiRETS Program Component
-t b 3 . .

Catagory, Diode IV Diode Iv =EE\\; =E\a E a)rﬁm Appllcatlﬂll TESt

B @ & ; .

i, wgpe s Analysis

d4 4 53 v A B & = g y

Classic Test

MoE = ¢ :

FHIO Mo o s Miscellaneous

e H @ p

fo o [mom wgn s My Favorite

Available elements are shown above. The Program Component provides the typical program
statements such as |IF, LOOP, FOR, and so on. They are used to control the test execution flow.
The Application Test, Classic Test, and My Favorite are used to define the test setup/test
condition. The Analysis provides the elements used to control auto analysis function and data
display. And the Miscellaneous provides other useful elements. For details of elements, see
online help or user’s guide.
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Module 6

Creating Your Test Definitions

Available variables

|Assign to external variables... |

Test Contents l
*Local variables T

[Variabic assipnments.

] ] ]

External variable: Measurement data:

& [@EwoR | [

Test Specification
*Device parameters
*Test parameters

o |

Test Qutput

) You can connect the
*Analysis parameters

variables in test setup with
*Local variables

Do not set the same name *Device parameters
for variables and *Test parameters
parameters. The name *Analysis parameters

must be unique.

In the test execution flow (program flow), you can use the following variables.
*Variables defined by the Local Variables Definition component

*Device parameters defined in the Test Specification

*Test parameters defined in the Test Specification

*Analysis parameters defined in the Test Output

Y ou may want to read the parameters/variables used in Classic Test setup or Application Test
setup defined in the Test Contents. Then use the External Variables Setup dialog box or built-in
functions. They can connect the test setup internal variables/parameters to the external variables
listed above. For the example variable connections, see “To Use Test Setup Internal Variables
in Module 5.

Note: Application test interna parameter/variable to be connected to an external variable must
be the analysis parameter in its test definition.
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Defining local variables

Local Variables Definition

@ Untitied S|
File Help
Test Specication Test Contents [ Test Outout |

B2 &4 & 1 O ® M B = A

BLOCK  ONERROR  FINALLY F LOOF FOR ASSIGN  COMMENT  END ERROR

Program Component [ Appication Test| Anakss| Cassc Test] Mscelneous| My Favorke Setwp |
Local Variables Definition statement ]
‘244 Numeric dd Vector | Add Sting | Add Module

Variable | Vanable | Varsble

Blod
Selection Variable

|Debug| Edit

Numeric Variable |

Name: [0 = value: [0 | Description: |

i}

[vector variable |

Local Variables Defini =

Name: [VECTD = Count:[1 8] Description: |

]

BLOCK
END BLOCK

@ Assign Linear Values FROM [0 W To

L
[m)

 Assign Linear values FROM | 5 swee |

L)

String Variable |
Name: [STRO ] value: | = Description: |

Module Variable ]

Name: [110D0 C| Description: -

L1

O —— |

Add Numeric Variable button displays the Numeric Variable area that provides the following fields.
*Name: Numeric variable name

*Value: Initial value of the variable

eDescription: Additional information for the variable

Add Vector Variable button displays the Vector Variable area that provides the following fields.
*Name: Vector variable name. Two dimensional array.

*Count: Number of elements, or array size

eDescription: Additional information for the variable

This area also provides the following radio button used to specify how to set the initial value of the array
data automatically.

* Assign Linear Values FROM [value of first element] TO [value of last element]

If Count>1, this setsfirst value + (N-1) x (last value-first value)/(Count-1) to the N-th element. If
Count=1, this setsfirst value(=last value) to the element.

* Assign Linear Values FROM [value of first element] STEP [step value]

This setsfirst value + (N-1) x step to the N-th element.

Add String Variable button displays the String Variable area that provides the following fields.
*Name: String variable name

*Value: Initial value of the variable

eDescription: Additional information for the variable

Add Module Variable button displays the Module Variable area that provides the following fields.
*Name: Module variable name

eDescription: Additional information for the variable
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Editing test contents

(@ Untitiea '
File Help

Test Svec-‘a:o'| Test Contents |}€:: output|
& = n O ® M O A

BLOCK  ONERROR  FINALLY F Loop FOR ASSIGN  COMMENT  END ERROR

]
i@
&

Mscelaneous | My Favorze Setup |

*Block Selection
*Insert R
*Delete ”
*Copy

*Cut

Paste

The Edit tab provides the following buttons:

*Block Selection/Line Selection toggle button selects the edit target selection mode. In theline
selection mode, clicking line just selects the line. In the block selection mode, clicking line
selects the block the line belongs.

eInsert button inserts the specified element between the highlighted line and the next line.
*Delete button deletes the highlighted line.

*Copy button copies the highlighted line to the clipboard.

«Cut button moves the highlighted line to the clipboard.

Paste button inserts the line in the clipboard between the highlighted line and the next line.
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Creating Your Test Definitions

Debug menu

@ Untitiea '
File Help

Test spachicaton|| Test Contents |frest outout |

B & m

BLOCK  ONERROR  FINALLY

O ® M O o A

F LooP FOR ASSIGN  COMMENT  END ERROR

Program Component [ Applcation Test

c| Analysis ] Classic Test| Mscelaneous | My Faver

BLOCK statement

Debug § Edit

*Run
*Abort
*Stop
*Break
*Inspect

Parameter Settings

The Debug tab menu provides the following buttons:

*Run button starts the debug (executes the test flow). During execution, the label changes to
Pause. Clicking Pause button pauses the execution, and changes the label to Run that is used to

continue the debug (execution).

«Abort button aborts the debug (execution).
*Step button executes the highlighted line of the test flow. Clicking the button repeatedly

continues the execution by aline.

*Break button sets/releases the break point. For the break point, this button rel eases the break
point from the highlighted line. Program execution will break at the break point automatically.

eInspect button is available when the debug (execution) is paused or broken. This button opens

the Variable Inspector used to monitor value of device parameters, test parameters, analysis
parameters, local variables, or system variables.
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Class Exercise

Create test definition and perform test.
. Open test definition editor.
. Define Test Specification (see previous page)

. Define Test Contents shown below.

. Use debug tools to check the definition. SMU4

. Connect device, and perform test. SMOL_Jf 2

SMUI

1
2
3
4. Save the definition as Trng idvd idvg.
5
6

SMU2

Test Contents:

Local Variables Definition
BLOCK
IDVD
Message
IF Yes=0
END
END IF
GMMAX
END BLOCK
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Test Definition Example

@ Trog iovd idvg

BEX]

[ File  Help

Preset Group:
[Demo

Test Spechication Test Contents |Te;(0 utout |

B od i d d 4 4 4 4

1d-vd

ovD IRVR Farallel REKELV  Parallel-ifm Zero-check Zero-che...

Block
Selection

Program Component | Application 'les: Analyss chm Test Nscelzneous My F;\mn{e Satup.

Delete

ol

4 °
VG-t

v

Ql I/V Sweep

Setup Name: [IDVD

Channel Setup Measurement Setup | Function Setup | Auto Analysis Setup | Dispiay Setup |

=

[vaRt

[nm_.gi Edit

Copy

Cut

BLOCK
IDVD
Message
IF Yes=0

END
END IF
GMMAX

END BLOCK

Local Variables Defini =

= fldvd_Vistart

W)|rive_vastar
: Jldvd_Vistop

: [[ava_vistep

§)fiavd_vastep

No of Step: |Hall | J1dvd_v2nop
compianced{i____alloors

Pwr Comp: |OFF 8| jorr [}

Range

ADC /
Integ

Ad-
vanced

)

Unit: V Name: I Name: Mode: : Compliance:
]'s'raﬁm’]ﬁ:wh " [lsub =V &[vsbs [oma ]
]suu| Saurce | v s =V B|[vsource [to0ma H

Use IDVD and GMMAX in the Demo preset group (My Favorite Setup) for the test setup.

Use the variables defined in the Test Specification to set the Unit on the Channel Setup, the
source values on the Measurement Setup, the Min and Max values on the Display Setup, and so

on.

For the example definition, open the Trng idvd idvg definition stored in the ¥data folder on the
Manual CD. The Manual CD stores the example test setup and definition data used in this

manual.
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Measurement Result Example

| € 10D [(1) ; 12/15/2006 7:37:43 PM] - Keysight EasyEXPERT

BE>]
File Edit View Marker Cursor Line Window Help
I=IE 5 — R B
AEEhacld- BEEHME-FA-Falls
SetupName:  |IDVD [(1) ; 12/15/2006 7:37:43 FM] X
X-Y Graph Plot Properties... F‘“’m |
® MARKER{ 1.50000000X0€+000V  2.35540000006-005 A --wens ) Idrain S84 A
50 m
© GMMAX (1) : 12/15/2006 7:17:59 PIA] - Keysight EasyEXPERT B @
File Edit View Marker Cursor Line Window Help
= —F 3 o T P rme T
BREEEE QAR E- BEHHMemE- - Ehlls
x
s.00m
Jdiv [X-Y Graph Plot Properties... [Parameters. ]
% 0 AR ¥ ) VTH 15.978 mv
. 067.) 00
Intercest: tntecest BETA  [2.034756-003
0 vd () 200 anis 358
- 4.510818E-002 201729002
[Gstoisplay 2 3
Index | vg| e [ & h
1 1V ov 70.6
2 1v 30my 10.868/
3 1v 60 my 16.424[20.0m
= e Jdwe |
o Intercept: il
500 m vg (V) 200m/dv 2
Ilhtw Properties...
Index | val SQRT_Id [ PEAK] ~
1 500 my  964.365076099... 174.303219803..
2 490 My 2.70730727413...  79.2572340348...
: Ay s ezl B

Thisisatest result example displayed on the Data Display window
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Trog idvd idvg

Fis Heb.
Test Specification \ Test Conlsms

To Define Test Output

2. Define the analysis parameters

l ¥ Define own Dutput

| Define Analysk Parameters...

Soonnitie o - EEREEDRL e G -.Lode

[%=¥ Graph

Name: Sharing:

F ox |

=] e o

To add a Y-axis parameter, press the [4dd] bution in this area.

3. Specify X axis and Y axis

[List Display

Parameters

To add a parameter, press the [Add)
button in this area.

4. Select variables to list

To add a parameter, press the [Add]
button in this area.

5. Select parameters
to display

=10/

Comply with above|level
Enable
Difable

The test output setup isoptional. If you have the following requirements, define the analysis

parameters and set the display parameters.

-To send the test result data to the subsequent tests in an application test
-To make the program branching depends on the test result

-To make the calculation using the test data in the Test Contents
-To display/record the test result of this application test

-To change the multi display mode of this application test

To define the test output:

1. Check the Define own Output Parameters box.
2. Click the Define Analysis Parameters... button. And define the analysis parameters on the

Analysis Parameter Definition window.

3. Specify X axisand Y axis of the X-Y Graph of the Data Display window.
4. Select variables to list in the List Display area of the Data Display window.

5. Select variables to display in the Parameters area of the Data Display window.

6. Select the multi display mode using the Allocate Data Display for each test pull-down menu.

Note: If the multi display mode is Disabled, the all test result data will be displayed on the
singular Data Display window. If the multi display mode is Enabled, the test result data of the
same test setup name will be displayed on the exclusive Data Display window and the test result
data of the different test setup name will be displayed on the new Data Display window.
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To Define Test Output
Analysis Parameters

[ Define Analysis Parameters...

: 3

Analysis Parameter Definition

|

[Vector Parameters ]
I Add Delete up
Name: Unit: Description
c v =V _v|[Gate Vokage =
c o EB ~|[prain Current -
oM =S ~]|[Transconductance ]
& [GM_MAX =s ~][Masimum Transconductance C]
' Scalar Paramters |
add | pelete| 1 | |
Name: Unit: Description
& v =V _|[Threshold Vortage C
Close

Define the analysis parameters as shown below:

At the Vector Parameters area or the Scalar Parameters area:

1. Click the Add button.

2. Enter the Name, Unit, and Description of the parameter.
For the sweep output/measurement data, use the vector parameter.

For the spot output/measurement data, use the scalar parameter.

For the data given by the max( ) and min( ) built-in function, use the vector parameter.

In thisexample, VG, ID, and GM are the vector parameter and VTH isthe scalar parameter.
GM_MAX isthe vector parameter because the max( ) built-in function is used to calculate this

value.
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To Define Test Output
Display Parameters

© Trng fdvd idve2 Lok
File Help |

Test Spechication | Test Contents  Test OUt

¥ Define own Qutput Parameters Define Analysis Parsmeters... |
[X-¥ Graph
N o T O
Name: scale: Min: Max:
Fox [ =] [Grewr =] [@vovoms ] [evoors  §]
c v: [ =] [tnear =] oA o [Tma )
(ol PR T ] [unear =] [os § fisms ]
[List Display Parameters
[cm| [odes| NSO e Bwa| oo WO O
c B = c Jer_max ~
cjem :l

This example sets:

X-Y Graph: ID-VG plot for Y1-X graph and GM-V G plot for Y2-X graph
List Display: VG, ID, and GM

Parameters: GM_MAX and VTH

All parameters must be defined in the Analysis Parameter Definition window shown in the
previous slide.

The X-Y Graph areais used to set the X axisand Y axis of the X-Y Graph Plot area on the Data
Display window.

*Name: Name of variable to plot on the X axis
*Scale: Linear or Log

*Min: Minimum value of the specified axis
Max: Maximum value of the specified axis

The List Display area selects the variables to be listed on the List Display area of the Data
Display window. Up to 20 variables can be set.

The Parameters area selects the variables to be listed on the Parameters area of the Data Display
window. Up to 20 parameters can be set.
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Module 7
Advanced Definitions and Operations

In This Module

* To Control External GPIB Devices
* To Call Execution Files

* To Perform Repeat Measurements
*  Prober Control Script

*  Thermo-trigger
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To Control External GPIB Devices

Miscellaneous: GPIB 1/0

Write String  to send a string command to GPIB device
Write Value  to send a command to GPIB device
Read String  to read a string value from GPIB device
Read Value  to read a numeric value data from GPIB device
Read List to read a vector data from GPIB device
Read STB to read status byte of GPIB device
GP-IB Control Group Execution Trigger

Device Clear

Go To Local

Local LockOut

Y ou can control external GPIB devices from the EasyEXPERT by using the GPIB 1/O statement.
The GPIB 1/0 statement provides the write/read functions shown above. Select awrite function
and enter the necessary parameters to send a command to the GPIB device. Select aread
function and enter the necessary parameters to read response from the GPIB device. For details,
see online help or User’s Guide.

The followings are the GPIB Control functions.

*Group Execution Trigger: Sends atrigger to the specified GPIB device.
*Device Clear: Sends a device clear to the specified GPIB device.

*Go To Local: Returns the specified GPIB device to the local state.
eLocal LockOut: Locks the specified GPIB device.

Note: Before starting, enable System Controller. See Module 8. Also establish the GPIB
connection with the external GPIB devices.
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To Control External GPIB Devices

Keysight B2200 control example

To send command

© TestB2200
| File Help
Tast Spactication

Test Contants | s Dpl

BE

Programming image:

Cassic Test

[Function

*RST
‘ROUT:FUNC ACON

 Wite String E Write Vamel
=

 Read String  Read List

GP-IB Control

(enters “SMU1" to StringPort)
‘ROUT:SYMB:PORT {0},"{1}"
‘ROUT:SYMB:PORT? {0}
(reads string data)

*OPC?

(reads operatlon complete flag)

ROUT SYMB:CHAN? {0}, {2}
(reads string data)

*OPC?

(reads operation complete flag) |

(~ Group Execution

~
Trigger 6o To Local

" Read STB

 Local LockOut

Write Value

Address: 22 H| Terminator: |LF+EQI -

Format:  [:ROUT:SYMB:CHAY {0),(2), (1) \

valpe1:  [Carella 5 vawe2 [stmoth

- Ve e

Value 1
Value 2
Value3 ——— {2}

valve 4: ||

— {0

— i

: - Value 4 — {3}

=
5
1}

This slide shows an example setup of the GPIB 1/O statement. Thisisa component of the test
contents used to control the Keysight B2200 switching matrix.

This example uses the Write Va ue function to send the following command to the B2200.

‘ROUT:SYMB:CHAN {0} .{2},"{1}"

where, {0} is CardNo, {1} is StringCh, and {2} is ChanNo.
The followings are the reference of the setup editor.

*Address: GPIB address of the device

eTerminator: EQOI, LF, CR/LF, LF+EOI, CR/LF+EOI, or NONE (no terminator)
eFormat; Command (header and parameters) sent to the device

*Vaue 1: Valuefor {0}
*Vaue 2: Vauefor {1}
*Vaue 3: Vauefor {2}
*Vaue 4: Valuefor {3}

{0}.{1},{2}, and {3} are variable available in the Format field only.

Note: Use double quotes to enter a string to alocal variable by using the Assign statement.

7-4

Module 7
Advanced Definitions and Operations




Module 7

Advanced Definitions and Operations

To Control External GPIB Devices

Keysight B2200 control example

To read data

Programming image:

*RST
‘ROUT:FUNC ACON

(enters “SMU1" to StringPort)
‘ROUT:SYMB:PORT {0},{1}"
:ROUT:SYMB:PORT? {0}

(reads string data)
*OPC?

(reads operation complete flag)
(enters “OUT1" to StringCh)
:ROUT:SYMB:CHAN {0} {2},"{1}"
: . . n

(reads string data)

*OPC?

(reads operation complete flag)

[@Testmaz00 TEE
File Help
Test Specticaton  Test Contents ‘ Test outpue |
== _67
GPIBYO) Messoge  Commend Dato Store
Execution  Control
Program Component | Apphcation Test | Analyss | Gassic Test|
= [Function |
5
w Run
 Write String © Write Value
o
2 |r? Read String I  Read Value  Read List  Read STB
&  ereak
— GP-18 Control
Local Variables Defini 2 r ﬁ""‘ﬂ Exaion " Device Clear € GoTo Local  Local LockOut
s rigger
BLOCK
Gpib( 'Write' )
Gpib( 'Write' ) Read String ]
StringPort = "SMUL"
Gpib( 'Write' ) Address: 22 [] Timeout: [1.00 5 [l
Gpib( 'Write' )
Gpib( 'Read' } String: i |
Gpib( 'Write' )
Cpib( 'Read’ ) Length To Read: |10 ] Length Actually Read:  |Lengii -]
BEEingeh = Pourd Terminator:  [F+€01 - Terminated: Torm v
Gpib( 'Write' )
Gpib( 'Write' )
TP TRIILC
Gpib( 'Read' )
END BLOCK
‘ | 2
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To Call Execution Files

Miscellaneous: Command Execution

© vt e

Command Filename: |xxxx..... sleep.exe -

Argument: T =

Local Variables Dafini =|| Write Type: € string @ ust

BLO | N

Yarr i & Read Type: « string & Value © Lt © None
Command ( 'sieep’ )
DIsplay et Tup write List

END BLOCK

values: AT =1 Specifies vector variable or
s ) string sent to the exe file. =
(ResaVaTE
P N

Result: [Passta =l

Specifies variables used to receive execution
results or output data. This area is deleted

- by Read Type: None.
AN

Y ou can cal the execution file (EXE file) from the EasyEXPERT. Use the Command Execution
statement and define the setup editor as shown in this example.

*Command Filename: Execution file name (command name)

*Argument: Command parameter or argument

*Write Type: String or List (vector data)

*Read Type: String, Value (numeric data), List (vector data), or None (no read data)
If you specify Write String, enter the string sent to the command.

If you specify Write List, enter the name of vector variable sent to the command, and specify the
format of data element sent to the command. See next slide.

In the Read String/Value/List area, specify the variables used to receive execution result and
output data. There isno entry field for Read Type: None.

*Result: Numeric variable name. Used to store the execution result.

*VValue: Numeric variable name for Read Value, or vector variable name for Read List. Used to
store the returned data.

*String: String variable name. Used to store the returned data.

eLength Actually Read: Numeric variable name. Used to store the byte length of the returned
data.

The above example calls the sleep.exe file used to insert the wait time for program execution.
The WAIT value must be defined in msec. After the normal command execution, the sleep.exe
returns 1 for Value and O for Result. The sleep.exe fileis stored in <installation
folder>¥Utilities.

Note: <installation folder> is the folder where the EasyEXPERT isinstalled.
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To set Format field

ULA][:F]}
L | List data index. Or index of element. Integer.
c A Character length of the specified data element.

Positive integer for right-aligned, or negative
integer for left-aligned. Optional.

« F Format identifier. C,D, E, F, G, N, P, R, or X.
Lower case is available. Optional.

Example:

{0,5:E} First element, 5 characters, exponential notation.
{1:G} Second element, general.

{2,10} Third element, 10 characters, general.

The Format field is used to specify the data format of List (vector variable). The strings shown
in the above example can be defined in the Format field.

In the strings, the list dataindex is mandatory. The character length and format identifier are
omissible. Then the length is not limited, and the format G is set.

Corc: Circulation

D or d: Decimal numeral

E or e Exponentia notation
For f: Fixed point

Gorg: Generd

N or n: Numeric

Por p: Percent

Ror r: Round trip

X or x: Hexadecima numeral
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Exercise
Try to improve your test definition as you want.

* To Use Built-in Functions
* To Use Read Out Functions
* To Control External GPIB Devices

» To Call Execution Files
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Arguments:|

~ Automatically fill in Device ID

Thermo-trigger

I Enabled Thermo-trigger

N1265A Thermo-trigger List... |

Repeat Stop Condition

| n

Stop repeating by:
(¥ Counter reaching to:  [5 |
[ Reset counter before repeating

Ht

To Perform Repeat Measurements

Start (Run)
Count ]

@

Repeat Procedures
Slarl Provedure:
| = | Erowse... I Start Procedure
Arguments: | |
Iteration Procedure: :
I ! Browse...
Arguments: | C
Final Procedure:
I Biowse... |

Test Executlon

Count=Count+1 |

I Iteration Procedure |

Yes |

Final Procedure

[IF Procedure return condition ]

i [ 1 Abort is clicked }

status limit

Count is set to 0 when repeat measurement is started.

Repeat measurement is performed as shown in thisflowchart. The statusis a response returned by the start/iteration
procedure. The Count is the accumul ated number of test executions. They are the stop condition of the repeat
measurement.

The repeat measurement stop function is enabled by the following check boxes.
«Counter reaching to
*Procedure return condition

If the first box is checked and the limit value is specified, the repeat measurement will be stopped if Count >= limit. To
perform the repeat measurement, set the limit value more than the number of devices under test or remove check from
this box.

If the second box is checked, the repeat measurement will be stopped if status= True.

When the second box is checked, the device ID automatic setup function is available and is enabled/disabled by the
Automatically fill in Device ID check box. The function enters the device_id value to the Device ID of the test result
record. Thedevice idisaresponse returned by the start/iteration/subsite procedure.

The Repeat Measurement Setup dialog box provides the following action buttons.
*Run: Starts repeat measurement.

<Abort: Stops repeat measurement immediately.

*Cancel: Closes the Repeat Measurement Setup dialog box.

For the Start/Iteration/Final Procedure, enter the full path name of the procedure.
For the Arguments, enter the options of the procedure.

See the following pages describing about procedures.

For the sub die move operation (subsite procedure), see page 7-18. Flowchart is changed.
For the Thermo-trigger, see page 7-19.
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Subsite move Test Setup

Category _~| (@] Subsite move [Setup mame: [subsce move ﬂﬁ
Memory “~ |Device Parameters T
7 =zl
NanoTech
Rehability Count: [0
|0 Structure Device ID:
T#T ——
v Utility v
Library ~ | [Test Parameters Extended Setup __~ My Favorite
~ TRNG
- ProberType: |Ciscade Mcrotech  ~
e TP - » o
Suss Microtec idvgvd
Vector Semcon 4
. CustomProber: :] : ”
‘lrng gmr II &«
Subsite
z, move
. Specify ProberType. | r
Trmg gm r2 Or specify driver for your prober in e
. CustomProber. «
- ";
Tmg gm } "
classic auto & S\W'OW"
Subsite e
ngr - I m-out-1-7

If you do not use the sub die (subsite) move operation, skip this page.

Click Application Test tab and open the Subsite move test setup in the Utility category. On the
Subsite move setup screen, specify ProberType (Cascade, Suss, or Vector) or driver for your
prober in CustomerProber, and save it as a setup in your preset group (My Favorite Setup). Then
you can use the setup for your quick test. See next page.

The Subsite move setup moves wafer chuck to the next subsite, reads device ID from the praber,
and setsit to the Device ID of the test result record.

For more details of the test setup, open the Test Definition window.

In the Subsite move test definition, an execution file callProbeDvr.exe is used. Thisfileisused
to send Subsite xxxx.exe to the prober specified by the prober_info.ini file and receive the
response; status and device_id. The callProberDvr.exe has the following input/output
parameters.

Input: Full path of Subsite_xxxx.exe
Output: status; True (break) or False
Output: device id

Note: The callProberDvr.exe refers to the prober_info.ini file for the GPIB address and log file
name. Do not set the Arguments of Subsite xxxx.exe.
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To Use Subsite move

[My Favorite Setup ~

‘I Preset Group: |TRNG ]| —
L sctup tame
i SWM-1to7
d idvavd Repeat Procedures
L Start Provafuns
& 1d-vd | = Erowse... I
2 SWM-open =
¥ IN-OUT-1-7 (] L
Iteration Procedure:
| = Browse.
Arguments: | =
Final Procedure:
[ = Bowse.. |
Arguments:| =
 Automatically fill in Device ID
[Fhermo-trigger
I Enabled Thermo-trigger N1265A Thermo-triager List... |
Repeat Stop Condition ] tn I

Stop repeating by:
¥ Counter reaching to: [5 ] #

[¥ Reset counter before repeating

¥ Procedure return condition

Concal |

If you do not use the sub die (subsite) move operation, skip this page.

To perform the test with the sub die move operation, do as follows.

o~ 0D PE

Start repeat measurement.

Add the Subsite move test setup to your preset group (My Favorite setup).
Set your preset group and test setups in the Quick Test tab screen.

Open the Repeat Measurement Setup dialog box.

Specify the procedures and the repeat measurement condition.

The Subsite move setup must be entered after measurements for a sub die.
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Prober Control Script
* Prober information file Use prober control script in EasyEXPERT
prober_info.ini Repeat Measurement Setup window

« Start Procedure
Start xxxx.exe

Iteration Procedure
Iterator_ xxxx.exe

* Final Procedure
Final xxxx.exe

» Subsite Procedure
Subsite xxxx.exe
Xxxx: * cascade

* Suss

* vector

Prober control script is sample program used for semi-automatic prober control. The Keysight
EasyEXPERT can call the script by using the Repeat Measurement Setup window.

See page 7-9 to call the script and perform repeat measurement.
See page 7-14 for the prober information file.

See page 7-13 for the start procedure.

See page 7-15 for the iteration procedure.

See page 7-16 for the final procedure.

See page 7-17 for the subsite procedure.

To use the prober control script, specify the start/iteration/final procedure in the Repeat
Measurement Setup dialog box (see page 7-9). And use the Subsite move test setup in your
quick test to control sub die move. The Subsite move setup uses the subsite procedure for
moving wafer chuck to the next subsite. See page 7-10 and 7-11.

The prober control script is stored in <installation folder>¥Utilities¥ProberControl.
Note: <installation folder> is the folder where the EasyEXPERT isinstalled.
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Start xxxx.exe

-
* Arguments: -a GPIB_address

-1log_file name | Displays Device ID Entry dialog box |
Example: |

Updates prober_info.ini file |

—a GPIB0::5::INSTR -1 C:¥temp¥prb.log
* Response: XML format data

|
Displays Start Com"rmatlon dialog box |

[ Moves to the first position |

<Response>
<Break>status</Break>
<Target>device_id</Target>

</Response> Gets X-Y coordinate
stat.us: . True (brea k)' or False . e
device_id: prefix:coordinate
Example: | Chuﬁk =

<Response> |
<Break>False</Break>

<Target>waf1a:3 1</Target>

</Response>

Returns response |

To specify the start procedure in the Repeat M easurement Setup dialog box, enter the full path
name of Start_xxxx.exe into the Start Procedure field.

After the repeat measurement is started, this procedure displays the Device ID Entry dialog box
and waits for your input. On the dialog box, enter a string used for the prefix of device id. After
that, you will see the Start Confirmation dialog box that is used to confirm your wafer setup
status. Load wafer and perform wafer alignment, then click OK on the dialog box. The
procedure moves wafer chuck to the first probing position, checks the prober status, gets the X-Y
coordinate of the probing position, and sets the wafer chuck to the UP position. At last, the
procedure returns the response.

The statusis True or False. It isused for the EasyEXPERT repeat measurement stop function.
When the Procedure return condition box is checked in the Repeat Measurement Setup dialog
box, the repeat measurement will be stopped if status= True.

The device idisastring for the Device ID of the test result record. When the Automatically fill
in Device ID box is checked in the Repeat Measurement Setup dialog box, the device_id will be
entered to the Device ID of the test result record.

For the sub die move operation (subsite procedure), see page 7-18. Flowchart is changed.

Note: To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.
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Prober_info.ini

[Prober]

Address=GPIB::5::INSTR > GPIB address of prober
LogMode=True

LogName=C:¥temp¥prb.log| — Full path name of log file

[Target]
UselD=True »device_id = prefix:coordinate
Subsitelnfo=False |
Waferinfo=False <Response>

ID@ <Break>FaIs£</Break>

i <Target/Ta rget>

</Response>

@ou enter in the Device ID Entry dialog box.
ID is automatically recorded in the prober_info.ini file.
The Device ID Entry dialog box is opened by Start xxxx.exe.

The prober information file is necessary to execute the prober control script. Before starting
tests, open thisfile, edit it as you want, and overwrite it. The name must be prober_info.ini.

The prober_info.ini file stores the information shown below.
*Address. GPIB address of prober

eLogMode: Log file creation mode; True or False

eLogName: Log file name (full path)

*UselD: Device ID creation mode; True or False

*Subsitelnfo: Set always False. Thisisjust a place holder.
*WaferInfo: Set always False. Thisisjust a place holder.

«ID: Ignore thisvariable. Thisisjust a pass parameter.

If the procedures specify the —a option, the Address value is not used.
If the procedures specify the - option, the LogName value is not used.
To create alog file, set LogMode=True.

To use the prefix:coordinate format for the device id value, set UselD=True. If UselD=False,
the device_id value will be coordinate, not prefix:coordinate. The prefix will be the value
entered in the Device ID Entry dialog box that is opened by Start xxxx.exe. Thisfunctionis
available when the Automatically fill in Device ID check box is checked.
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Iterator_xxxx.exe

* Arguments: -a GPIB_address —T
-1log_file_name | uck down |

Example:
—a GPIBO::5::INSTR -1 C:¥temp¥prb.log

* Response: XML format data

<Response> Prober error? Xes
<Break>status</Break> '
<Target>device_id</Target> No |

</Response> | Gets X-Y coordinate

| Moves to the next position I

status: True (break) or False I
device_id: prefix:coordinate o
| Chuck up |
Example: T
[
<Response> | Returns response |

<Break>False</Break>

<Target>waf1a:4 1</Target>

</Response>

To specify theiteration procedure in the Repeat Measurement Setup dialog box, enter the full
path name of Iterator_xxxx.exe into the Iteration Procedure field.

The procedure is called after the measurement is completed for adie. This procedure sets wafer
chuck to the DOWN position, moves it to the next probing position, checks the prober status,
gets the X-Y coordinate of the probing position, and sets the wafer chuck to the UP position. At
last, the procedure returns the response.

The statusis True or False. It isused for the EasyEXPERT repeat measurement stop function.
When the Procedure return condition box is checked in the Repeat Measurement Setup dialog
box, the repeat measurement will be stopped if status= True.

The device_id isastring for the Device ID of the test result record. When the Automatically fill
in Device ID box is checked in the Repeat Measurement Setup dialog box, the device id will be
entered to the Device ID of the test result record.

For the sub die move operation (subsite procedure), see page 7-18. Flowchart is changed.

Note: To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.
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Final xxxx.exe

* Arguments: -a GPIB_address
-1 log_file_name

Example:
—a GPIBO::5::INSTR -l C:¥temp¥prb.log
i Response: none Repeat Procedures
Slarl Provedure:
[ = Erowse...
Arquments: [ C]
‘ Start ) Iteration Procedurae:
| = Browse...
Arguments: =
Final Procedure:
| Chuck down | I T —
Arguments:| =
[ Automatically fill in Device ID
End Tharmo-trigger
I Enabled Thermo-trigger N1265A Thermo-trigger List...

[Repeat Stop Condition \ e

Stop repaating by:
Stﬂp Condition—> ¥ Counter reachingto:  [5 H Aot

¥ Reset counter before repeating |

¥ Procedure return condition

IS Z

To specify the final procedure on the Repeat Measurement Setup dialog box, enter the full path
name of Final_xxxx.exe into the Final Procedure field.

The procedure is called after one of the stop condition is detected. This procedure sets wafer
chuck to the DOWN position.

Note: To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.
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Subsite xxxx.exe

* Arguments: -a GPIB_address
-1 log_file_name

| Chuck down |

Example:
—a GPIBO::5::INSTR -1 C:¥temp¥prb.log

Yes

No
[ Moves to the next subsite |

<Resp0nse> Prober error? Yes
<Break>status</Break>

<Target>device_id</Target> No_
</Response> | Gets X-Y coordinate |

* Response: XML format data

status: True (break) or False
device_id: prefix:coordinate

Chuck
Example: | uc|: = |

[
<Response> | Returns response |
<Break>False</Break>
<Target>waf1a:3 1</Target> End
</Response>

To realize sub die move operation, you need to define Subsite_xxxx.exe in your test definition
and create your application test setup. However, you do not need to take care of this procedure
by using the Subsite move test setup included in the application library. The Subsite move setup
moves wafer chuck to the next subsite, reads device ID from the prober, and sets it to the Device
ID of the test result record.

Open the Subsite move test setup and save it as a setup in your preset group (My Favorite Setup).

Then you can use the setup for your quick test.

Note: To use the Subsite move setup, set the GPIB address and log file name in the
prober_info.ini. And ignore the Arguments for Subsite_xxxx.exe.

Note: If you use a Suss prober, the number of Subsite move setups used in your quick test (die
test) isimportant. 1t must be N-1; N isthe number of subsites defined in the prober.

The statusis True or False. It isused for the EasyEXPERT repeat measurement stop function.
When the Procedure return condition box is checked in the Repeat Measurement Setup dialog
box, the repeat measurement will be stopped if status= True.

The device id isastring for the Device ID of the test result record.
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To Change Execution Flow

&— |

[ Test Execution |

| |Subsite F"rocedure[ |

Yes

]
[ Move to the 15t subsite |
|

To use the subsite procedure, change the flowchart as follows.
On the page 7-9, replace the box A with the block A shown above.
On the page 7-13 and 7-15, insert the box B shown above to the position B of the flowchart.
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Thermo-trigger — BI505A and N1265A  BZ

Hepeat Measurement Setup

Repeat Procedures
Slarl Provedure:
| d Erowse... I
Argurrems:| !
Iteration Procedure:
| = Browse...
Arguments: | Cl
Final Procedure:
| d Biowse... |
Arguments:| =
~ Automatically fill in Device ID
Therme-trigger
I Enabled Thermo-trigger N1265A Thermo-trigger List... |
) Run
Stop repeating by:
[¥ Counter reaching to: 5 !I
[¥ Reset counter before repeating
Canczl
¥ Procedure return condition

Thermo-trigger

I| If Abort is clicked |

]

Start (Run)
Count ]

Start Procedure

Test Executlon

Count=Count+1 |

I Iteration Procedure |

Yes |+
Final Procedure

Thermo-trigger function is valid only when the N1265A ultra high current expander/fixture is

used.

If this function is enabled, the repeat measurement execution flow is changed. See the next page.
The following steps are added.

1. After Countisjudged, temperature (Temp) is measured.

2. If the measured temperature isin the range of the temperature condition (Center and
Radius), the action (Action) is executed after the delay time (Delay) elapsed. Or else, the
temperature measurement and this judgement are repeated.

Thetermsin () are the parameters you can set by using the dialog box opened by clicking the
N1265A Thermo-trigger List button. The dialog box is shown in the next page.
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Thermo-trigger — Execution Flow

Thermo-trigger List

add | pelete | Up | oown |

Radius

Thermo-trigger List
dialog box for setting
temperature conditions

Import... Export... Ok Cancel Apply I

To use the Thermo-trigger, change the flowchart as follows.
On the page 7-19, replace the box A with the block A shown above.

The Thermo-trigger List dialog box is used to set the temperature conditions. Y ou can set a
maximum of 1001 conditions.

Temp specifies T1, T2, or T1-T2.

T1: Temperature value measured by the thermometer channel 1.
T2: Temperature value measured by the thermometer channel 2.
T1-T2: Difference between T1 and T2.

Center and Radius specify the temperature range, Center +/- Radius.
Delay specifies the delay time before Action is executed.

Action specifies TRIG, NOP, or END.

TRIG: Doesthe single test execution after the specified delay time, and then goes to the next
operation. Thisis useful to do the single test execution in the specified temperature range.

NOP: No operation (single test execution is skipped). Waits for the delay time, and goes to the
next operation. Thisis useful to wait in the specified temperature range.

END: Setsthe statusto True, and exits the repeat measurement after the delay time. Thisis
useful to exit the repeat measurement in the specified temperature range.
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Module 8
Miscellaneous Operations

In This Module

*  Function Status Indicators

* Run Option

* Automatic Data Export and Data Record
* Calibration

*  Configuration

* XSLT Filters

* To Enable System Controller

* To Start EasyEXPERT on External PC

* To Use 415x Setup File Converter

This module describes the above topics. You will understand what is the function status indicator,
how to change the function status, how to perform selftest and calibration, how to perform SMU zero
offset cancel, and so on.
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Function Status Indicators

| Date

| Count | Device ID

| Remarks |i|

2009/09/18 16:59:38
d 2008/10/02 16:20:46
4T 0.1V step  2008/02/05 11:24:50
2008/02/01 20:36:02
2008/02/01 20:36:02
2008/02/01 20:35:43

1

il

1

Id-vd

=l

T|_ Thermometer OFF |- Mult Display OFF ||| Standby OFF 0] MU Zero OFF | 5! Auto Export OFF |f =] Auto Record N |

[ Multi Display ON

4] dri48deg. C

[[>] standby ont

Standby function OFF m ON

|#0] SMU Zero ON

SMU zero

Multiple data display OFF = ON

Thermometer OFF m) T1: XX deg C ™ T2: XX deg C m) dT: XX deg C

E&] pwto Record OFF

Automatic data record ON mp OFF

|5l auto Exporton

Automatic data export OFF m) ON

offset cancel OFF m) ON

Function status indicators let you know the status OFF or ON of the following functions. The
indicators are placed at the bottom of the main screen.

Thermometer indicator shows the thermometer OFF status, temperature (T1 or T2) measured by the
thermometer channel 1 or 2, or difference (dT) between temperature values measured by the

channels 1 and 2.

T1, T2, or dT is shown while the Thermometer is enabled. They are toggled by clicking the indicator
if the channels 1 and 2 are enabled. Where, XX indicates the temperature value.

Multi Display OFF/ON: Shows the multiple data display function OFF or ON status.
Standby OFF/ON: Shows the standby function OFF or ON status.

SMU Zero OFF/ON: Shows the SMU zero offset cancel function OFF or ON status.
Auto Export OFF/ON: Shows the automatic data export function OFF or ON status.

Auto Record ON/OFF: Shows the automatic data record function ON or OFF status.

Clicking indicator controls the function ON/OFF directly or opens the dialog box or window which

controls the function status.
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Run Option

syEXPERT (Administrator) =2
ew Tools Help
o S 5 fon: Clcic=of | > [
— Append F6
: |Vee-Vi -avoril

Yoo Repeat Ctrl+F6 @ setup Name : [Vce-Voe = 7
IVSH ) Demo
N Stop ShiftF5 pr

Recall G Temp: [5.0deg 8| =
ar Options... POy (I
Jiod 4

Auto Export and Auto Record status:

[Slavoepatorr | [ asorecordon | o Save Data button
[Slaumecaion  [Eladsrerodol | op appears if the last
[SlautoBxporton [B] Auto Record OFF test result data is in
" Run Options the memory when
fv Record Test Result Data Autormatically bOth AlltO EXpOl’t and
¥ Show Test Result Editor Aut() Rec()rd are OFF’
fv Allocate Data Display for each test and allows yOll to save
Close the last data as the
test result record.

Multi data display ON [E i pispiay on

Run > Options menu opens the Run Option dialog box used to change the status of the automatic
data record function, the automatic data export function, and the multiple data display function.

If the Record Test Result Data Automatically check box is checked, both or one of the automatic
data record function and the automatic data export function will be set to ON. To specify the
function status, see the next page. If the Show Test Result Editor checkbox is checked, the Test
Result Editor is opened when the measurement is finished.

If the Record Test Result Data Automatically check box is not checked, both functions are set to
OFF. In this status, both data record and data export are not performed. So the test execution time
will be reduced. Also, EasyEXPERT memorizes the last test result data. And it can be saved as a
test result record by clicking the Save Data button right next to the Run Option button. This status
will be useful for probe contact check, defect analysis, and so on.

The multiple data display function ON or OFF can be controlled by clicking the Multi Display
indicator or by using the Allocate Data Display for each test check box on the Run Option dialog
box.

About the multiple data display function:

If this function is OFF, the all test result data will be displayed on the singular Data Display window.

If this function is ON, the test result data of the same test setup name will be displayed on the
exclusive Data Display window and the test result data of the different test setup name will be
displayed on the new Data Display window.
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Initial Workspace

Automatic Data Export and Data Record

File Edit View Run Tools Help

Test Results Data Auto Export

Device D : = | Count :[3

Category... ~| Vce-Vge @ setw
MUHVSHU + [ o
PHIC Polarity : [ich ] Temp: [500e0 |
PowerBIT
PowerDiode ||
B4 PowertiosF
sic a
Test Parameters

| Quick Test | Tracer Test | clasic Test | Application Test

Pumping 4T

Memo: [ |

Primary Sweep
Gate: [SHUSHP 7]

Vostart: 100V ]

vostop: [roov 8] [}

N
Vostep : [[00mv ]

Import...
Export »

Demo-s-... |£| Emiter: GOV
Endurance
Ail
- 1
)
Concel me [Date
P— fax 4/9/2015 3:23:00 PM
Un 06 4:48:35 PM
- 06 6:20:05 PM

8 4:20:46 PM

@nab\e automatic data export to the specified storage device (Auto Export ON)

nation for Export
Foler Path :

C:\Tem\EasyEXPER T\ TestData = [ Browse...

File Name

& Default Form!

€ Custom Format

e.g, # 'Setup Name WQevice ID(123) 'Remarks _; 4_14_2015 12_04_50 PM]

File Type
 Test Result { EasyEXPERT fagmat ) My Format

(" Compressed Test Result ( Easy®{PERT format )

oy [C:\Program Fies\Agient\B1500\EasyEXPERT &
" XML Spread Sheet File Extension - [.cov
 TextFile

Data Sterage

able automatic data record to the internal storage devi

(

(Auto Record ON)

Image Format: [ bmp

oK Cancel

Customize...

Properties

[5] uto Expart oN

L— |E] Auto Record OFF

The automatic data export function and the automatic data record function can be enabled or disabled
by using the Test Results Data Auto Export dialog box. This dialog box is displayed by clicking
these indicators or selecting the Results > Export > Options > Auto Export... menu.

The automatic data export function is used to export the test result data automatically to the storage
device you specify. You can specify the destination (storage device), exported file name, and file
type. To set the automatic data export function to enable (set to ON), check the Enable automatic

data export to the specified storage device check box.

The automatic data record function is used to save the test result data to the internal HDD
automatically. This function can be disabled if the automatic data export function is enabled. To
disable the automatic data record function, remove the check from the Enable automatic data record
to the internal storage device check box.

Even if both data export and data record functions are enabled, the functions can be set to OFF by
removing the check from the Record Test Result Data Automatically check box on the Run Option

dialog box.
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Module Self Calibration
Tools > System > Calibration...

I
Calibration

Module Seff Calibration | sMU Zero Cancel | cMU Calibration |

Module Self Calibration |

| Name | Full Range| Status | Notes ‘
GNDU+ADC PASS
SPGU1:HV,5P... ---- PASS Unselect Al
WGFMUL:RS,W... — PASS
SMU1:HP — PASS
SMU2:HR/AS off PASS Start Calibration
SMU3:HR/AS Off PASS
SMU4:HR PASS
SMUS:MP PASS
SMUB:MP PASS
CMU1:MF — PASS I~ Full Range
Calibration
[~ Enable Auto Calibration

Close

The Calibration window is opened by selecting Tools > System > Calibration... menu. The Module
Self Calibration tab screen of this window is used to perform the calibration of SMUs. The list area
of this screen lists Name, Full Range, and Status.

Name: Name of module. To select, check the left check box.

Full Range: For the high resolution SMU (HRSMU) connected to the atto sense/switch unit (ASU).
Full range calibration on or off.

Status: Calibration status. Pass or fail.
Notes: Error information when calibration failed.

To perform the self-calibration, specify the modules, open the measurement terminals of the
corresponding modules, and click the Start Calibration button.

Full Range Calibration:
For the HRSMU connected to the ASU. Enables or disables the full range calibration. If this box has
been unchecked, the BIS00A does not use the 1 pA range.

Enable Auto Calibration:

Enables or disables the auto-calibration capability. If this box has been checked (function ON), and
the BISO0A/B1505A automatically starts calibration for all modules every 30 minutes if the output
switches of all modules are off for 30 minutes.

NOTE:

To perform calibration correctly, open the measurement terminals. If auto-calibration is enabled, do
not forget to open the measurement terminals or disconnect the device under test from the terminals
after measurement.
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SMU Zero Cancel

SMU Zero Cancel

Name Full Range | 1nA 100pA 10pA ipA
O SMUL:HP

O SMU2:HR
O SMU3:HR
O SMU4:HR
1 SMUS:HR (a17a 35.9fA  16.281A |

I Full Range Integration Time:

Select all Unselect All 2

Measure...
3

)

0| SMU ZeroON |

The SMU Zero Cancel tab screen is used to perform the SMU zero offset current measurement and
set the SMU zero offset cancel function.

This function subtracts the offset current from the current measurement raw data, and returns the
result as the measurement data. This function is used to compensate the error factor (offset current)
caused by the measurement path such as the measurement cables, manipulators, or probe card.

To enable this function, perform the following procedure.
1.Check the left box of the Name column to specify the module to enable this function.

2.Click the Measure... button to perform the zero offset current measurement and wait until the
measurement is completed. The measurement data will be displayed in the appropriate cell.

3.Click the Close button to enable the zero offset cancel function.
To disable the function, uncheck the left box of the Name column, and click the Close button.

Note:

The offset cancel is not available for measurement over 100 nA range. For 10 nA range
measurement, the offset cancel is performed by using the 1 nA range offset value. For measurement
by a range less than 10 nA, the offset value measured by each range is used.

For more information, see online help or User’s Guide.
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CMU Calibration

CMU Calibration
- [For the aceurate ~
¥ Phase Compensation Measure... | | rement, perform
= hort/Load correction

measurement
ncy befare starting the
ance measurement

¥ Open Correction Measure... B

the measurement frequency,
default

™ short Correction Measure. |

[~ Load Correction 1
vl advanced
Options... > e
Advanced Options for CMU Calibration

[Frequency | [Reference standard value |
& Use factory specified frequencies (Default) Open Reference
¢ specify list of calibration frequencies Model: | C0-G =
1 MHz I il Capadi oF g
Conductance: [0 5 8
Short Reference
Model: | LsRs. -
oH [
' Spocity fraquandies hy rame Resistance: [0 ohm 8
start: | | stop:[ g Load Reference
Steps: [ 8| scale: [ =l Model: | Ls-Rs -
oH ]
[Integration Time | i 50 0hm 8
‘ € AutoMode & PLC Mode Factor: [16 ]
OK Cancel

The CMU Calibration tab screen is used to perform the measurement data correction of the multi
frequency capacitance measurement unit (MFCMU). For the easy way, perform the phase
compensation and the open correction at least. The check boxes left of the Open/Short/Load
Correction and the Phase Compensation are effective after the corresponding measurement is
performed.

Measure...: Opens a dialog box used to perform correction/compensation data measurement. To
perform the measurement, follow the dialog box.

Advanced Options...: Opens the “Advanced Options for CMU Calibration” dialog box used to set
the frequencies for the correction data measurement and the reference values of the working
standard. See the next page.

To perform the open correction and the phase compensation, open the measurement terminals.
To perform the short correction, connect the measurement terminals together.

To perform the load correction, connect your load standard between the high terminal and the low
terminal.

NOTE:

For a more accurate measurement, perform Open/Short/Load correction at the measurement
frequency before starting the capacitance measurement.

If the measurement frequency is not included in the list of default frequencies below, click the
Advanced Options... button and set the measurement frequency on the Frequency area of the
Advanced Options for CMU Calibration window.

Default frequencies:

1k,2k 5k, 10k, 20k, 50k, 100k, 200k, 500k, I M, 1.2M, 1.5M,2M,2.5M,2.7M,3 M, 3.2
M,3.5M,3.7M,4M,42M,4.5M, 5 MHz

8-8



Module 8
Miscellaneous Operations

Advanced Options for CMU Calibration

Advanced Options for CMU Calibration
Frequency Reference Standard Value ‘
* Use factory specified frequencies (Default) Open Reference
" Specify list of calibration frequencies Model: | Co-G -
1 MHz Jﬁi Capacitance: |0 F B
Conductance: |0 5 8
Short Reference
L : Model: | Ls-Rs =
Inductance: |0 H B
" Specify frequencies by range Resistance: |0 ohm 2}
start: | EB|  stop:] & Load Reference
Steps: ] E] Scale: | J Model: | Ls-Rs -
Inductance: |0 H B
|In1BgraIJon g | Resistance: |50 ohm =l
‘ " Auto Mode (' PLC Mode Factor: |16 Ei
0K ‘ Cancel ‘

This dialog box is opened by clicking the Advanced Options... button, and is used to set the
information required to measure the open/short/load correction data and the phase compensation
data. This dialog box provides the following action button.

OK: Applies the setup changes and closes this dialog box.

Cancel: Cancel the setup changes and closes this dialog box.

Frequency: You can select the measurement frequency setup mode from the following modes.
Measurement frequency setup modes:

Default (Use factory specified frequencies): Usually, select this mode. 23 points are automatically
set. They are 1k,2k, 5k, 10k, 20k, 50k, 100k, 200k, 500k, 1 M, 1.2 M, 1.5M,2M, 2.5 M, 2.7
M,3M,32M,3.5M,3.7M,4M,4.2M, 4.5M, and 5 MHz.

Specifies by list: Select this mode when you want to set the frequencies independently. The
frequency must be 1 kHz to 5 MHz. The number of frequencies must be 1 to 101. Click Add to open
a dialog box, and enter the value. For the unnecessary value, highlight the value and click Delete.

Specifies by range: Select this mode when you want to set the frequencies sequentially and
automatically. Specify the start frequency, the stop frequency, the number of steps, and the scale
LINEAR/LOG. The start frequency must be less than the Stop value and at least 1 kHz. The stop
frequency must be more than the Start value and no more than 5 MHz. The number of steps must be
2 to 1001.

NOTE:
If the device measurement frequency is not equal to the correction data measurement frequency,
calculation will be performed automatically to get the correction data for the device measurement

frequency, and the calculated correction data will be used for the data correction of the measurement
data.
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Advanced Options for CMU Calibration

Advanced Options for CMU Calibration

Frequency

| |Referen0e Standard Value

1 MHz

7" Specify frequencies by range

* Use factory specified frequencies (Default)

" Specify list of calibration frequencies

"
L

Start: i EJ Stop: ] ! E}

Steps: 1 EJ Scale: ] j
Integration Time |
" Auto Mode ' PLC Mode Factor: |16 E!l

Open Reference

Model: | Cp-G =
Capacitance: ;UF—‘E
Conductance: iUS—‘E]
Short Reference
Model: | Ls-Rs B
Inductance: {ﬁH—E
Resistance: m
Load Reference
Model: | Ls-Rs =
Inductance: |0 H B

Resistance: |50 ohm B

0K ‘ Cancel ‘

Integration Time area defines the integration time used for measuring phase compensation data or
open/short/load correction data. The number of averaging samples (Mode=AUTO) or the averaging

time (Mode=PLC) is set.

Mode: A/D converter operation mode, AUTO or PLC.

Factor: Factor for the initial value. For details, see online help or user’s guide.

8-10



Module 8
Miscellaneous Operations

Advanced Options for CMU Calibration

Advanced Options for CMU Calibration

Frequency

Reference Standard Value

* Use factory specified frequencies (Default)

" Specify list of calibration frequencies

1 MHz {—E]
o

7" Specify frequencies by range

Stark: J _EJ Stop: ] ! E}
Steps: ] EJ Scale: ] j
|Integraﬁon Time |

‘ " Auto Mode ' PLC Mode

Factor: |16 E!

Open Reference

Model: | Cp-G =
Capacitance: m
Conductance: iUS—‘E]
Short Reference
Model: | Ls-Rs B
Inductance: {ﬁH—E
Resistance: m
Load Reference
Model: | Ls-Rs =
Inductance: |0 H B

Resistance: |50 ohm B

0K ‘ Cancel ‘

Reference Standard Values area provides the following entry fields used to set the reference values
of the open/short/load standard. If you use the standard, enter the reference values to the entry fields.

OPEN Reference: Capacitance and Conductance. If you do not use the reference, enter 0 in the both

fields.

SHORT Reference: Inductance and Resistance. If you do not use the reference, enter 0 in the both

fields.

LOAD Reference: Inductance and Resistance
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Main Frame

Tools > System > Configuration...

Configuration

Main Frame andu\esl Dual HCSMU Combination | Module Selector | UHC Expandar / Fictura | HWSMU Current Expander | L]

|Sysﬁem Information |

Model Identification : |B1505A Line Frequency : |50HZ <
EasyEXPERT Rev. : |6.0.1513.9400 Firmware Rev. : |3.6.0.0

Host ID : |001372351bf6

Main Frame Diagnosis |
| Item Status i

Trigger I/O .

Digital I/O

Touch Panel Switch ---- Unselect Al

LCD
Interlock, Open

Interlock, Close —

High Voltage LED — .
Measurement LED - Start Diagnosis
Frant Vear —_—— -

(]

IREERERERER

Close

The Configuration window is opened by selecting Tools > System > Configuration... menu, and is
used to display the system information and event log, as well as to perform diagnostics and self-test.

The Main Frame screen is used to display the system information and perform diagnostics.
Model Identification: Displays the instrument ID. B1500A or B1505A.

Line Frequency: Sets the power line frequency, 50 Hz or 60 Hz.

EasyEXPERT Rev.: Displays the revision number of the EasyEXPERT.

Firmware Rev.: Displays the revision number of the BIS00A/B1505A firmware.

Host ID: Displays the host id of the BIS00A/B1505A internal computer.

Main Frame Diagnosis: This area lists [tem and Status.

Item: Name of diagnostics item. To select, check the left check box.

Status: Diagnostics status. Pass or fail.

To perform diagnostics, specify the items to perform and click the Start Diagnosis button. A dialog
box is opened. Follow the dialog box to perform the diagnostics. Some items need your judgement,
pass or fail. Also you will need to connect an adapter, press keys, check LEDs, and so on.

The Host ID is important for the B1540A-002 users and the B1541A-002 users. It is necessary to
activate the EasyEXPERT Software Plus features. For details, see the Software Entitlement
Certificate.
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Miscellaneous Operations

Modules

Slot Configuration |
| Slot | Module Type | Name | Status | SCUU | Notes
11 B1500A GNDU+ADC PASS
M 1 B1530A WGFMU1:RS,WGFMU2:RS PASS
E 2 Bi517A SMU1:HR PASS Unselect Al
E 3 Bi1517A SMU2:HR PASS
E 4 Bi511A SMU3:MP PASS
Start
Self Test
< | >
Accessory Configuration
Status LED: -]

The Modules screen is used to perform self-test of modules.

Slot: Slot number where the module is installed. To select, check the left check box.
Module Type: Module model number

Name: Module name

Status: Self-test status, Passed, Failed, Recovered, or ---- (self-test has not been performed)
SCUU: Specifies if the module is connected to the SCUU.

Notes: Error information when the module self-test failed.

To perform self-test, specify the modules, open the measurement terminals of the corresponding
modules, and click the Start Self Test button.

Recover Module button is for the service use only. This button makes the failed modules respond
again. This button does not solve the problem that causes the Failed status.

Status LED: Enables (ON) or disables (OFF) the status indicator (LED) of the ASU (Atto Sense and
Switch Unit) and the SCUU (SMU CMU Unify Unit).
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ASU - B1500A/ES270B

ASU List : |
| Slot [ Module Type l Name ASU Serial Number : | ASU I/0O Path : |
1 B1525A SPGU1:HV,SP...
2 B1530A WGFMU1:RS,...
3 B1510A SMU1:HP
5 B1517A/E5288A SMU2:HR/AS 00000000 SMU
6 B1517A/E5288A SMU3:HR/AS 00000000 SMU
7 B1517A SMU4:HR SMU:00000000
8 B1511A SMU5:MP
9 B1511A SMU6:MP
10 B1520A CMU1:MF
gup;?:niele?}zrsgfec ﬁ:lﬁ:ir\:rseacroer:;raieniaurll"dme ASU ASU1/0 Path: :I'
and the SMU. So confirm the serial number of the ASU
and connect it to the dedicated SMU properly.

This screen is available if the BIS00A/ES5270B installs the SMU connected to the ASU (Atto
Sense/Switch Unit), and shows the ASU information.

Slot: Slot number
Module Type: Type of module
Name: Module name or SMU name

ASU Serial Number: Serial number of the ASU registered as a pair with the SMU. This cell displays
an error message instead of the serial number if unpaired ASU is connected.

ASU I/O Path: ASU input to output connection, SMU or AUX

If the ASU 1/O Path field is set to SMU, the ASU makes the path from the ASU Force input to the
ASU output.

If the ASU 1/O Path field is set to AUX, the ASU performs automatic switching in every test. The
ASU makes the path from the AUX In input to the ASU output for the test without the SMU and
makes the path from the ASU Force input to the ASU output for the test with the SMU.
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Switching Matrix
— Not Available for B1IS05A/B1506A/B1507A

General Information |

Switching Matrix Type: |B22DDA Femto Leakage Switch MainFrame
Start
GPIB Address: {22 7] poll Self Test

B2200A/B2201A Input Port Configuration Extended Configuration vI
SWM IN1: [ SMULHP | I Kelvin swaino: [ =]
swainz: | 7] swminio: | 7]
SWM IN3: [ SMUZ:HP | I Kelvin swainit: [ =]

swMiINg:|  +] swminiz: [ |

SWM IN5: [ SHMUZHR ~| I Kelvin SWM IN13: [ CHUL:MF - My
swMine: | 7] swMinia: | 7]

SWM IN7: [SHU4:HR ~| I Kelvin

swMins:| 0 v

Not available for the BIS05A/B1506A/B1507A. This screen is used to establish the GPIB
connection with Keysight B2200A/B2201A/E5250A switching matrix and define the
B2200A/B2201A/E5250A input port connections.

Switching Matrix Type: Displays the type of the switching matrix or No Switching Matrix.

GPIB Address: Specifies the GPIB address of the switching matrix. 1 to 30.

Poll: Confirms if the switching matrix of the specified GPIB address is connected to the instrument.
Start Self Test: Starts the selftest of the switching matrix.

SWM IN#: Switching matrix input ports. Enter the label used to specify the input port to the right
entry field. The port name and the connected module name can be the label. The character : (colon)
cannot be used. Checking the Kelvin check box grays out the coupled even number port. Checking
the CMU check box grays out SWM IN10 for the ES250A or SWM IN14 for the B2200A/B2201A.
The input ports IN11 to IN14 are not available for the E5250A.

Kelvin: Check this box if this port is used for the Kelvin connection.

CMU: To perform capacitance measurement through the switching matrix, check this check box and
set CMU1:MF to the SWM INO for the E5S250A or the SWM IN13 for the B2200A/B2201A. And
connect MFCMU to the Input 9 and 10 of the E5250A or the Input 13 and 14 of the
B2200A/B2201A. To perform capacitance compensation, see User’s Guide.

Extended Configuration: Opens the Extended Configuration dialog box. See the next page.
Note: The ES255A installed in the E5250A is not supported.
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Extended Configuration

Extended Configuration
Save As Hardware Profile |

Tosave current configuration as Hardware Profile, .
dlick this button. e
[CMU Compensation |
Start
Self Test ¢ No Compensation

B2200A/B2201A
||Bdnndedcanﬁqura|ion v|| & Selact
DUTI/F: [B22204 -
-

Cable: [164344-002 (3 m) -

" User Compensation Data File
= [ |
-
ES5250A
AUL:MF > I cMU
£ User Compensation Data File (E52504)
¢ [ |

Length:

Triaxial Cable: B| Meters
User Triaxial Cable: B| Meters
User Coaxial Cable: B| Meters

Close

This dialog box is opened by clicking the Extended Configuration button in the Configuration window Switching Matrix
screen.

Save as Hardware Profile is used to save the hardware profile that is the B2200A/B2201A/E5250A hardware configuration
and the measurement module connection. Click the Save button to save the present hardware profile. The hardware profile
can be made for each workspace individually.

CMU Compensation is used to select the compensation mode of the capacitance measurement using the
B2200A/B2201A/E5250A. Click one of the radio buttons, No Compensation, Select, and User Compensation Data File. For
the capacitance compensation, see User’s Guide.

* No Compensation:

Select this radio button if you do not need the capacitance compensation. The raw data without compensation is displayed
and saved.

* Select:

Select this radio button to perform the capacitance compensation for the path from the B2200A/B2201A input ports to
Keysight 16495F/G connector plate or Keysight B2220A probe card interface. The data after compensation is displayed and
saved.

DUT I/F field is used to specify the model number of the path you use. The selections are the 16495F/G and B2220A.

Cable field is used to specify the model number of the cable from the B2200A/B2201A output to the DUT I/F. The
selections are the 16494A/B/C-001/002/005. This mode cannot perform the capacitance compensation for the cables to
positioner/manipulator or the probe card.

» User Compensation Data File:

Select this radio button to perform the capacitance compensation for the path from the B2200A/B2201A/E5250A input ports
to the end of positioner/manipulator or probe card. See User’s Guide. The data after compensation is displayed and saved.

Note: The ES255A installed in the E5250A is not supported.
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SMU/PG Selector — B1500A/4155/4156

16440A SMU/PG Selector

¥ Enable SMU/PG Selector

SMU Assignment: Input/Output Path:

Selector CH1:|sMUZ:HR x||normaly PGU (AUX) x|
Selector CH2: |SMU3:HR || Always smu |
Selector CH3: |SMU4:HR =l|Normaly PGU (ALX) ]
Selector CH4:|slUS:HR || Atvays sau =

Only for the B1500A/4155/4156. This screen is used to specify the input connection and the channel
connection status of the Keysight 16440A SMU/PG selector.

Enable SMU/PG Selector: Check this box to use the selector.
Selector CH1/CH2: Indicates the channels 1 and 2 of the first selector respectively.
Selector CH3/CH4: Indicates the channels 1 and 2 of the second selector respectively.

SMU Assignment: Specifies the SMU connected to the SMU input of the selector channel CH1,
CH2, CH3, or CH4.

Input/Output Path: Specifies the connection status of the selector channel CH1, CH2, CH3, or CHA4.
Always SMU: Makes the selector channel “SMU on” state.

Normally PGU (AUX): Performs automatic switching in every test. The selector channel normally
makes the “PGU on” state and makes the “SMU on” state only for the test which uses the SMU
connected to the Input SMU terminal.

The CH1 and CH3 also provides the “PGU open” state which is set by using the Advanced window
of the Measurement Setup.
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SMU/PG Selector — B1500A/4155/4156

o Easy to switch between SMU and PGU
o Solid state relay

16440A Selector

Input SMU
Channel 1 SWi1 @® ToDUT
Input PGU () o o o
Sw2
Input SMU @ "o
Channel 2 SW @ ToDUT
Input PGU @)

o o—!
SW2

SW1 & SW2 : Mechanical Relay
v Flash Memory Test SW3: Solid State Relay
v Transistor photomos

The selector has two channels as shown above. Each channel has two ports (SMU and PGU).
External pulse generators can also be connected. The connectors are Triax for SMUs and outputs,
and BNC for PGUs.

Up to two selectors (four channels) may be required for some reliability tests such as Flash
EEPROM.

As a special design for Flash memory, a solid state relay was added to float the drain. This
eliminates wear and tear of millions of closures that would occur with a mechanical relay.
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Dual HCSMU Combination — B1505A

Dual HCSMU Combination

[” Enable Primary HCSMU : -
Secondary HCSMU : o

Only for the B1505A. This screen is used to set the dual HCSMU operation.

Enable check box enables or disables the dual HCSMU operation. If this box is checked, the dual
HCSMU operation is enabled and two HCSMU modules can be a SMU which supports =40 A
(pulse), =2 A (DC).

Primary HCSMU specifies the HCSMU module used as the primary channel of the dual HCSMU
operation. The module must be connected to the Primary port of the 16493S-020/021 dual HCSMU
adapter.

Secondary HCSMU specifies the HCSMU module used as the secondary channel of the dual
HCSMU operation. The module must be connected to the Secondary port of the 16493S-020/021
dual HCSMU adapter.

Apply button applies the dual HCSMU operating condition. To apply the setup changes
successfully, the B1505A must be in the idle state and the Standby output must be OFF.
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Module Selector — B1505A

N1258A/N1259A-300 Module Selector

¥ Enable Module Selector

Input Output

HVSMU: [spus:py -

B Enable Series Resistor
(100k ohm) for HVSMU Default: |spui:Hp  ~

HCSMU: [smusHC =
HPSMU: [suut:Hp -

Diagnosis

Status: Communication Established Start Diagnosis |

Status: --—-

I” Auto Detection

Apply

Only for the B1505A. This screen is used to specify the input connection and the default input-
output path of the module selector.

Enable Module Selector check box is used to enable/disable the module selector. If this box is
checked, the module selector can be used.

Input: Specifies the modules connected to the module selector’s HVSMU, HCSMU/DHCSMU, and
HPSMU input ports respectively. For the port which no module is connected, blank the entry field.
The Enable Series Resistor (100 kohm) for HVSMU check box must be checked if you want to insert
the series resistor to the HVSMU path.

Output: The Default field is used to specify the module connected to the module selector output port
in the idle state. When a measurement is performed, the module specified by the test setup is
automatically connected.

Status: Shows one of the following status.
*Not Detected: Module selector has not been detected yet.
*Communication Established: Normal status. Module selector can be used.

*Communication Lost: Once the module selector was detected. However the communication has
been broken now.

Auto Detection check box is used to enable/disable the module selector automatic detection. If this
box is checked, the automatic detection of the module selector is performed when EasyEXPERT is
launched.

Start Diagnosis button is used to start the module selector diagnosis. And the Status shows the
diagnosis result.

Apply button applies the setting.
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Module Selector — B1505A

o Easy to switch High open, HPSMU, HCSMU/DHCSMU,
HVSMU, or HYSMU via 100 kohm

o Upto30Aand3000V

F: Force

S: Sense

P.A:
Protection adapter

GNDU force and sense

are connected to Low
sense line.

HVSMU force is connected
to High sense line.

GNDU HCSMU HPSMU  HVSMU

Module selector is used to switch the measurement resource connected to the device under test
(DUT) automatically. The measurement resource will be HPSMU, HVSMU, or
HCSMU/DHCSMU. One selector provides one switching channel.

The N1258A is used with a DUT interface such as your own test fixture and prober station.
The N1259A with option 300 is for the packaged device test.

CAUTION: If dual HCSMU (DHCSMU) is used with the module selector, the maximum current
must be =30 A to prevent the module selector from performance degradation and failure.
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UHC Expander / Fixture — BISOSA/B1506A

Ultra High Current Expander / Fixture

[v Enable Ultra High Current Unit

Control Self Test Self Calibration
Voltage Control SMU : hd Start... Start...
Current Control SMU : - Status: ---- Status: ---—-

¥ Enable Selector ¥ Enable Gate Control
Input Output Gate Control

UHCU : :I' [ Enable Series Resistor SMU - -

(100k ohm) for HYSMU
HVSMU : || -
Default : |GNDU:GND - Resistor : |0 ~| ohm
SMU : [SMUS:MP -

Thermometer
[~ Channel 1 [~ Channel 2 Interval:|2s B| Format: T1-{0},T2={1},T1-T2-{2} dea C =

Diagnosis

¥ Auto Detection Status : Not Detected
Start...
Apply | Status : ----

Only for the B1505A/B1506A. This screen is used to set the UHC (Ultra High Current)
expander/fixture. The fixture can be controlled by the B1505A/B1506A via the Digital I/O
connector.

Enable Ultra High Current Unit enables/disables the ultra high current unit (UHCU). If this box is
checked, Control, Self Test, and Self Calibration fields become effective. The UHCU is effective by
setting the Voltage Control SMU and the Current Control SMU. The UHCU can be identified by the
SMU set to the Voltage Control SMU. In this slide, SMU2 specifies the UHCU.

Enable Selector enables/disables the fixture built-in selector. If this box is checked, the Input and
Output fields become effective. The Input field specifies the UHCU and the measurement resources
connected to the selector’s HVSMU and SMU inputs. The Output field specifies the Default
measurement resource connected to the selector output in the idle state. When a measurement is
performed, the measurement resource specified by the test setup is automatically connected. Enable
Series Resistor (100 kohm) for HVSMU enables/disables the 100 kohm series resistor on the
HVSMU path.

Enable Gate Control enables/disables the Gate path of the fixture.

Thermometer Channel 1 and Channel 2 enable/disable the thermometer of the fixture. Interval sets
the temperature measurement interval, and Format specifies the format for recording the temperature
data. The data is recorded by adding to the end of the Device ID string. Variables {0} for the
channel 1 temperature, {1} for the channel 2 temperature, and {2} for the difference between {0}
and {1} are available for setting the format.
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UHC Expander / Fixture — BISOSA/B1506A

o« SMU path, 3 Kelvin (6 non-Kelvin)

o UHVU path, up to 10 kV

o UHCU path, up to 1.5 kA, through built-in selector
o Gate path

o« CMU path through bias tee

v Thermometer, 2 channels

B1505A/B1506A UHC expander/fixture
Digital 1/0 Digital 1/0
Interlock Interlock High
GNDU GNDU - puT _|Prain
=2
HVSMU |---->{ HYSMU—0 =1
HP/MPSMU | = - = -> SMUI—_OK— r-_:-, |:
=
% Source
UHCU @
MC/HCSMU |-control Low
MC/HCSMU V-control

This test fixture contains a ultra high current expander (UHC expander) and a built-in selector.
The fixture provides several paths listed above and the thermometer channels.

The UHC expander configures the ultra high current unit (UHCU) which supports up to 500 A or 1.5
kA. It depends on the option. And the output can be connected to the device under test (DUT)
through the built-in selector.

For the B1505A, the selector output can also be extended to a prober station by using the N1254A-
524 prober system cable.
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Built-in Selector — B1505A/B1506A

o Easy to switch the open condition, GNDU only, UHCU only, or
GNDU with SMU, HVSMU, or HYSMU via 100 kohm

o Up to 1.5 kA and 3000 V

Gate . Low High

High Sense© Force Sense® ®F0rce

\@ ﬁ\l NG 1 lmz‘:

P.A

_| HVSMU force is
S F connected to
S||F UHCU High sense line.
Y (¢
F V-control | |I-control Sccx))F F

MCSMU GNDU MCSMU MCSMU ~ SMU HVSMU

F: Force

.

S

The built-in selector is used to switch the measurement resource connected to the device under test
(DUT) automatically. The measurement resource will be UHCU, SMU, or HVSMU. One selector
provides one switching channel.

The fixture also provides the series resistor control for the Gate path. The resistance can be selected
from 0, 10, 100, or 1000 ohm.
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HVSMU Current Expander — BIS0SA

N1266A HVSMU Current Expander |

¥ Enable High Voltage Medium Current Unit

Input/Control Self Test
HVSMU: SMUT:HY Vl Start... |
Voltage Control SMU: [suyuz:HC vl Status: ----

Current Control SMU: [5MJ3:MC vl

Output
[" Enable Series Resistor (100k ohm) for HVSMU
Defauit: =

[ Auto Detection Status: Not Detected

Apply |

Only for the B1505A. This screen is used to set the N1266A HVSMU current expander. The
N1266A can be controlled by the BI1505A via the Digital I/O connector.

Enable High Voltage Medium Current Unit enables/disables the high voltage medium current unit
(HVMCU). If this box is checked, Input/Control and Output fields become effective. The HVMCU
is effective by setting the HVSMU, the Voltage Control SMU, and the Current Control SMU. The
HVMCU can be identified by the SMU set to the Voltage Control SMU. In this slide, SMU2
specifies the HVMCU.
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HVSMU Current Expander — BIS0SA

o Easy to switch High open, HVYMCU, HVSMU, or HVSMU via
100 kohm

o Upto2.5Aand3000V

B1505A N1266A HVSMU current expander
MC/HCSMU > |-control
MC/HCSMU V-control High
HVMCU DUT Drain
HVSMU HVSMU———o [«
VV o
Open Source
GNDU > GNDU | L N1261A-002
OW ™1 oroos(1) [T
Digital I/0 Digital 170

*1: N1261A-002/004 protection adapter is required for connecting prober.
Not requred for connecting N1258A, N1259A, N1259A-300, or N1265A.

N1266A is used to expand the HVSMU maximum current up to 2.5 A. The N1266A also provides a
built-in selector to switch the measurement resource connected to the device under test (DUT)
automatically. The measurement resource will be HVMCU or HVSMU. The GNDU is always
connected to the Low output terminal.

The Output field shown in the previous page specifies the Default measurement resource connected
to the selector output in the idle state. When a measurement is performed, the measurement resource
specified by the test setup is automatically connected. Enable Series Resistor (100 kohm) for
HVSMU enables/disables the 100 kohm series resistor on the HVSMU path.
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UHYV Expander — B1505A

N1268A Ultra High Voltage Expander

[ Enable Ultra High Voltage Unit
Input/ Control

Voltage Control SMU: ISMU2:MC vl
Current Control SMU: Ismu3;|\qc vl

[~ Auto Detection Status: Not Detected

Apply |

Diagnosis

Status:

Start...

Only for the B1505A. This screen is used to set the N1268A ultra high voltage expander. The
N1268A can be controlled by the BI1505A via the Digital I/O connector.

Enable Ultra High Voltage Unit enables/disables the ultra high voltage unit (UHVU). If this box is
checked, Input/Control field becomes effective. The UHVU is effective by setting the Voltage
Control SMU and the Current Control SMU. The UHVU can be identified by the SMU set to the
Voltage Control SMU. In this slide, SMU2 specifies the HVMCU.
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UHYV Expander — B1505SA

o Ultra high voltage up to 10 kV

B1505A

MCSMU
MC/HCSMU

Interlock
Digital 1/0

MCSMU
MCSMU

—— Interlock circuit

Source

N1268A UHV expander
I-control Interlock Output
V-control High
Interlock Input Low
Digital 1/0

|—> UHV Low Gate
Gate Source
Chuck Chuck

N1269A UHV connection adapter

N1268A is used to expand the maximum voltage up to 10 kV.

If you use the N1265A test fixture, connect the UHVU output High and Low to the N1265A UHV

High and Low terminals.

If you use a prober station, use the N1269A UHV connection adapter as shown above.
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Device Capacitance Selector —
B1505A/B1506A/B1507A

N1272A Device Capacitance Selector
I Enable Device Capacitance Selector
Input Default Path
MFCMU:
HVSMU: Default Path: Open
SMuU:
Calibration
File Path: ‘
Select Calibration Data...l Select Factory Default | Start Calibration...
Diagnosis
I~ Auto Detection Status: Not Detected 9
Start...
Apply | Status: Status:

Only for the B1505A/B1506A/B1507A. This screen is used to set the device capacitance selector.
The selector can be controlled by the

B1505A/B1506A/B1507A via the Digital I/O connector.

Enable Device Capacitance Selector check box is used to enable/disable the device capacitance
selector. If this box

is checked, the selector can be used. The Input specifies the unit connected to the selector.
Default path (for the N1272A/B1507B0 specifies the N1274A measurement path in the idle state.
Calibration performs the open/short correction for the selected adapter or selects the
correction/compensation data for the adapter.

File Path shows the file path for the correction/compensation data file to apply.
Select Calibration Data... button selects the correction/compensation data file to apply.
Select Factory Default button selects the default correction/compensation data to apply.

Select Start Calibration... button opens the Device Capacitance Calibration dialog box to get
the correction/compensation data for the adapter.

Auto Detection check box is used to enable/disable the automatic detection of the device capacitance
selector. If this box is checked, the automatic detection is performed when Workspace is loaded.

Diagnosis is effective when the Enable Device Capacitance Selector check box is checked. Start...
button starts the diagnosis for the selector. Dialog box will be opened to navigate you the cable
connection during the diagnosis. The Status shows the execution result.
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Gate Charge Adapter — B1505A/B1506A

Calibration

Current Load Control:

I—L| Default Path:

Gate Charge Adapter
Input Adapter
Gate: = Adapter: N1253A Opt014 -
HVSMU: I—L|
UHCU/HCSMU: ’—L| Default Path

Open

File Path: |
Residual Resistance:

0 ohm

Parasitic Capacitance:

Gate Control SMU_| [F]

10uA 1.62033E-09
100 uA 1.61774E-09
1mA 1.6099E-09
10 mA 1.55703E-09
100 mA 6.85863E-10

Apply |

Select Calibration Data...l
Select Factory Default |

Start Calibration... |

-

Status: Not Applied

Only for the B1505A/B1506A. This screen is used is used for the gate charge measurement settings.
Adapter selects the adapter to use.

Input specifies the measurement units for gate charge measurement.
Default Path (for the N1274A) specifies the N1274A measurement path in the idle state.

Calibration performs the open/short correction for the selected adapter or selects the

correction/compensation data for the adapter.

File Path shows the file path for the correction/compensation data file to apply.

Residual Resistance shows the residual resistance value of the DUT gate drive path for short
correction/compensation. If N1265A Opt014/B1506A OptF14, shows the resistance values
of every DUT gate drive path.

Parasitic Capacitance shows the parasitic capacity for the open correction/compensation.

Select Calibration Data... button selects the correction/compensation data file to apply.

Select Factory Default button selects the default correction/compensation data to apply.

Select Start Calibration... button opens the Device Capacitance Calibration dialog box to get
the correction/compensation data for the adapter.
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SMU Output Setting Limit — B1505A

SMU Output Setting Limits

Voltage Setting Limit: IlD kv B
Current Setting Limit: |1_5 kA =]

Apply |

This screen is used to set the upper limit of the SMU output value and compliance value.

Voltage Setting Limit: Sets the upper limit of the voltage output value and compliance value.
Effective value: 200 V to 10 kV, in 100 V step.

Current Setting Limit: Sets the upper limit of the current output value and compliance value.
Effective value: 1 A to 1.5 kA, in 1 A step.

Apply button applies the setting.
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Event Log

4/11/2006 4:48:55 PM

Event Log |
Date/Time 1 Message 1 D 1 Process User Host
4/12/2006 3:00:35 PM  Configuration query completed. 110001 StaDaemon B1500user B1500A-0...
4/12/2006 3:00:22 PM  Service started successfully. 102001 StaDaemon B1500user B1500A-0...
4/12/2006 2:25:56 PM  Service stopped successfully. 102002 AppSetup B1500user B1500A-0...
4/12/2006 2:00:41 PM  Service started successfully. 102001 AppSetup B1500user B1500A-0...
4/12/2006 2:00:38 PM  Service stopped successfully. 102002 StaUpd B1500user B1500A-0...
4/12/2006 2:00:37 PM  Service started successfully. 102001 Stalpd B1500user B1500A-0...
4/12/2006 1:52:48 PM  Service stopped successfully. 102002 StaDaemon B1500user B1500A-0...
4/12/2006 12:44:00 ... Configuration query completed. 110001 StaDaemon B1500user B1500A-0...
4/12/2006 12:43:51 ... Service started successfully. 102001 StaDaemon B1S00user B1500A-0...
4/12/2006 12:40:29 ... Service stopped successfully. 102002 AppSetup B1500user B1500A-0...
4/12/2006 12:14:57 ... Service started successfully. 102001 AppSetup B1500user B1500A-0...
4/12/2006 12:14:53 ... Service stopped successfully. 102002 StaUpd B1500user B1500A-0...
4/12/2006 12:14:52 ... Service started successfully. 102001 StaUpd B1500user B1500A-0...
4/11/2006 6:50:48 PM  Service stopped successfully. 102002 StaDaemon B1500user B1500A-0...

11/2006 6:50:47 PM  GPIB timeout occurred.Int... 103008 StaDaemon B1300user B1500A-0...
4/11/2006 4:51:15 FM StaDaemon B1300user B1500A-0...
StaDaemon B1500user

B1500A-0... [o]

This screen displays the event log.

Date/Time: Displays date and time of the event.
Message: Event message

ID: Process ID of the event

Process: Process name

User: User name. Windows login name.

Host: Host name of the B1500A/B1505A

The Refresh button refreshes the event log.
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e S Select XML Style Sheet File
File Edit View Run Tools Help Lookin: [ XSLT | cf B~
Tnitial Workspace Device D : ' : Count ;| 5 vl
5 [ < Vee-vge ) [ meas_index_meta csvoxsl
£ [ [v=vo CH o gt
g mz“;’::w“ “ [Device Parameters Documerts | essindex_meta-xmissixsl
Fr. sy,
pMIC Polarity : [Nch Il Temp : [25.0 deg| B ’”a“-‘“:b fsb k i
index-tob-sv.xs
= |powerr Desktop [ mess_ndexcsmise el
=l powerinde =] Fimeas |
. 2 meas_meta-csv.xsl
Exportin My Format y [meas_meta-tab-sv.xsl
Aﬁ 2| meas_meta-xmiss.xsl
My Format: Cuments
-
= ) 2
My Compuser
N i) (e | @ |
My Nefwork  Fie name [meas_index_metasvassl | Open
azes
Gate : N "‘—h]
Files of type: M ¥ % s - Cancel
(n127: s | XML Style Sheet Files )
; VgStart : -
E Vostop: [T00V & i
Trng idvd - -
idvg3 Vvostep : [t00mv & Savein: [ DATA -l e Bk Er
|3 3 [icsmeos TesTas. @R samPLIEG HOLaTR @ZERO_CHECKATR
X (6] ®: Z.XTR @rc_savprin locxR  @ZERO_CHECK_ASUXTR
» Cancel me [Date et ®o=o0.0c 4 =
G ax 4/9/2015 3:23:00 P| o° @eerasees
3 3 & Select All = .
Click this button * k-ASU 11/14/2006 4:48:3 [ @
= 11/13/2006 6:20:05 5, :G“”'“E“ e
Highlight this line» and T 102200872045 YT @i o
[[nitia) st |[] herm J TRNG_IDVD_IDVG3.XTD
- ® 000 pusexme @ oo e
Filter » 2 2,
s . Wy Doamcrts gy, TR1iC_DYE_I0VG. XD
_ ®rrm TRNG_IDVE_IDVG.XTR
Import. ?’J @1 _resar TRING_IDVD_VTH.XTD
ez | ), R TELT | gt
5 | ANcompressed Test Result... " =
s Rt File, ~3% (2] ] | £3)
|
e My Netrork e name [ - Save
Places.
I N Save as type: Al Files - Cancel )
o
Options »

The XSLT (XSL-Transformation, eXtensible Stylesheet Language Transformation) filter files are
used to export test records. The fifteen filter files listed below are stored in <installation
folder>¥Utilities¥XSLT.

The following filter files are used for exporting the measurement data only.
meas-csv.xsl, meas-tab-sv.xsl, meas-xmlss.xsl

The following filter files are used for exporting the measurement data with the index.
meas-index-csv.xsl, meas-index-tab-sv.xsl, meas-index-xmlss.xsl

The following filter files are used for exporting the measurement data with the meta data.
meas-meta-csv.xsl, meas-meta-tab-sv.xsl, meas-meta-xmlss.xsl

The following filter files are used for exporting the measurement data with the index and the meta
data.
meas-index-meta-csv.xsl, meas-index-meta-tab-sv.xsl, meas-index-meta-xmlss.xsl

The following filter files are used for exporting all data including the test setup.
csv.xsl, tab-sv.xsl, xmlss.xs

Where, the meta data contains the test name, the setup name, the record time of the test results, the
device ID, the counter number, the flag of the test results, and the remarks on the test results.

Filter files that contain xmlss in the file name export test record in the XML Spread Sheet format.
Filter files that contain csv or tab-sv in the file name use a comma or a tab for the data separator.
For more information, see online help or User’s Guide.

Note: <installation folder> is the folder where the EasyEXPERT is installed.
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To Enable System Controller

Keysight 10 Library Connection Expert
'@ - [Modffy configurable properties for this GPIB PCL interface

Fie Option _
VISA nterface ID: o0 ™
GFIB address; 21 |v
Start EasyEXPERT
L controler (recommended) |

S =10

(@ Keysight Connection Expert E] £

File Edit View /O Configuration Tools Help Plautodscover e - i

& R Al ) L DPupeties 1 neractive 10 B Add Instumert 9 Add nteface 3¢ Delete

[Task Guide: gilent 82350 PCI GPI Interface - GPIB0 )

[Tasks for This Interface Refresh Al AnKeysight GFIB interface card installed in a PCI slot in this ’

Q refeshtisGRBmafuce | 5 B, 5is0oArooss S

o1 (SRLY) -

@ enoeoroperies 4 SRt (' ) s item s been verfied

B Chonsetheisne | Change Proper ..

3y ©% U USnefceD: @R

X e Seriel number Myass30262 & Reboot Required
GPIB address: 17

eneral Tasks ) Changes to the /O configuration were detected that require the computer
System Contraler: Mo = system be rebooted in order for the changes to take effect. Would you like

@ Refreshall L to reboot nowi?

k2 SICL nterface I a0

‘w Add an instrument Logical unit: 7 Reboot Now: The e
Auto-discover: Mo o

Rebootlater: Yo hen to rebot. Same of the ch:

be visble to other the

mection

systems rebooted.

How do Tget diivers?

@ Cancel Changes:  The changes that led to tis required reboot il be discarded, You
e,

willoase some recent ok you have don
Where can 1find i

@ Srogremmingsamsles

B I Reboot Now I Reboot Later Cancel Changes | Help

o)

Keysight VISAls the primary VISAlibrary

To control external GPIB devices from the B1500, it must be set to system controller. Exit the
EasyEXPERT, and close the Start EasyEXPERT window. After that, launch the Keysight
Connection Expert by clicking Start, All Programs, Keysight IO Library Suite, and Keysight
connection Expert.

On the Keysight Connection Expert, change the GPIB configuration of the B1500.
*Select GPIBO.

+Click Change Properties... button.

*Change GPIB address to 21 that is the typical address number for the system controller.
*Check System controller box.

+Click OK button.

*Reboot the B1500.
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To Start EasyEXPERT on External PC

Exeoution bode
GPIB Commurication
© EasyEXPERT 1= e
— oflire ———————————————
ile ptions
WISA interface I IGPIBD %
Start EasyEXPERT GPIE address: IT i
& offre ——
Model: IBISDDA =
-
© EasyEXPERT = [
File | Options | LI L‘:EII
Auto Start of EasyEXPERT
EasyEXPERT Database v Backup EasyxperT Datsbase ——+ Database Backup Creation Wizard
User Level... Restore EasyEXPERT Database ———% O .
N 2 Database Restoration Wizard

[ IMove EasyEXPERT Database ]

EasyEXPERT Database
Mave To
’7 EasyEXPERT Database Path;

[ #usere1 Browse...
Cancel

4

To open the Start EasyEXPERT window, click Start > All Programs > Keysight EasyEXPERT >
EasyEXPERT menu. This window provides the Option menu used to open the following dialog box.

Gpib Communication:
Select Online if the supported instrument is connected to your computer and you want to control it
via GPIB. Or else select Offline.

Database Backup Creation Wizard:
Use this wizard to create the EasyEXPERT database backup (xdb file).

Database Restoration Wizard:
Use this wizard to restore the EasyEXPERT database backup. The wizard can restore the xdb file or
the backup which is a copy of the folder that contains the EasyEXPERT database.

EasyEXPERT Database:
Specify the EasyEXPERT Database path if you want to move the database to the other folder.

To launch EasyEXPERT, click the Start EasyEXPERT button.

Note: For the installation procedure, see the readme file stored in the EasyEXPERT installation
media.

Note: For the offline mode. To use the same module configuration as the B1500, copy the
UnitConfigXXXX.xml file to your PC where the EasyEXPERT runs. The file is stored in the B1500
internal HDD. For details, see “Running EasyEXPERT on External PC” in EasyEXPERT User’s
Guide or Online Help.
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To Use 415x Setup File Converter

I

0- gogonoan

[
i

Import

4155/4156 setup file EasyEXPERT setup file
(file extension: MES or DAT) (file extension: XTS)

b[SetupFileConverter.exep

Execution example:

C:¥Mydata>SetupFileConverter.exe setupl.dat
C:¥Mydata>SetupFileConverter.exe *.mes

You can reuse the 4155/4156 setup file (MES file or DAT file) for the test using EasyEXPERT. This
is realized by Setup File Converter which has the function to create the XTS file by converting the
MES or DAT file to the EasyEXPERT format. This executable file is stored in <installation

folder>¥415xC¥Conversion.

You can execute the setup file converter on the Command Prompt as shown below. If you want to

use the Windows desktop instead of the Command Prompt, see the next page.

1. Create your working folder (for example, C:¥415xdata).

2. Copy your MES or DAT files to this folder.

3. Copy SetupFileConverter.exe file to this folder.

4. Launch the Command Prompt.

5. Go to your working folder (for example, C:¥> cd 415xdata).

6. Execute SetupFileConverter.exe as shown in the following example.
C:¥415xdata> SetupFileConverter.exe *.MES

This example converts all MES files in your working folder to the EasyEXPERT setup file format,

and creates the XTS files in this folder.

Note: If you execute the setup file converter without the parameter, the help message will be

displayed.

Note: The setup file converter provides some options. See User’s Guide or online help for the

options.
Note: <installation folder> is the folder where the EasyEXPERT is installed.
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To Use 415x Setup File Converter

1. Drag and drop the shortcuts of the MES/DAT file on the
shortcut of the Setup File Converter.

3. XTS file and shortcut are created.

2. File conversion is executed and system message is displayed.

M| Setup File Converter il g =[S

SetupFileConverter.exe : Uersion A.83.18 u
Start Conversion @ E:i\Documents and Settings\RGlL4155.ﬂGILENT\Desktup\R.‘

ES1.DAT
ExportFile ¢ E:NDocuments and Settings“AGIL4155.AGILENT“Desktop-RE]

Setuplersion : HP4155_C02.24
Conversion successfully completed.

——— Press Enter key to guit.

You can perform the file conversion on the Windows desktop as follows.

1. Create a shortcut of the SetupFileConverter.exe on the desktop.

2. Copy your MES/DAT files to the desktop.

3. Drag and drop the shortcuts of the MES/DAT files on the shortcut of SetupFileConverter.

This starts the file conversion and displays the system message. And if the conversion is completed
successfully, the setup file converter creates the XTS files and the shortcuts on the desktop.

Note: The setup file converter provides some options. See User’s Guide or online help for the
options.
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To Use 415x Setup File Converter

Start > All Programs >Agilent BIS00A EasyEXPERT >
4155,4156 Setup File Converter

File  Help
- [“F3elect | P Gonvert 3 Glear

Create XTS for:

 B1500A
© 41558/C
) 41558/C with HPSMU
) 4156B/C
) 41568/ C with HPSMU

Selected Files:
C¥WTHGM MES

Start Corwersion : C¥VTHGM.MES L)
ExportFile U CUEVTHGM xS
SetupWersion . HP4155 C03.10

Conwersion successfully completed.

To create XTS file:

The following procedure converts the 4155/4156 setup file (DAT or .MES) and creates the .XTS file
in the folder the setup file is stored.

1. Click Select icon, or click File > Select Files to open the Select 4155/4156 MES Files or DAT
Files dialog box.

2. Specify the 4155/4156 setup files to convert. Multiple files can be selected.
3. Click Open on the Select 4155/4156 MES Files or DAT Files dialog box.

4. Click Convert icon, or click File > Convert Files.

To read XTS file, use the import function to read the created .XTS file on the EasyEXPERT.
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